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111 Introduction

This manual is an instructional tool for system administrators and
others who work with PathFinder. It describes how to install, set up,
design, monitor, and maintain various PathFinder applications.





Overview 1-1
Overview

PathFinder Description
PathFinder is a voice processing system that combines sophisticated
application software with the power of the PC to handle a wide variety of
telecommunications tasks.

PathFinder helps people communicate more effectively. It provides a
bridge between a telephone and a computer. PathFinder uses pre-
recorded, digitized human speech, called voice prompts, to talk to a
caller. Unlike a tape recorder, which stores recordings sequentially,
PathFinder stores recordings on a computer hard drive. This storage
system allows PathFinder to access any voice prompt or recording in any
order. PathFinder can communicate information by stringing together
multiple voice prompts to form sentences.

Basic Process
In order to prepare, set up, and use PathFinder, the following three steps
are required:

1. Install and configure all hardware, and install all software. Refer to
Chapter 2, Installation for instructions on how to do this. You must
work through every chapter in the order presented before you can
move on.

2. Configure PathFinder. Refer to Chapter 2, Installation for instructions
on how to carry out the initial configuration of PathFinder. You must
work through this entire configuration procedure before moving on.

3. Start up and run PathFinder. Refer to Chapter 7, PathFinder Monitor
Application for more information on running PathFinder.

Even though you may want to jump right in and begin using PathFinder
immediately, it is strongly recommended that you carefully review this
manual before proceeding. This will help orient you with the many
features and options available as you work through the setup and
operation of PathFinder.
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PathFinder Components
PathFinder is made up of four components:

Foundation Software -- The platform from which application
modules run (e.g., Auto-Attendant, Voice Messaging, etc.)

Optional Software Modules -- Purchased separately (e.g., Point to
Point Messaging, Internet Fax Delivery, etc.)

Telephony Hardware -- Voice cards, etc.

Personal Computer (PC)



222 Installation

This chapter describes the PathFinder installation procedure, the
initial analysis and preparation of your system prior to installing
hardware and software.
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Perform a System Analysis

You must perform an initial analysis and prepare your system prior to
installation of hardware and software.

Before starting the installation of PathFinder, you need to consider
certain hardware requirements and recommendations. Having the
proper hardware configuration is a key factor in PathFinder’s
performance and reliability.

System Requirements
These guidelines help reduce the possibility of hardware-related
problems with PathFinder.

All system components--both required equipment and optional
equipment--should be listed in the Windows NT®/2000 Hardware
Compatibility List (HCL), which can be found on the Internet at http://
www.microsoft.com/hwtest/hcl. The HCL is a database of hardware,
classified by function.
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Minimum Requirements
The following are system requirements for PathFinder.

Table 2-1: Minimum System Requirements

Component 4-Port System 8-Port System
12-Port System

(or higher)

Computer/
Processor

Intel-based Pentium®
300 MHz or faster

Intel-based Pentium
667 MHz or faster

Intel-based Pentium
733 MHz or faster

Memory 64 MB 128 MB 256 MB

Hard Disk 1.2 GB hard drive
(~200 hours of voice
storage)

2.1 GB hard drive
(~400 hours of voice
storage)

2.1 GB hard drive
(~400 hours of voice
storage)

Motherboard Typically, one ISA expansion slot per 4 voice or fax ports; consult your sales
representative

Drive CD-ROM

Display VGA or higher-resolution display adapter

Voice Cards Refer to “Telephony Hardware Compatibility” on page 2-5

Peripheral/
Miscellaneous

Microsoft Mouse or compatible pointing device
Keyboard

Software Windows 2000 Professional, Windows 2000 Server, Windows NT® 4.0
Workstation or Windows NT 4.0 Server
Windows NT Service Pack 5

Refer to Appendix C , " Optional Modules" for information on additional system
requirements (if any) for any Optional Modules you have purchased.
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Optional PC Equipment
The following optional equipment is not required for the proper
functioning of PathFinder, but it may be useful.

Determining System Size
The size of PathFinder can be measured in two ways:

Amount of disk storage

Number of ports

Once PathFinder is up and running, it generates a number of reports that
allow you to accurately monitor use. In the meantime, the following
guidelines will help you determine the proper hardware configuration.

We also recommend that you consult with your Vodavi sales
representative and technical support staff. They can provide valuable
insight when determining resource requirements.

Hard Disk Storage Size

Voice processing can require a large amount of disk space. Many
applications are disk intensive, meaning they continually access
information on the hard drive. For this reason, it is vital that you
incorporate quality components in your system, especially in the case of
the disk drive.

Table 2-2: Optional PC Equipment

Network Interface Card Must be listed on the Windows HCL

Remote Diagnostics PC Anywhere 32-bit
Modem (on the Windows HCL) 33.6 bps or faster

Backup Tape Drive (on Windows HCL)

Backup Power Supply An un-interruptible power supply from the Windows HCL

Surge Protector A device to protect against electrical spikes
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The size of the drive depends on two factors: the application and the
number of users. On average, one hour of message storage can support
about thirty users. A general rule of thumb is that one hour of voice
storage requires about 10 MB of disk space.

Storage Size Factors
Factors affecting the amount of storage you need include the following:

Number of extensions and mailboxes required

Number of messages received and accessed per day

Average message length

Message retention period

Another factor to consider is the quality level of the voice prompts.
PathFinder's voice recording sampling rate should be set at 6 KHz. Any
other sampling rate will cause problems when playing the prompts. At
this rate, PathFinder can format about fifty minutes of voice data per 10
MB of disk space.

PathFinder software and its database use about 10 MB of disk space.
Therefore, if you need three hours of voice storage, it is recommended
that you make a hard drive allocation to voice mail storage of at least
40 MB.

Number of Ports
The number of ports required depends on several factors, such as:

Application size

Time of day

Average length of a transaction

Average traffic and peak traffic loads

Grade of service (the number of acceptable busy calls received)

In general, each port supports about twenty-five users.

You can also control disk use by encouraging users to delete messages as
soon as they are reviewed.
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PC System Placement
When choosing the location for the PathFinder PC, consider such factors
as convenience, security, and environment.

Place the PathFinder PC in the same room or close to the area where
the phone system is located.

Provide a clean, relatively dust free space with adequate ventilation.

The room should have a stable temperature and comply with the
manufacturer's specifications.

The PathFinder computer needs to be connected to a reliable source
of power. Fluctuations in line voltage and power surges can impede
operation and damage the PC or its components. An un-interruptible
power supply (UPS) is recommended.

Telephony Hardware Compatibility
The following are the Dialogic cards that are used in the PathFinder:

Install and Configure Hardware

The following tasks must be completed to install and configure your
system hardware:

Install Dialogic drivers (automatically installs in Windows 2000)

Configure and install telephony hardware

Make network attachments

Make host computer attachment

Install the software key

Systems with RS-232 hookup for telephone integration or host
connection must be located less than 50 feet from the source
equipment. A short-haul modem is required if the distance
spanned by the RS-232 hookup is greater than 50 feet.

Dialog/4 D42-SX NOTE -- Drivers are available,
however, they will no longer be
updated by Dialogic.

VFX/40ESCplus D42-SL
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Preparation
Gather the following items in one place before starting the installation
process:

Voice Cards -- PathFinder includes at least one voice card. Each card must
be inspected for possible adjustments to the switches or the jumpers.
The cards are fragile and susceptible to static electricity. These items can
be purchased from a computer retailer.

Screwdriver -- Used to remove and replace the computer chassis and
install the voice cards. Size and type should be appropriate for your
computer; most require Phillips head.

Needle Nose Pliers -- Used to remove or replace jumpers on voice cards.
The pliers should be small so as not to damage either the card or jumpers.

Work Table -- The worktable should be sturdy, located in a well-lit area
with adequate space to remove the computer chassis. It should also
provide adequate space to unpack and inspect the voice cards. An anti-
static floor mat in the area in front of and under the worktable is highly
recommended.

Overall Hardware Setup Procedure
The steps necessary to set up system hardware depend upon the number
of telephone lines (ports) your telephone system is designed to support,
and any additional software modules, such as fax support, that have been
purchased with PathFinder.

Some of the information contained in the rest of this chapter may not be
applicable to you or your specific system setup. Check the section
headings to determine which information in this chapter pertains to your
specific hardware configuration.

Use an anti-static wrist strap and, if possible, an anti-static floor
mat during inspection and installation of the voice cards and other
hardware.

All cards are configured with default settings at the factory. However,
you must confirm these settings prior to running PathFinder.
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Dialogic® Products
Refer to “Telephony Hardware Compatibility” on page 2-5 for more
information on compatible voice cards.

Current Drivers

PathFinder 8.2 uses Dialogic System Release 5.0 drivers. The default
location of SR5/DNA drivers is:

C:\Program Files\Dialogic

Telephony Hardware Configuration
The following are instructions for configuring the Dialog/4TM, the most
commonly shipped voice card. Configure these voice cards prior to
installation.

Channels
The Dialog/4 voice cards support up to four independent voice I/O
channels each with a telephone line interface. Each channel has the
following capabilities:

Record, digitize, and compress audio in real-time

Play back previously recorded files

Detect DTMF tones

Generate DTMF and pulse tones for dialing

Initiate and receive calls through the loop start telephone interface

Refer to the following web sites for further information on installing and
connecting Dialogic cards:

http://support.dialogic.com/Install/Config/Dialog4/dlg4-003.pdf
http://support.dialogic.com/Install/Config/Dialog4/dlg4hwg3.pdf
http://support.dialogic.com/Install/Config/index.html



2-8 Install and Configure Hardware
Board-Level Jumpers
Card options and memory configurations are set through board jumpers
and switches. The figure below illustrates Dialog/4 jumpers and switches.

Figure 2-1: Model Dialog/4

Jump Board Configuration-- Configure your voice cards to match the
following table. Refer to the documentation shipped with Dialogic
boards for specific instructions on configuring each card.

Refer to your Dialogic Voice Board Reference Card for specific locations
of jumpers and switches for modification.

Part Function

J1-J2 RJ-14 jack for interface

JP1 Jumper block to set
interrupt level

JP5-
JP6

Jumper pins to set
base memory
segment

JP7 Jumper pins to enable
hardware interrupt
circuitry

JP101-
JP401

Jumper pins to set ring
detection threshold

SW1 Switches to set the off-
set address & default
hook switch state
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Table 2-3: Jump Board Configuration

Configuration Board Address IRQ JP7

Four-Port with 1 Dialog/4 1 Dialog/4 D0000 5 Installed

Eight-Port with 2 Dialog/4 1-Dialog/4 D1000 5 Installed

2-Dialog/4 D2000 5 Removed

Twelve-Port with 3 Dialog/4 1-Dialog/4 D0000 5 Installed

2-Dialog/4 D2000 5 Removed

3-Dialog/4 D4000 5 Removed

Sixteen-Port with 4 Dialog/4 1-Dialog/4 D0000 5 Installed

2-Dialog/4 D2000 5 Removed

3-Dialog/4 D4000 5 Removed

4-Dialog/4 D6000 5 Removed

Four-Port with Four-Port Fax 1-VFX 40ESC plus D0000 7 Installed

Eight-Port with Four-Port Fax 1-Dialog/4 D0000 5 Installed

1-VFX 40ESC plus D2000 7 Installed

Eight-Port with Eight-Port Fax 1-VFX 40ESC plus D0000 5 Installed

2-VFX 40ESC plus D2000 5 Removed

Twelve-Port with Four-Port Fax 1-Dialog/4 D0000 5 Installed

2-Dialog/4 D2000 5 Removed

1-VFX 40ESC plus D4000 7 Installed

Twelve-Port with Eight-Port Fax 1-Dialog/4 D0000 5 Installed

1-VFX 40ESC plus D2000 7 Installed

2-VFX 40ESC plus D4000 7 Removed

Twelve-Port with Twelve-Port Fax 1-VFX 40ESC plus D0000 7 Installed

2-VFX 40ESC plus D2000 7 Removed

3-VFX 40ESC plus D4000 7 Removed
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Phone Line Assignments -- Boards are assigned phone lines as follows:

The board with the lowest address is designated as the first board in
the system and is assigned phone lines one through four.

The next lowest address is the second board in the system and
contains lines five through eight.

PathFinder can have up to eight model Dialog/4 voice cards.

Potential Conflicts -- In some PCs, a memory address conflict occurs
between voice card(s) and other add-on hardware components (such as
a tape drive controller card, ESDI or SCSI disk controller card, network
adapter card and the like).

Telephony Hardware Installation
After all the jumper and switch settings are configured properly, install
the voice card(s) in the PC.

PC Preparation
1. Place the PC in an easily accessible area.

2. Turn the power off and disconnect the AC power cord on the PC from
the wall socket.

3. Unplug any other cables from the PC including any peripheral device
cables.

4. Remove the cover according to the manufacturer's instructions, and
store the cover fasteners in a safe place.

Do not attempt to install the voice cards without configuring them
first!
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Physical Board Installation

1. Remove the screw that secures the expansion slot cover and remove
the cover.

2. Insert the board into an available ISA slot on the motherboard, using
care not to apply excessive pressure on any of the components.
Ensure that the modular jacks face the back of the PC.

3. Gently press on the edge of the board and the bracket to securely
seat it in the slot. Rocking the board forward and backward while
applying pressure on its top edge helps seat it properly.

4. Align the notch in the board's bracket with the hole in the rear panel
of the PC. Fasten it into place with the screw that was removed in
Step 1.

Telephone Connection

Four-line voice cards (Dialog/4 models) use standard two-line RJ-14
modular jacks to connect to the phone system. The RJ-14 jacks on the
four-line cards support two telephone lines or extensions per jack.

On the VFX 40ESCplus, each RJ-11 jack on the rear bracket of the voice
board supports a single voice channel. Use RJ-11 connectors and phone
cable to connect each voice channel jack to a PBX or Central Office (CO).

Telephone connections are located on the right side of the four-line voice
card. When connecting phone lines to four-line cards, follow these steps:

1. With the board components face up and the jacks on the right side,
connect lines one and two to the top connector.

2. Connect line three and four to the bottom connector.

Use an anti-static wrist strap and, if possible, an anti-static floor
mat when installing voice cards.

Do not put the cover back on the PC without securely fastening the
voice card to the chassis. Severe damage to the card could result
if it is operated without being securely fastened to the PC chassis!

Lines one and three are inside pairs, and lines two and four are
outside pairs.
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Voice Network Attachment
PathFinder is flexible in the way it can be incorporated into the telephone
network or telephone system of most locations. When considering how
to attach the system, you should keep the following concerns in mind:

Accessibility for maintenance and administration

Type of connection needed between PathFinder and the phone
system or host

The need to handle a variety of voice processing functions

Direct Attachment to the Central Office

In this configuration, PathFinder is connected directly to the telephone
company’s central office. Users can reach PathFinder by dialing directly.
This common setup is used with toll-free access to an information hotline.

However, with this configuration, PathFinder is unable to transfer callers
to other extensions. Since PathFinder is connected directly to the central
office (in front of the phone system), there is no way to transfer to an
operator or other person for assistance. The one exception is a Centrex/
Essex connection.

PathFinder can be connected to the central office using any of the
following lines.

Analog Line -- Analog lines are standard telephone transmission lines
that use an RJ-14 connector.

Centrex/Essex Line -- A Centrex/Essex line is a business telephone
service offered by a local telephone company from a local central office.
Centrex lines, like a PBX, provide such features as call transfer, call
forwarding, call hold, and others, and they use an RJ-14 connector.

PBX Attachment
In the PBX (Private Branch Exchange) configuration, PathFinder is
attached to the phone system through single line extension ports. This
provides the greatest flexibility for running PathFinder modules.
PathFinder must be configured this way to process call transfers.
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Incoming calls are routed through the phone system and are answered in
one of three ways:

Answered by a live operator, and then transferred to PathFinder

Answered directly by PathFinder

Routed to PathFinder only if an extension is busy or does not answer

Connect PathFinder to a PBX using any of the following lines.

Analog Line -- Your phone system must support analog (single-line)
telephone sets with hunt group capability. In a hunt group, if one line is
busy the PBX can roll the call over to the next line in the group. An analog
line uses an RJ-14 connector. In addition, the analog telephones must
have the following features:

Flash-hook transfer

Dial-out

Place call on hold

Re-connect

Loop current disconnect

Proprietary Connections -- Many phone systems have proprietary
connection methods that require a special card to access their
integration features. These include the SL1, NorStar, NEC, and Mitel
switches. The type of connector used depends on the phone system.

If a PBX integration was purchased with PathFinder, refer to Chapter 3,
Phone System Integration and Setup for specific information on attaching
your telephone system to PathFinder.

Software Security Key
Included with PathFinder is a software security key. It is designed to
unlock the various optional features of PathFinder.

PathFinder will not function properly if the security key hardware is not
installed.
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The security key hardware resembles a male/female parallel connector
that plugs into the parallel port on the back of the PC. If you have a
parallel printer or other device attached to that port:

1. Remove the printer cable from the PC port, if attached.

2. Install the security key hardware on the printer port.

3. Attach the printer to the software key (in other words, re-attach the
printer to the PC through the software key).

Install and Configure Operating System

This section covers installing and configuring your Windows NT® or
Windows 2000 operating system.

Before you can install the PathFinder software, you must install and
configure the operating system in order to optimize conditions for
running PathFinder. This configuration procedure installs and activates
the Streams Environment and TCP/IP.

Installation
To install your operating system, follow the installation instructions
provided by the operating system provider. For example, to install
Windows NT® or Windows 2000, follow the instructions provided by
Microsoft®.

Configuration
Before installing the PathFinder software, you must optimize your PC
operating system for running PathFinder. This overall procedure consists
of the following tasks:

Setting up a Windows administrator account

Configuring the operating system for automatic logon

Installing and activating the Streams Environment and TCP/IP

If attaching a printer to the software key, any errors from the printer
(e.g., out of paper or off-line) may cause PathFinder to go offline.
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Log On

Log On - Windows NT
To set up a Windows NT administrator account, perform the following
steps:

1. From the Start menu, select Programs > Administrative Tools > User
Manager.

2. From the File menu, select User > New User.

3. In the Username field, type PathFinder.

4. In the Password field, type the serial number for your PathFinder
software.

5. Clear the User must change password at next logon check box

6. Select the Password never expires check box

7. Click on the Groups button, and select Administrators in the right
pane.

8. Click Add.
9. Click OK.

10. Click OK.

11. Click the Close button in the upper-right corner to close the window.

Log On - Windows 2000
To set up a Windows 2000 administrator account, perform the following
steps:

1. From the Start menu, select Settings > Control Panel.

2. Double-click Users and Passwords Control Panel.
3. Click Advanced tab.

4. Click Advanced button.

5. Click Users Folder in left explorer window pane.

6. Click Action > New User...

7. Type Pathfinder in the Username field.

8. In the Password field, type the serial number for your PathFinder
software, then re-enter the serial number a second time in the
Confirm P/W field.

9. Clear the User must change password at next logon check box.
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10. Select the Password never expires check box.

11. Click Create.

12. Click Close.

13. Click Groups Folder in the left explorer window pane.

14. Double-click Administrators group in the right explorer window
pane.

15. Click Add...

16. Select the local domain in the look-in bar, if not already selected.

17. Double-click the Pathfinder account.

18. Click OK.

19. Click OK.

20. Close the Local Users and Groups window.

21. Click OK on Users and Passwords window.

Automatic Administration Logon

It is highly recommended that you set up the system to automatically log
on to Windows. If you do not create an Automatic Administration Logon
account, the system may not function correctly when shut down
unexpectedly.

Auto Log On - Windows NT
To allow the system to automatically log on to Windows NT® each time
the system reboots, do the following:

1. From the Start menu, select Run.

2. In the Open field, type Regedt32, then click OK.

3. Select HKey_Local_Machine.

4. Double-click Software.

5. Double-click Microsoft.

6. Double-click Windows NT.

7. Double-click Current Version.

8. Double-click Winlogon.

Create an Emergency Repair Disk before creating the Automatic
Administration Logon account.
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9. Double-click DefaultUserName.

10. Type in the username you created in “Log On - Windows NT” on
page 2-15, then press Enter when you finish typing.

11. Click Edit.

12. Choose Add Value.

13. In the Value Name field, type DefaultPassword, then press Enter
when you finish typing.

14. In the String field, type the password for the user name you created in
“Log On - Windows NT” on page 2-15, then press Enter when you finish
typing.

15. Click Edit/Add Value.

16. In the Value Name field, type AutoAdminLogon, then press Enter
when you finish typing.

17. In the String field, type 1, then press Enter when you finish typing.

18. Click the Close button in the upper-right corner to close the window.

Auto Log On - Windows 2000
To allow the system to automatically log on to Windows 2000 each time
the system reboots, do the following:

1. From the Start menu, select Run.

2. In the Open field, type Regedt32, then click OK.

3. Select HKey_Local_Machine/Software/Microsoft/Windows NT/
Current Version/Winlogon/DefaultUserName.

4. Type in the username (Pathfinder) that you created in “Log On -
Windows 2000” on page 2-15, then press Enter when you finish typing.

5. Click Edit.

6. Choose Add Value.

7. In the Value Name field, type DefaultPassword, then press Enter
when you finish typing.

8. In the String field, type the password for the user name you created in
“Log On - Windows 2000” on page 2-15, then press Enter when you
finish typing.

9. Double-click AutoAdminLogon.

10. Change the value to 1, then click OK.
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11. Double-click DefaultDomainName and verify that the value is the
name of the local domain or the desired logon domain. Change it if
necessary, then click OK.

12. Click OK.

13. Close Regedt32.

Install Adapter

To set up a network adapter, perform the following steps:

Install Adapter - Windows NT
1. From the Start menu, select Settings > Control Panel.

2. Double-click on the Network icon.

3. When prompted to install Networking, click No.

4. In the Network Settings window, click on the Adapters tab.

5. Click Add.

6. Select MS Loopback Adapter from the Network Adapters window.

7. When prompted for the frame type, select the default 802.3, then
click OK.

8. When prompted for the location of the NT Distribution Files, type or
browse to select the location. Click on Continue, then follow the on-
screen instructions.

9. When installation is complete, the Network Settings window displays.
Click OK to add the adapter information to the Registry.

10. When prompted to restart, select Don’t Restart Now.

Install Adapter - Windows 2000
1. From the Start menu, select Settings > Control Panel.

2. Double-click Add/Remove Hardware.

3. Click Next.

4. Select Add/Troubleshoot Device, then click Next.

If you have a network adapter card (NIC) in your system, confirm that
it is properly configured and operates within normal parameters (If
an NIC is installed, you must enable TCP/IP protocol). Then, you must
skip this ”Install Adapter" procedure and proceed instead to the
”Install Streams Environment" procedure.
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5. Select Add New Device, then click Next.

6. Select No, I want to select the hardware from a list, then click Next.

7. Select Network Adapters, then click Next.

8. Select Microsoft in the left window pane, select Microsoft
Loopback Adapter in the right window pane, then click Next.

9. Click Next.

10. Click Finish.

Install Streams Environment

Install Streams - Windows NT
To set up the streams environment when using Windows NT, perform the
following steps:

1. Double-click on the Network icon. When prompted to install
Networking, click No.

2. Click on the Protocol tab.

3. Click Add.

4. In the window that displays, click on the down arrow to the right of
the Apple Talk Protocol entry for a list of choices. Select Streams
Environment, then click Continue.

5. When prompted for location of NT Distribution Files, type or browse
to select location. Click Continue, then follow on-screen instructions.

6. When returned to the Network Settings dialog box, select Add.

7. In the window that displays, click on the down arrow to the right of
the Apple Talk Protocol entry for a list of choices. Select TCP/IP
Protocol and Related Components, then click on Continue.

8. Click OK, and the TCP/IP Configuration window displays.

9. Enter the IP address:

If you are on a network, enter the IP Address, Subnet Mask, and
Default Gateway supplied by your network administrator.

If you are on a standalone system, type the following values:

IP Address: 128.0.0.1

Subnet Mask: 255.255.255.0

10. When installation is complete, the Network Settings window displays.
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11. Click OK to add the Streams Environment and TCP/IP to the Registry.

12. When prompted if you want to restart, select Restart Now.

13. After restarting, check the Event Viewer to make sure that all network
drivers and protocols loaded properly.

After the restart, the adapter and/or Streams Environment are
installed and ready for operation. You can now continue with
PathFinder installation.

Install Streams - Windows 2000
When networking software is installed via the Windows 2000 operating
system, the streams environment is automatically configured.

Install PathFinder Software

You will install PathFinder software from the installation CD. You must
also install helper applications, such as Adobe® Acrobat Reader® and
Dialogic drivers.

Prerequisites & Preparation
Before you attempt to install the PathFinder software, ensure that you
perform the following tasks:

Install the software key and install and configure the voice cards.
(Refer to “Install and Configure Hardware” on page 2-5 for details.)

Install and configure Windows NT® for Streams service, if using
Windows NT. (Refer to “Install and Configure Operating System” on
page 2-14 for details.) Windows 2000 installs streams automatically.

Once you have performed these tasks, you are ready to install PathFinder
software.

Do not run other applications on the voice processing machine. If you
do, PathFinder may react erratically.
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Dialogic Drivers
Any new PathFinder installation requires the Dialogic drivers installation.

If you are upgrading an existing PathFinder application, you must first
disable and uninstall the existing drivers to install the new Dialogic
drivers.

Sentinel Drivers
It is recommended that you always install or upgrade the sentinel drivers.
This ensures that the latest drivers are always loaded. Existing drivers do
not need to be uninstalled prior to installation.

PBXpert
If you have a non-standard PBX, this utility can train PathFinder for your
phone system by learning tones such as busy, ringback, disconnect, etc.
This program operates only on Windows NT® 4.0 or higher.

Software Installation
To install the software required for PathFinder operation, follow these
steps.

Install PathFinder Software

Install Pathfinder Software - Windows NT
1. Make sure the software key is installed. Refer to “Software Security

Key” on page 2-13 for more information.

2. Insert the PathFinder CD into your CD-ROM drive.

3. From the Start menu, select Run . . . .

Each option in the setup menu has a dialog box at the bottom of the
screen that provides more information about that option.
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4. In the Open field, type <Your CD-ROM Drive 
Letter>:\setup.exe and click on OK.

Figure 2-2: Run Window

5. In the Welcome window, click Next.

6. Read the Software License Agreement, then click Yes at the end of the
document.

7. Select Components.

8. Click All to select all, then click Next.

9. Select PathFinder Server Components. If PathFinder server is selected,
you are prompted to select which of the PathFinder components you
would like to install.

10. Select only the options that apply or are specified in the order, and
click on Next to continue.

11. Indicate the destination folder as C:\HELLONT (if the installation is an
upgrade) or C:\PathFinder (if the installation is new), then click Next
to continue.

12. Indicate the program folder of PathFinder, then click Next to
continue.

13. Click Next to acknowledge that you have enough information to
continue.

14. For Startup folders, click All to select all, then click Next to continue.

15. To continue, click Next.
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PathFinder documentation may be available as a Portable Document
Format (PDF) file, which can be read using Adobe® <Default Paragraph
Font>Acrobat Reader™. When selecting options from the Setup menu,
clearing all options except this one automatically installs Acrobat Reader.

16. Read the Acrobat Licensing Agreement, then click Yes at the end of the
document.

17. Indicate a destination directory of C:\Acrobat4\Reader.

18. Clear the Display Acrobat Reader 4.0 Readme file check box, then
click Finish.

19. Click OK to continue.

20. Click Next in the Installation Successful window.

To complete software installation:

21. Save changes and exit.

22. Click OK.

23. Select Configuration Programs.

24. Check and activate Codekey Manager and MAINT, then click on
Next.

25. If the information matches, close Codekey Manager.

The Codekey Manager program allows you to view the options that
the sentinel allows. It also provides the capability to add new
features to PathFinder.

If you are installing PathFinder for the first time, it is not
necessary to change anything in the Codekey manager.
If this is a PathFinder upgrade, Codekey manager must unlock
features in order for you to use them. Contact your dealer for
further information.
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Install Pathfinder Software - Windows 2000
1. Make sure the software key is installed. Refer to “Software Security

Key” on page 2-13 for more information.

2. Insert the PathFinder CD into your CD-ROM drive.

3. From the Start menu, select Run . . . .

4. In the Open field, type <Your CD-ROM Drive 
Letter>:\setup.exe and click OK. (Example: CD-ROM drive
letter = E, type E:\setup.exe)

5. In the Welcome window click Next. (If dialogic drivers were installed
in a previous installation attempt, skip to Step 10)

6. Windows 2000 will inform you that Dialogic drivers have not been
installed. Click Next to install the drivers. The installation will
continue automatically.

7. Select Yes, I want to restart my computer now.

8. Click Finish.

9. After computer restarts, begin at step 1 again.

10. Select Skip Dialogic driver install, then click Next.

11. Click Yes.

12. Click Next to check Sentinel Driver installation.

13. Click Next (do not select First, Run codekey manager).
14. Select each item to install (recommend selection of all components).

15. Click Next to select the default destination folder.

16. Click Next to select the default program folder for PathFinder.

17. Click Next to acknowledge that you have enough information to
continue.

18. For startup folders, click All to select all, then click Next.

19. Click Next to install Adobe Acrobat 4.0.

20. Click Next in the Setup window.

21. Click Next to select the Default destination folder.

PathFinder installer window is in the background. Ignore this during
the Acrobat installation.
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22. Click OK in the information window.

To complete software installation:

23. De-select MAINT, then click Next.

24. Select either YES or NO, regarding the option to view the release
notes.

25. Click OK.

26. Click Finish.

Configure Dialogic Software & PBXpert

This section covers configuration of Dialogic software and PBXpert. For
PathFinder to work properly, you must configure the Dialogic software to
match the installed Dialogic hardware.

PBXpert allows the voice processing boards to learn the ring back, busy,
do not disturb, and other tones relevant to voice processing. This
software learns the tones and creates a tone set file for your telephone
system. PBXpert configuration involves walking through a Wizard
program.

Dialogic Software
After PathFinder software has been installed, the Start menu contains a
Dialogic program group, which contains the following items:

Advanced Tone Features -- Allow you to determine which tone set file
to use.

Dialogic Configuration Manager (DCM) -- Allows you to configure the
software to match your hardware settings for the voice processing
boards. Configures the software to recognize the Dialogic hardware.

Country-Specific Configuration -- Allows you to configure your voice
processing board (Dialogic hardware) for a particular country outside
the United States.

PBXpert -- Allows the voice processing boards to learn the ring back,
busy, do not disturb, and other tones relevant to voice processing.
Learns the tones and creates a tone set file for telephone systems.
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Release catalog -- Contains Dialogic release notes and information on
how to contact Dialogic technical support.

Set Dialogic Service Startup Mode -- Determines how the Dialogic
service is started by the Windows 2000/Windows NT® operating
system. Defines when the Dialogic service should be started.

Uninstall -- Completely removes the Dialogic system software from
your PC.

Universal Dialogic Diagnostic Utility (UDDU) -- Allows you to run tests
on your voice board to determine the integrity of the board.

Configuration

For PathFinder to work properly, you must configure the Dialogic
software to match the installed Dialogic hardware. Please note that the
Dialogic software may not work properly until the Streams Environment
has been installed. Refer to “Install Streams Environment” on page 2-19.
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Dialog/4
1. From the Start menu, select Programs > Dialogic System Software >

Dialogic Configuration Manager - DCM.

The following window displays:

2. Click Connect.
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The Dialogic Configuration Manager window appears:

3. Select Action > Add Device, as shown below:
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The Add Hardware Wizard window displays:

4. Select D/x1D in the left pane and Dialog/4 in the right pane, then
click Next.

The following window displays:
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5. Type a name to identify the board (e.g., Voice Board 1,as used in
the previous illustration), then click Next.

The following displays:

The system will reflect the lowest interrupt possible in the upper
pane of the window at the System tab. In this example, 3 is the
default interrupt value.

6. Change the interrupt value to match the hardware IRQ setting. Refer
to Table 2-3 and Figure 2-1 . Generally, you will use IRQ 5. If IRQ 5 is not
available, then use IRQ 7.
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7. Click OK and the following window displays:

The Dialog/4-Voice Board 1 is shown under D/x1D. Its icon has a
superimposed red dot and the message at the bottom of the window
indicates that the card has not been started.

8. The board configuration is complete. If you have multiple Dialog/4
cards, repeat this procedure starting at step 3 until all cards are
configured.

9. To start the dialogic boards, click on the Start Service icon in the
toolbar (identified by the green dot). A brief indication will appear in
the upper right of your desktop display to show the progress of the
dialogic services being loaded/started. When complete, the
superimposed red dot changes to green, the green icon in the
toolbar is grayed out, and the bottom of the window reflects Dialogic
System Service Status: Running.
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The illustration below shows that two dialogic cards are configured
and running.

10. Click File > Exit, then reboot to load dialogic drivers.
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VFX40ESC plus
1. From the Start menu, select Programs > Dialogic System Software >

Dialogic Configuration Manager - DCM.

The following window displays.

2. Click Connect.
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The Dialogic Configuration Manager window appears:

3. Click on the Stop Service icon in the toolbar (red stop sign).
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4. Select Action > Add Device, as shown below:

The Add Hardware Wizard window displays:

5. Select VFX in the left pane and VFX/40ESC Plus in the right pane, then
click Next.
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The following window displays:

6. Type a name to identify the board (e.g., Fax Board 1, as used in
the previous illustration), then click Next.
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The following displays:

7. Highlight the BLT Address parameter, then use the dropdown menu
to select a base memory address value of c0000.
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8. Highlight the BLT Interrupt parameter, then use the dropdown menu
to select the interrupt value to match the hardware IRQ setting. Refer
to Table 2-3 and Figure 2-1 . Generally, you will use IRQ 7.
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9. Click OK and the following window displays:

The VFX/40ESC Plus - Fax Board 1 is shown under VFX. Its icon has a
superimposed red dot and the message at the bottom of the window
indicates that the card has not been started.

10. The board configuration is complete. If you have multiple VFX cards,
repeat this procedure starting at step 4 until all cards are configured.

11. To start the dialogic boards, click on the Start Service icon in the
toolbar (identified by the green dot). A brief indication will appear in
the upper right of your desktop display to show the progress of the
dialogic services being loaded/started. When complete, the
superimposed red dot changes to green, the green icon in the
toolbar is grayed out, and the bottom of the window reflects Dialogic
System Service Status: Running.
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Upgrading From Previous Version
If you are upgrading from a previous version of PathFinder, you must
uninstall the previous version of Dialogic software. To remove the older
version of software, please follow these steps:

1. Locate the DIALOGIC.CFG file. The default location is
\DLGCDEV\DIALOGIC\CFG.

2. Copy the DIALOGIC.CFG to a floppy diskette.

3. Uninstall the existing version of the Dialogic System Software.

4. Install the new version of the Dialogic System Software.

5. Copy the DIALOGIC.CFG from the floppy to the
\DLGCDEV\DIALOGIC\CFG directory.

Removing a Board
To remove a board from the configuration, follow these steps:

1. From the Start menu, select Programs > Dialogic System Software >
Dialogic Configuration Manager - DCM.

2. Click on the Stop Service icon in the toolbar (red stop sign).

3. Highlight the board to be removed.
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4. Select Action > Delete Service,

-or-

Right-click on the board and choose Delete Device.
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Exiting Configuration Utility
To exit the board configuration utility:

Select File > Exit.

PBXpert

To configure PBXpert, you need the following:

Telephone system with 2 analog lines plugged into the Dialogic
boards and extension numbers for those ports

Dialogic voice board loaded into the PC with the memory address
and IRQ configured correctly

PathFinder software installed

Dialogic drivers installed

PBXpert software installed

Follow these steps to configure PBXpert:

Start Up Mode

Before running the PBXpert Wizard, the Dialogic drivers need to be
started. Either run the PathFinder Engine and then stop the PathFinder
Engine, or perform the following steps:

1. Select from the Start menu Programs > Dialogic System Software >
Dialogic Configuration Manager - DCM.

2. Click on the Start Service icon in the toolbar (identified by the green
dot).

You only need to configure PBXpert if you are using supervised transfers
AND you are not running on a phone system that appears in the certified
list.
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PBXpert Wizard
1. Select from the Start menu Programs > Dialogic System Software >

PBXpert.

2. The PBXpert Wizard displays.
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3. Click Next.

4. Type in the PBX Manufacturer and PBX Model number. The Tone Set
file name is created automatically from the Manufacturer and Model
number.
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5. Click Next.
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6. Leave the TAPI PBX strings set to None. Click Next.
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7. Choose the Dialogic Board Type to match the board you are going to
use for testing, then click Next.

8. Select the first channel to use for testing.

9. Type in the extension number that this channel is using.
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10. Click Next.

11. Select the second channel to use for testing.

12. Type in the extension number that this channel is using.
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13. Click Next.

Channels 1 and 2 are in one port, and channels 3 and 4 are in the
next port.
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14. Confirm your settings. Make certain Run Wizard Auto-Test is
selected. The Wizard Auto Test verifies that the correct channel is
plugged into the correct extension. Click Next.

15. When the Wizard Auto Test is successful, click OK.

16. Click Next.

17. The Wizard then runs a series of tests to learn the tones of the phone
system. This takes several minutes.

18. If the data have all green lights, then click Keep Data.

19. Click Next.

20. The Wizard verifies all of the settings it learned.

21. Click OK.

22. The Wizard displays the results from the test. Click Finish.

If you get an error during the Wizard Auto Test, confirm your
settings and re-test.

If there are any red lights, re-run the test.
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23. Select File > Exit, from the menu bar.

Advanced Tone Features & INI File

1. Select from the Start menu, Programs > Dialogic System Software >
Tone Features.

2. Make certain Disconnect Tone Supervision and Tone Set File
Enabled are selected.

3. Choose the correct tone file from the \Dlgcdev\Dialogic\Data
directory. The TSF (Tone Set File) name is a combination of the PBX
Manufacturer and Model number.

4. Click OK.

5. Select from the Start menu, Programs > Windows NT Explorer.

6. Double-click on the HELLONT directory.

7. Double-click on HELLONT.INI. This opens the HELLONT.INI file in
Notepad.

8. Find the [VoiceHardware] section. Go to the bottom of the
section and type use_perfect_call=1.

9. Save the file and exit.

Software Overview
This installation adds software to your PC. Some of this software is
discussed below.

Each application listed in the Voice Processing program group (on the
Start menu) is described below. Some of the applications displayed in the
Start menu’s Programs group are optional modules that are purchased
separately. All of the following application names display even if you
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have not purchased the corresponding module(s), but you cannot access
an optional module unless you have unlocked it on your software key.

Figure 2-3: PathFinder Start Menu

Boom Box -- A utility used to record, edit, and play back PathFinder voice
prompts.

Call List Admin -- For administrative use relating to the Chalk Talk
optional module.

CodeKey Manager -- Shows what options are enabled on the software
key. Allows you to upgrade PathFinder with an unlock code.

Internet Fax Admin -- For reporting and configuring the optional
internet fax module.
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Internet Fax Server -- Controls the internet fax module.

Maint -- The module used to configure the voice processing engine.

Onelook -- Controls access to the Onelook module.

Point to Point -- Controls access to the Point to Point module.

Q&A Admin -- Allows you to set parameters for query of callers to get
multiple responses and retrieve the answers from one mailbox location.

TeleQueue Reports -- Provides reports that detail the operation of the
call queueing system.

Installation Troubleshooting
The following installation problems may be solved as follows:

PathFinder Won’t Start
Check the error log file (C:\PathFinder\Logs\Error.Log) for the following
error:

Monitor displays the following error:

Attach the software key (activator) to LPT1 on the PC. Refer to “Software
Security Key” on page 2-13 for more information.

Please make sure the Sentinel key is attached and the 
drivers are loaded. Program terminating, press a key.

Failed to wait for startup signal event.
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How Can I Be Certain I Configured My Dialogic Boards
Correctly?

The best way to determine if your Dialogic boards are configured
correctly is to use the Universal Dialogic Diagnostic Utility (UDDU). Run
the Dialogic Configuration Manager (DCM) to edit configurations.

1. Access the UDDU program by selecting from the Start menu
Programs > Dialogic System Software > Universal Dialogic Diagnostic
Utility.

2. The system warns you that all Dialogic boards will be stopped; select
Yes.

3. Select the type of board and type of tests that you would like to run.
Consult your Dialogic documentation for details on available tests.

4. Investigate any failure.

5. If you get a failure in the PC Interrupt test, double check your IRQ
settings on the board and in the Dialogic software.

Do not start the UDDU while any PathFinder software is running.



333 Phone System
Integration and Setup

This chapter describes the Simplified Message Desk Interface (SMDI)
integration process, and how to setup the STARPLUS® and infinite®

phone systems.
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Phone System Integration Protocols

The software required to configure the Simplified Message Desk Interface
(SMDI) integration is included as part of the standard PathFinder package.

SMDI
SMDI is a special integration module used in particular telephone
systems, especially larger telephone systems such as CENTREX, Fujitsu
9600, and NEC2400. SMDI integration requires an RS-232 connection
between the telephone system and PathFinder.

Prerequisites

To integrate PathFinder with an SMDI protocol, you first must have a
functioning PathFinder application with at least one available COM port.

Switch Requirements
The telephone system must support the SMDI protocol. Certain phone
systems require additional hardware, such as Voice Bridge. Consult your
sales representative regarding any additional hardware requirements.

The following procedures apply only to integrating PathFinder; they do
not apply to setting up your telephone system.
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Integration

Configuration Process
To configure the SMDI integration, follow these steps:

1. Configure the phone system switch (PBX) to send all calls to the
PathFinder ports based on Busy and/or No Answer conditions.

2. If you are using a Voice Bridge, follow the Voice Bridge instructions to
configure the device.

3. Connect the SMDI link (or Voice Bridge) to the PC’s COM1 port. The
default is 1200 E71. If you need to change these parameters, you can
modify the SMDI.INI file (refer to “SMDI.INI File” on page 3-4).

4. From the Start menu, select Programs > PathFinder Voice
Processing > MAINT.

5. SMDI integrations require two auxiliary lines. The first is used for
Message Manager, the second to process the SMDI packets from the
telephone system. Follow these steps to configure the auxiliary line:

a. From the MAINT menu bar, select Configuration > System
Settings > Auxiliary Tasks.

b. Make sure that there is no event group selected.

c. Click Add to add a new task; this new task must be the second task.

d. In the Name field, select SMDISV.

e. When you are finished, click on Accept.

6. From the main MAINT window, click the Lines button in the toolbar.

7. Make sure that the PBX entry for each of the lines is SMDI.
8. Create the necessary mailbox and extension numbers.

9. From the main MAINT window, select Configuration > Telephony
Settings > MWI Notification.

10. Set the message waiting indicators’ Set and Clear values to SMDI.

11. Bring up the system and test the integration as needed.
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Adding Registry Variables
These options correspond to registry variables that can be added to
PathFinder by following these steps:

1. From the Start menu, select Programs > PathFinder Voice
Processing > MAINT to open the MAINT application.

2. From the menu bar, select Configuration > Registry.

3. In the Registry setup window, fill in the name and value for each
desired option (refer to Table 3-1 ). Leave all other fields blank.

Customization Parameters
You can customize six aspects of the SMDI integration, as follows:

Table 3-1: SMDI Defaults

SMDI Parameters Default Description

SmdiMaxRings 5 rings This parameter controls how many rings PathFinder waits
before answering a call as non-integrated.

SmdiMaxWaitTime 6 seconds This parameter controls how many seconds PathFinder waits
after receiving a ring or SMDI packet before it gives up.

SmdiSkipCheck OFF When SkipCheck is turned on, PathFinder does not confirm
that mailboxes exist when the packet is received. To turn this
option on, use one in the Value field. To turn this option off,
delete all data in the Value field.

SmdiDigitLength 7 This is the number of digits coming in from the switch.

SmdiXOnXOff OFF If you are having problems communicating with the PBX or
Voice Bridge, make sure that XOn/XOff is being used. If it is
being used, set this value to one.

SmdiMbxPassword This parameter is not used.
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SMDI.INI File
The SMDI.INI file can be used to change the RS232 settings. By default,
PathFinder uses the following settings:

Baud rate: 1200

Parity: Even

Data Bits: Seven

Stop Bits: One

The SMDI.INI file can change any or all of these parameters, as well as the
registry variable (r_ird).

The file is located in the Data directory; it is a DOS text file and can be
edited as such. Here is an example:
; Lines beginning with semicolons are comments
ComPort=2
ComBaudRate=9600
ComParams=N81
r_ird=1
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Problem Diagnosis
The SMDI system can log more information if you need to diagnose
system problems. In order to log such information, turn on Integration
Debugging/Logging.

RS-232 Connection
The serial port providing integration from the SMDI must be connected
to the serial port on the PC, not the parallel port. This has been a major
problem with some installations.

With Windows NT®, you can use the HyperTerminal program in
Programs > Accessories > HyperTerminal > HyperTerminal to verify you
are communicating with the PBX/Voice Bridge. Make sure the COM
settings are correct for the connection.

Other Protocols
Call Vodavi Technical Support for assistance in integrating other protocols.
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Phone System Set Up

Follow the integration instructions that pertain to your telephone system
in order for it to work with PathFinder.

Starplus Systems

Starplus 2448EX

Hardware Requirements

One SLT port per PathFinder voice port. Each SLT card provides eight
ports.

One APB card. There are two DTMF receivers built on the APB card.

One SLU module. The SLU is installed on the APB card. The SLU
provides four additional DTMF receivers for a total of six.

One ring generator (RGU) unit is needed.

Supported Features

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Outdial (to pager or specific number).

Multiple Return to Operator.
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Table 3-2: Starplus 2448 EX - Configuration Setup

1. From Station 10, enter the Admin code of
✳✳2366 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group:
press Flash 50, enter SLT extension range to
be assigned to the VM group (XX-XX), press
Page A, Btn 6.

3. Press Flash 36, Btn 1 to enter VM group
programming for VM group 690.

4. Press Flash 36, Btn 12 and enter the SLT
ports into VM group 690.

5. Press Flash 36, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 37.
b. Enter [0] + [0] + [TRANS] + [7] + [HOLD].

- First 0 is the table number assigned
- Second 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 37.
b. Enter [1] + [0] + [TRANS] + [7] + [HOLD].

- 1 is the table number assigned
- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Enter [1] + [1] + [✳] + [HOLD].
- First 1 is the table number assigned
- Second 1 is a suffix digit
- ✳ is a digit that informs PathFinder that this

is a subscriber.

d. Enter [8] + [0] + [#9999999] +
[HOLD].
- 8 is the disconnect table
- 0 is a required entry
- #9999999 is the disconnect code used by

PathFinder

8. Press Flash 40, Btn 4, enter the CO line
range, dial [4] on the dialpad, then press
[HOLD] to enable Loop Supervision for
all CO lines.
To ring CO lines directly to VM, program VM
extensions into a UCD group in addition to the
VM group.

9. UCD group programming.
a. Press Flash 19, Btn 11.
b. Enter the station numbers into the

UCD group, then press [HOLD].
10. Program CO lines to ring the UCD

group.
a. Press Flash 40 to enter CO line

programming.
b. Enter the CO line range, then press

[HOLD].
c. Press Btn 9, enter the UCD group

number [890], then press [HOLD].
11. Press Flash 90, then press [HOLD] to

update and exit the programming
mode.

12. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [690] on the keypad.
d. Press the [ON/OFF] button.

Disconnect digits are not sent for internal calls. They are only sent for
disconnecting CO calls when Loop Supervision is enabled.
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Starplus 96EX

Hardware Requirements

One SIB port per PathFinder voice port. Each SIB card provides eight
ports.

One APL card. There are two DTMF receivers built on the APL card.

One SLU module. The SLU is installed on the APL card. The SLU
provides four additional DTMF receivers for a total of six.

One Ring Generator (RGU) Unit is needed.

Supported Features

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Outdial (to pager or specific number).

Multiple Return to Operator.
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Table 3-3: Starplus 96EX - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳2366 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), press
Btn 13, then press [HOLD].

3. Press Flash 36, Btn 1 to enter VM group
programming for VM group 690.

4. Press Flash 36, Btn 12 and enter the SLT ports
into VM group 690.

5. Press Flash 36, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 37.
b. Enter [0] + [0] + [TRANS] + [7] + [HOLD].

- First 0 is the table number assigned
- Second 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 37.
b. Enter [1] + [0] + [TRANS] + [7] + [HOLD].

- 1is the table number assigned
- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Enter [1] + [1] + [✳] + [HOLD].
- First 1 is the table number assigned
- Second 1 is a suffix digit
- ✳ is a digit that informs PathFinder that

this is a subscriber.

d. Enter [8] + [0] + [#9999999] +
[HOLD].
- 8 is the disconnect table
- 0 is a required entry
- #9999999 is the disconnect code used by

PathFinder

8. Press Flash 40, Btn 4, enter the CO line
range, dial [4] on the dialpad, then
press [HOLD] to enable Loop
Supervision for all CO lines.

9. Program CO line ringing assignments.
a. Press Flash 40 to enter CO line

programming.
b. Enter the CO line range, then press

[HOLD].
c. Press Btn 9, then Btn 1 to program

ringing assignments.
d. Enter [690] + [3] on the dial pad,

then press [HOLD].
- 690 is the voice mail group
- 3 is for day and night ringing

10. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [690] on the keypad.
d. Press the [ON/OFF] button.

Disconnect digits are not sent for internal calls. They are only sent for
disconnecting CO calls when Loop Supervision is enabled.
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Starplus SPD 612

Hardware Requirements
The following are the hardware requirements for the STARPLUS SPD 612
in-band integration:

One 2 x 4 SLT expander card. Each card provides four SLT circuits. Or
one OPX box per VM port can be used. Each OPX box decreases DKT
ports by one.

One DTMF receiver module must be installed on the 2 x 4 SLT card.
This provides one DTMF receiver. OPX boxes contain their own DTMF
receiver internally.

One ring generator unit is needed when using the 2 x 4 SLT card.

A 48 volt power supply is needed if using the OPX box to connect to
PathFinder. Each OPX box draws 500 ma of current.

Supported Features
The supported features of the STARPLUS SPD 612 include:

Station forward to a personal greeting.

Message waiting on/off LEDs.

Stations can transfer a caller directly to a mailbox without supervising
the call.

Outdial (to pager or specific number).

Multiple Return to Operator
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Table 3-4: Starplus SPD 612 - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, Btn 1 to select Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, Btn 2 to select Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.

d. Enter [1] + [✳] + [HOLD].
- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that

this is a subscriber.

e. Enter [9] + [#9999999] + [HOLD].
- 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Press Flash 40, Btn 6, enter the CO line
range, press [HOLD], press Btn 6, dial [4]
on the dialpad, then press [HOLD] to
enable Loop Supervision for all CO
lines.

9. Program CO line ringing assignments.
a. Press Flash 40 to enter CO line

programming.
b. Enter the CO line range, then press

[HOLD].
c. Press Btn 11 to program ringing

assignments.
d. Enter [440] + [7] on the dial pad,

then press [HOLD].
- 440 is the voice mail group
- 7 is for day and night ringing

10. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.
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Starplus SPD 1428

Hardware Requirements
The following are the hardware requirements for the STARPLUS SPD 1428
digital in-band integration:

One SLT port per PathFinder voice port. Each 2 x 4 SLT card provides
four ports.

One DTMF Receiver module. The DTMF is installed on the 2 x 4 SLT
card. The DTMF provides one additional DTMF receiver for a total of
two. If the phone system has an expansion KSU and
2 x 4 or 4 x 8 card installed, an additional DTMF receiver can be
installed on these. This would bring the total to four DTMF receivers.
OPX boxes contain their own DTMF receiver internally. A 48V power
supply is needed.

One Ring Generator unit is needed.

Supported Features
The supported features of the STARPLUS 1428 SPD include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Stations transfer caller directly to mailbox.

Outdial (to pager or specific number).

Multiple Return to Operator.



Phone System Set Up 3-13
Table 3-5: Starplus SPD 1428 - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, Btn 1 to select Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, Btn 2 to select Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.

d. Enter [1] + [✳] + [HOLD].
- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that

this is a subscriber.

e. Enter [9] + [#9999999] + [HOLD].
- 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Press Flash 40, Btn 6, enter the CO line
range, press [HOLD], press Btn 6, dial [4]
on the dialpad, then press [HOLD] to
enable Loop Supervision for all CO
lines.

9. Program CO line ringing assignments.
a. Press Flash 40 to enter CO line

programming.
b. Enter the CO line range, then press

[HOLD].
c. Press Btn 11 to program ringing

assignments.
d. Enter [440] + [7] on the dial pad,

then press [HOLD].
- 440 is the voice mail group
- 7 is for day and night ringing

10. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.
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Starplus SPD 2856

Hardware Requirements
The following are the hardware requirements for the STARPLUS SPD 2856
digital in-band integration:

One SLT port per PathFinder voice port. Each 4 x 8 SLT card provides
eight ports.

One DTMF Receiver module. The DTMF is installed on the 4 x 8 SLT
card or other 4 x 8 cards. The DTMF provides one DTMF receiver.

One Ring Generator unit is needed.

Supported Features
The supported features of the STARPLUS SPD 2856 include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Outdial (to pager or specific number).

Multiple Return to Operator.

Stations transfer callers directly to mailbox.
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Table 3-6: Starplus SPD 2856 - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, Btn 1 to select Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, Btn 2 to select Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.

d. Enter [1] + [✳] + [HOLD].
- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that

this is a subscriber.

e. Enter [9] + [#9999999] + [HOLD].
- 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Press Flash 40, Btn 6, enter the CO line
range, press [HOLD], press Btn 6, dial [4]
on the dialpad, then press [HOLD] to
enable Loop Supervision for all CO
lines.

9. Program CO line ringing assignments.
a. Press Flash 40 to enter CO line

programming.
b. Enter the CO line range, then press

[HOLD].
c. Press Btn 11 to program ringing

assignments.
d. Enter [440] + [7] on the dial pad,

then press [HOLD].
- 440 is the voice mail group
- 7 is for day and night ringing

10. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.



3-16 Phone System Set Up
Starplus SPD 4896

Hardware Requirements
The following are the hardware requirements for the STARPLUS SPD 4896
in-band integration:

One SLT port per PathFinder voice port. Each SL12 card provides
twelve ports.

One DTM4 installed on the SL12. DTM4 provides four DTMF receivers.

In lieu of a DTM4, a 6 X 6 Combo card can be installed. This provides
six DTMF receivers.

One Ring Generator unit and a 48V power supply are needed.

Supported Features
The supported features of the STARPLUS SPD 4896 include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Stations can transfer a caller directly to a mailbox without supervising
the call.

Outdial (to a pager or specific number).

Multiple Return to Operator.
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Table 3-7: Starplus SPD 4896 - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, Btn 1 to select Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, Btn 2 to select Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.

d. Enter [1] + [✳] + [HOLD].
- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that

this is a subscriber.

e. Enter [9] + [#9999999] + [HOLD].
- 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Press Flash 40, Btn 6, enter the CO line
range, press [HOLD], press Btn 6, dial [4]
on the dialpad, then press [HOLD] to
enable Loop Supervision for all CO
lines.

9. Program CO line ringing assignments.
a. Press Flash 40 to enter CO line

programming.
b. Enter the CO line range, then press

[HOLD].
c. Press Btn 11 to program ringing

assignments.
d. Enter [440] + [7] on the dial pad,

then press [HOLD].
- 440 is the voice mail group
- 7 is for day and night ringing

10. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.



3-18 Phone System Set Up
Starplus DHS

Hardware Requirements

An SLA Analog adapter

Supported Features (FP2 ONLY)
The supported features of the STARPLUS DHS include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Stations can transfer a caller directly to a mailbox without supervising
the call.

Outdial (to a pager or specific number).

Multiple Return to Operator.
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Table 3-8: Starplus DHS - Configuration Setup

1. Connect the single line adapter box to the
PathFinder PC (note the extension
numbers).

2. Enter programming mode: [FEAT] + [#] + [*]
+ [000000].

3. Press [SHOW].
4. Press [NEXT] to go to the station area. Press

[SHOW].
5. Enter the first station number on the keypad

to be included as a VM port. Press [SHOW].
6. Press [NEXT] until the VM PORT entry is on

the display.
7. Press [CHG] to mark VM PORT=Y.
8. Repeat this procedure for all stations to be

entered as VM ports.
9. Press [SAVE], then press [HOLD] twice.
10. Press [NEXT] until SYSTEM APPLICATION

appears. Press [SHOW].
11. Press [SHOW] at the STATION HUNT GROUP

entry.
12. Enter [1] on the keypad and press [SHOW].
13. Press [CHG] to mark the group as a VM type,

then press [NEXT].
14. Press [SHOW] at the GROUP MEMBER entry.
15. Press [CHG], enter the station number to be

assigned in the group, then press [SAVE].
16. Repeat the procedure until all stations are

entered in the group.
17. Press [SAVE]. Then press [HOLD] twice to

return to the STATION HUNT entry.
18. Press [NEXT] to go to the VM screen, then

press [SHOW].
19. Press [CHG] at the ICM PREFIX entry.

20. Press [FEAT], dial [70] + [7], then press
[SAVE].

Press [NEXT] to go to the XFR
PREFIX.
Press [CHG] at the XFR PREFIX entry.
Press [FEAT] and dial [70] + [7], then
press [SAVE].

21. Press [NEXT] until the ICM SUFFIX
entry is shown.

22. Press [CHG] at the ICM SUFFIX entry.
23. Dial [*], then press [SAVE].
24. Press [NEXT] until DIS DGT appears.
25. Press [CHG], dial [#9999999], then

press [SAVE].
26. Press [HOLD] twice.
27. Press [BACK] twice until 4. RESOURCE

appears.
28. Press [SHOW].
29. Press [CHG] until Ring Scheme

shows 1, then press [CLEAR].
Assign a VM flexible buttons on each
station as follows:

Press [FEAT] + [#] + [3].
Press flexible button to program
Press [CHG] (soft key) + [FEAT] (soft
key).
Press [FEAT] + [64]. Press [SAVE]
(soft key).

NOTE -- If Call Screening is used with the DHS,
then the transferred to party must go on hook
after either rejecting the call or transferring the
caller to another extension.
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Starplus Triad-S

Hardware Requirements
The following are the hardware requirements for the STARPLUS Triad-S in-
band integration:

One SLIB port per PathFinder voice port. Each SLIB card provides six
ports.

One DTRU installed on the SLIB. DTRU provides two DTMF receivers.

One RGU (ring generator) unit is needed. This can be an internal or
external RGU.

Supported Features
The supported features of the STARPLUS Triad-S include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Stations can transfer a caller directly to a mailbox without supervising
the call.

Outdial (to a pager or specific number).

Multiple Return to Operator.
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Table 3-9: Starplus Triad-S - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, then press Btn 1 to select

Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, then press Btn 2 to select

Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.
d. Enter [1] + [✳] + [HOLD].

- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that

this is a subscriber.

e. Press Btn 9, enter [#9999999] +
[HOLD].
- Btn 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.

NOTE -- You can adjust the volume level on each
SLT port by using the volume up or down code.
This provides additional control for both internal
and external calls into PathFinder.

IMPORTANT -- If Call Screening is used with
Triad-S, then Auto Callback must be disabled in
the phone system (FLASH 01, Button 17).
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Starplus Triad 1

Hardware Requirements
The following are the hardware requirements for the STARPLUS Triad 1 in-
band integration:

One SLIB port per PathFinder voice port. Each SLIB card provides six
ports.

One DTRU installed on the SLIB. DTRU provides two DTMF receivers.

One RGU (ring generator) unit is needed. This can be an internal or
external RGU.

Supported Features
The supported features of the STARPLUS Triad 1 include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Stations can transfer a caller directly to a mailbox without supervising
the call.

Outdial (to a pager or specific number).

Multiple Return to Operator.
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Table 3-10: Starplus Triad 1 - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, then press Btn 1 to select

Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, then press Btn 2 to select

Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.
d. Enter [1] + [✳] + [HOLD].

- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that

this is a subscriber.

e. Press Btn 9, enter [#9999999] +
[HOLD].
- Btn 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.

NOTE -- You can adjust the volume level on each
SLT port by using the volume up or down code.
This provides additional control for both internal
and external calls into PathFinder.

IMPORTANT -- If Call Screening is used with
Triad 1, then Auto Callback must be disabled in
the phone system (FLASH 01, Button 17).
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Starplus Triad 2

Hardware Requirements
The following are the hardware requirements for the STARPLUS Triad 2 in-
band integration:

One SLIB port per PathFinder voice port. Each SLIB card provides six
ports.

One DTRU installed on the SLIB. DTRU provides two DTMF receivers.

One RGU (ring generator) unit is needed. This can be an internal or
external RGU. One or two SLIBs is an internal RGU, and more than two
SLIBs are an external RGU.

Supported Features
The supported features of the STARPLUS Triad 2 include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Stations can transfer a caller directly to a mailbox without supervising
the call.

Outdial (to a pager or specific number).

Multiple Return to Operator.
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Table 3-11: Starplus Triad 2 - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, then press Btn 1 to select

Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, then press Btn 2 to select

Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.
d. Enter [1] + [✳] + [HOLD].

- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that

this is a subscriber.

e. Press Btn 9, enter [#9999999] +
[HOLD].
- Btn 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.

NOTE -- You can adjust the volume level on each
SLT port by using the volume up or down code.
This provides additional control for both internal
and external calls into PathFinder.

IMPORTANT -- If Call Screening is used with
Triad 2, then Auto Callback must be disabled in
the phone system (FLASH 01, Button 17).
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Starplus Triad 3

Hardware Requirements
The following are hardware requirements for the STARPLUS Triad 3 in-
band integration:

One SLIB port per PathFinder voice port. Each SLIB card provides
twelve ports.

One DTMF-A installed on the SLIB. DTMF-A provides four DTMF
receivers.

One RGU (ring generator) unit is needed.

Supported Features
The supported features of the STARPLUS Triad 3 include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Stations can transfer a caller directly to a mailbox without
supervising the call.

Outdial (to a pager or specific number).

Multiple Return to Operator.
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Table 3-12: Starplus Triad 3 - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, then press Btn 1 to select

Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, then press Btn 2 to select

Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.
d. Enter [1] + [✳] + [HOLD].

- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that

this is a subscriber.

e. Press Btn 9, enter [#9999999] +
[HOLD].
- Btn 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.

NOTE -- You can adjust the volume level on each
SLT port by using the volume up or down code.
This provides additional control for both internal
and external calls into PathFinder.

IMPORTANT -- If Call Screening is used with
Triad 3, then Auto Callback must be disabled in
the phone system (FLASH 01, Button 17).
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infinite Systems

infinite 4096

Hardware Requirements
The following are the hardware requirements for the infinite 4096 in-
band integration:

One SIB port per PathFinder voice port. Each SIB card provides eight
ports.

One APL card. There are two DTMF receivers built on the APL card.

One SLU module. The SLU is installed on the APL card. The SLU
provides four additional DTMF receivers for a total of six.

One Ring Generator (RG) unit is needed.

Supported Features
The supported features of the infinite 4096 include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Outdial (to pager or specific number).

Multiple Return to Operator.
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Table 3-13: infinite 4096 - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳2366 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), press
Btn 13, then press [HOLD].

3. Press Flash 36, Btn 1 to enter VM group
programming for VM group 690.

4. Press Flash 36, Btn 12 and enter the SLT ports
into VM group 690.

5. Press Flash 36, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 37.
b. Enter [0] + [0] + [TRANS] + [7] + [HOLD].

- First 0 is the table number assigned
- Second 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 37.
b. Enter [1] + [0] + [TRANS] + [7] + [HOLD].

- 1is the table number assigned
- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Enter [1] + [1] + [✳] + [HOLD].
- First 1 is the table number assigned
- Second 1 is a suffix digit
- ✳ is a digit that informs PathFinder that

this is a subscriber.

d. Enter [8] + [0] + [#9999999] +
[HOLD].
- 8 is the disconnect table
- 0 is a required entry
- #9999999 is the disconnect code used by

PathFinder

8. Press Flash 40, enter the CO line range,
dial [4] on the dialpad, press [HOLD],
press Btn 4, then press [HOLD] to
enable Loop Supervision for all CO
lines.

9. Program CO line ringing assignments.
a. Press Flash 40 to enter CO line

programming.
b. Enter the CO line range, then press

[HOLD].
c. Press Btn 9, then Btn 1 to program

ringing assignments.
d. Enter [690] + [3] on the dial pad,

then press [HOLD].
- 690 is the voice mail group
- 3 is for day and night ringing

10. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [690] on the keypad.
d. Press the [ON/OFF] button.

Disconnect digits are not sent for internal calls. They are only sent for
disconnecting CO calls when Loop Supervision is enabled.
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infinite DVX I

Hardware Requirements
The following are the hardware requirements for the infinite DVX I
in-band integration:

One SLT port per PathFinder voice port. Each 2 x 4 SLT card provides
four ports.

One DTMF Receiver module. The DTMF is installed on the 2 x 4 SLT
card. The DTMF provides one additional DTMF receiver for a total of
two. If the phone system has an expansion KSU and 2 x 4 or 4 x 8 card
installed, an additional DTMF receiver can be installed on these. This
would bring the total to four DTMF receivers. OPX boxes contain their
own DTMF receiver internally. A 48V power supply is needed.

One Ring Generator unit is needed.

Supported Features
The supported features of the infinite DVX I include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Stations transfer caller directly to mailbox.

Outdial (to pager or specific number).

Multiple Return to Operator.
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Table 3-14: infinite DVX I - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, Btn 1 to select Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, Btn 2 to select Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.
d. Enter [1] + [✳] + [HOLD].

- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that this is

a subscriber.

e. Press Btn 9, enter [#9999999] +
[HOLD].
- Btn 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Press Flash 40, enter the CO line range,
press [HOLD], press Btn 6, dial [4] on the
dialpad, then press [HOLD] to enable
Loop Supervision for all CO lines.

9. Program CO line ringing assignments.
a. Press Flash 40 to enter CO line

programming.
b. Enter the CO line range, then press

[HOLD].
c. Press Btn 11 to program ringing

assignments.
d. Enter [440] + [7] on the dial pad,

then press [HOLD].
- 440 is the voice mail group
- 7 is for day and night ringing

10. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.

NOTE -- You can adjust the volume level on each
SLT port by using the volume up or down code.
This provides additional control for both internal
and external calls into PathFinder. Handset
receiver gain feature must be turned on, Flash 05,
Button 13.
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infinite DVX II

Hardware Requirements
The following are the hardware requirements for the infinite DVX II in-
band integration:

One SLT port perPathFinder voice port. Each 4 x 8 SLT card provides
eight ports.

One DTMF Receiver module. The DTMF is installed on the 4 x 8 SLT
card or other 4 x 8 cards. The DTMF provides one DTMF receiver.

One Ring Generator unit is needed.

Supported Features
The supported features of the infinite DVX II include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Outdial (to pager or specific number).

Multiple Return to Operator.

Stations transfer callers directly to mailbox.
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Table 3-15: infinite DVX II - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, Btn 1 to select Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, Btn 2 to select Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.
d. Enter [1] + [✳] + [HOLD].

- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that this is

a subscriber.

e. Press Btn 9, enter [#9999999] +
[HOLD].
- Btn 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Press Flash 40, enter the CO line range,
press [HOLD], press Btn 6, dial [4] on the
dialpad, then press [HOLD] to enable
Loop Supervision for all CO lines.

9. Program CO line ringing assignments.
a. Press Flash 40 to enter CO line

programming.
b. Enter the CO line range, then press

[HOLD].
c. Press Btn 11 to program ringing

assignments.
d. Enter [440] + [7] on the dial pad,

then press [HOLD].
- 440 is the voice mail group
- 7 is for day and night ringing

10. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.

NOTE -- You can adjust the volume level on each
SLT port by using the volume up or down code.
This provides additional control for both internal
and external calls into PathFinder. Handset
receiver gain feature must be turned on, Flash 05,
Button 13.
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infinite DVX III

Hardware Requirements
The following are the hardware requirements for the infinite DVX III in-
band integration:

One SLT port per PathFinder voice port. Each SL12 card provides
twelve ports.

One DTM4 installed on the SL12. DTM4 provides four DTMF receivers.

In lieu of a DTM4, a 6 X 6 Combo card can be installed. This provides
six DTMF receivers.

One Ring Generator unit and a 48V power supply are needed.

Supported Features
The supported features of the infinite DVX III include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Stations can transfer a caller directly to a mailbox without supervising
the call.

Outdial (to a pager or specific number).

Multiple Return to Operator.
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Table 3-16: infinite DVX III - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, Btn 1 to select Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, Btn 2 to select Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.
d. Enter [1] + [✳] + [HOLD].

- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that this is

a subscriber.

e. Press Btn 9, enter [#9999999] +
[HOLD].
- Btn 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Press Flash 40, enter the CO line range,
press [HOLD], press Btn 6, dial [4] on the
dialpad, then press [HOLD] to enable
Loop Supervision for all CO lines.

9. Program CO line ringing assignments.
a. Press Flash 40 to enter CO line

programming.
b. Enter the CO line range, then press

[HOLD].
c. Press Btn 11 to program ringing

assignments.
d. Enter [440] + [7] on the dial pad,

then press [HOLD].
- 440 is the voice mail group
- 7 is for day and night ringing

10. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.

NOTE -- You can adjust the volume level on each
SLT port by using the volume up or down code.
This provides additional control for both internal
and external calls into PathFinder.
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infinite Mach 1

Hardware Requirements
The following are the hardware requirements for the infinite Mach I in-
band integration:

One SLIB port per PathFinder voice port. Each SLIB card provides six
ports.

One DTRU installed on the SLIB. DTRU provides two DTMF receivers.

One RGU (ring generator) unit is needed. This can be an internal or
external RGU.

Supported Features
The supported features of the infinite Mach I include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Stations can transfer a caller directly to a mailbox without supervising
the call.

Outdial (to a pager or specific number).

Multiple Return to Operator.
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Table 3-17: infinite Mach I - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, Btn 1 to select Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, Btn 2 to select Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.
d. Enter [1] + [✳] + [HOLD].

- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that

this is a subscriber.

e. Press Btn 9, enter [#9999999] +
press [HOLD].
- Btn 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.

NOTE -- You can adjust the volume level on each
SLT port by using the volume up or down code.
This provides additional control for both internal
and external calls into PathFinder.

IMPORTANT -- If Call Screening is used with
Mach I, then Auto Callback must be disabled in
the phone system (FLASH 01, Button 17).
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infinite DVXPlus II

Hardware Requirements
The following are the hardware requirements for the infinite DVX PLUS II
in-band integration:

One SLIB port per PathFinder voice port. Each SLIB card provides six
ports.

One DTRU installed on the SLIB. DTRU provides two DTMF receivers.

One RGU (ring generator) unit is needed. This can be an internal or
external RGU.

Supported Features
The supported features of the infinite DVX PLUS II include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Stations can transfer a caller directly to a mailbox without supervising
the call.

Outdial (to a pager or specific number).

Multiple Return to Operator.
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Table 3-18: infinite DVXPlus II - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, Btn 1 to select Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, Btn 2 to select Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.
d. Enter [1] + [✳] + [HOLD].

- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that

this is a subscriber.

e. Press Btn 9, enter [#9999999] +
press [HOLD].
- Btn 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.

NOTE -- You can adjust the volume level on each
SLT port by using the volume up or down code.
This provides additional control for both internal
and external calls into PathFinder.

Subscribers are defined as users with a mailbox
and extension on PathFinder. The subscriber does
not have to use both the mailbox and / or
extension.
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infinite DVXPlus III

Hardware Requirements
The following are the hardware requirements for the infinite DVX PLUS III
in-band integration:

One SLIB port per PathFinder voice port. Each SLIB card provides six
ports.

One DTRU installed on the SLIB. DTRU provides two DTMF receivers.

One RGU (ring generator) unit is needed. This can be an internal or
external RGU. One or two SLIBs is an internal RGU, and more than two
SLIBs are an external RGU.

Supported Features
The supported features of the infinite DVX PLUS III include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Stations can transfer a caller directly to a mailbox without
supervising the call.

Outdial (to a pager or specific number).

Multiple Return to Operator.
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Table 3-19: infinite DVXPlus III - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, Btn 1 to select Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, Btn 2 to select Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.
d. Enter [1] + [✳] + [HOLD].

- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that

this is a subscriber.

e. Press Btn 9, enter [#9999999] +
press [HOLD].
- Btn 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.

NOTE -- You can adjust the volume level on each
SLT port by using the volume up or down code.
This provides additional control for both internal
and external calls into PathFinder.

Subscribers are defined as users with a mailbox
and extension on PathFinder. The subscriber does
not have to use both the mailbox and / or
extension.
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infinite DVXPlus IV

Hardware Requirements
The following are hardware requirements for the infinite DVX PLUS IV in-
band integration:

One SLIB port per PathFinder voice port. Each SLIB card provides
twelve ports.

One DTMF-A installed on the SLIB. DTMF-A provides four DTMF
receivers.

One RGU (ring generator) unit is needed.

Supported Features
The supported features of the infinite DVX PLUS IV include:

Station forward to a personal greeting.

Message waiting On/Off LEDs.

Stations can transfer a caller directly to a mailbox without
supervising the call.

Outdial (to a pager or specific number).

Multiple Return to Operator.
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Table 3-20: infinite DVXPlus IV - Configuration Setup

1. From Station 100, enter the Admin code of
✳✳3226 (or dial ✳✳ and your password).

2. To disable the conference feature on SLT
ports to be assigned to the VM group: press
Flash 50, enter SLT extension range to be
assigned to the VM group (XXX-XXX), then
press Btn 3.

3. Press Flash 65, Btn 1 to enter VM group
programming for VM group 440.

4. Press Flash 65, Btn 12 and enter the SLT ports
into a VM group 440-447.

5. Press Flash 65, Btn 10 to set the Leave Table
as Table 0 and Btn 11 to set the Retrieve
Table as Table 1.

6. Leave Table Programming
a. Press Flash 66, Btn 1 to select Table 0.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

7. Retrieve Table Programming
a. Press Flash 66, Btn 2 to select Table 1.
b. Enter [0] + [TRANS] + [7] + [HOLD].

- 0 is a prefix digit
- TRANS indicates a pause based on the pause

timer
- 7 is used in conjunction with PathFinder’s 100

and 200 menus

c. Press Btn 2 to select Table 1.
d. Enter [1] + [✳] + [HOLD].

- 1 is a suffix digit
- ✳ is a digit that informs PathFinder that

this is a subscriber.

e. Press Btn 9, enter [#9999999] +
press [HOLD].
- Btn 9 is the disconnect table
- #9999999 is the disconnect code used by

PathFinder

8. Perform the following at each station:
a. Press [SPEED] twice.
b. Press the flexible button to be

programmed.
c. Dial [440] on the keypad.
d. Press the [ON/OFF] button.

NOTE -- You can adjust the volume level on each
SLT port by using the volume up or down code.
This provides additional control for both internal
and external calls into PathFinder.

Subscribers are defined as users with a mailbox
and extension on PathFinder. The subscriber does
not have to use both the mailbox and / or
extension.
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4 Configuration
Overview

The MAINT application allows you to configure and control
PathFinder. The following menu options are available in MAINT:

File

Configuration

Edit

Reports

Help

This chapter gives an overview of the entire configuration procedure, describes
how to prepare PathFinder for configuration, introduces MAINT, and provides a
summary of this configuration program’s features and options.

Each of the menu options above is described in more detail in a later chapter.
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Prerequisites

Before configuring PathFinder, make sure you complete the following:

Installed the voice card(s)

Installed the PathFinder software

Tested all voice channels

Connected at least 1 phone line to the voice card(s)

Overall Configuration Procedure

After you have installed and configured all other components by
completing the prerequisite steps above, you are ready to configure your
PathFinder software. To configure your software, follow these steps:

1. Perform preliminary steps for configuration preparation. Refer to
Chapter 4, Configuration Overview.

2. Configure Access Levels and set up MAINT passwords. Refer to
Chapter 4, Configuration Overview.

3. Configure system settings. Refer to Chapter 5, MAINT Application -
System Settings.

.After configuration, you will be able to start up, run, and manage the
operation of PathFinder via the Monitor application. Refer to Chapter 7,
Boom Box and Monitor Applications for more information.

If you have problems accessing MAINT, refer to Chapter 2, Installation.

Module
System
Telephony

Users
Class of Service
Menus
Time Control
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Configuration Preparation

To begin with, you must answer some first-time questions and set up
basic voice functions in order to prepare PathFinder for configuration.

Defining Parameters
1. From the Start menu, select Programs > PathFinder Voice Processing >

Maint.

Figure 4-1: Program Group for PathFinder
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2. The Loading Key window displays to tell you that your software key is
being loaded.

Figure 4-2: Loading Key Window

3. In the First Time Questions window, click on Edit Settings.

Figure 4-3: First Time Questions Window

4. Click on Next to proceed to the second First-Time Questions window.

If your software key is not installed, the Software Key Not Found error
message displays. If this happens, you must make sure that your
software key is installed properly. Refer to Chapter 2, Installation for
more information.

If you do not need to answer First-Time Questions anymore, select
the “Don’t run wizard at startup” checkbox.
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5. In the Voice Lines field of the next First Time Questions window,
indicate the number of voice lines on your system.

Figure 4-4: First Time Questions Window

6. In the default digit lengths pane of the First Time Questions window,
indicate the required parameters in the Mailbox Length, Extension
Length, and Password Length fields. Refer to “Digit Lengths” on
page 5-1 for more information on these parameters.

7. Click on Accept. You are then prompted to configure PBX
Integrations.

8. In the PBX Integration window, configure your system’s PBX
integration. Refer to “PBX Integrations” on page 5-34 for more
information on how to do this.

9. After you have finished configuring your PBX integration, you are
returned to the main MAINT window. You must now continue the
Configuration Preparation process by setting up voice functions.
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MAINT Overview

File Menu
The File menu provides access to the MAINT
Logins function and MAINT passwords.

For a description of these functions, refer to Access
Levels & MAINT Passwords.

Choosing Exit from this menu quits MAINT.

Configuration Menu
The Configuration menu provides access to
functions that set parameters concerned with the
general operation of PathFinder, such as call
transfer sequences and hang-up detection.

Before putting PathFinder into service, you must
configure Module, System, and Telephony
Settings, along with any other modules you may
have purchased.
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Refer to Chapter 5, MAINT Application - System Settings for more
information on these options:

Module Settings -- Digit Lengths, Record/Playback, Auto-Attendant,
Logging, Operators, Voice Mail, Language, and Retries/TimeOuts;
controls how the voice processing system behaves, including
languages on PathFinder.

System Settings -- Directories, Auxiliary Tasks, LPT/COM Ports, and
Time Periods; controls the auxiliary tasks on PathFinder.

Telephony Settings -- Voice Lines, MWI/Notification, Rings, Transfer
Settings, Hang Up Detection, and Perfect Call; controls transfer
settings and hang-up detection parameters.

Other MAINT Settings -- PBX Integrations, any option module
purchased, and the Registry.

Refer to Appendix C to configure any optional modules that display in
this menu, such as Point to Point or Fax settings.

Edit Menu
You can further configure PathFinder via MAINT’s
Edit menu.

Refer to Chapter 5, MAINT Application - System
Settings for more information on these options:

User Settings -- Defining and maintaining users’
mailboxes and extensions

Class of Service Settings -- Defining classes of
service (COSs) that can be applied to groups of mailboxes

Menu Settings -- Creating and modifying voice menus

Time Control Settings -- Creating and editing time controls to activate
or disable PathFinder features depending on time of day or day of week

Line Settings -- Defining line settings to assign modules or
applications to different phone lines

Distribution Lists -- Refer to Chapter 6, Lists and Reports for creating
automatic distribution of voice messages to lists of specific users
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Reports Menu
The Reports menu provides access to a
configuration of a complete range of
administrative and management reports on
PathFinder operation. Reports are grouped
according to the immediate selections shown in
the menu.

Highlighting a menu item with an arrow to the
right of it shows the types of reports which you
can configure.

Refer to Chapter 6, Lists and Reports for more
information on these report options:

Activity Reports

Settings Reports

Directory Reports

Logs Reports

Messages Reports

Greetings & Signatures Reports

Help Menu
The Help menu provides access to standard help
functions. If you’re unsure of screen selections or
any aspect of PathFinder operation, go to the
Help menu’s Contents option for general
orientation, or use the Search for Help on . . .
option for help related to a specific word, term,
or search key.

You can also click on the Help button in the MAINT toolbar or press F1 in
most windows to display context-sensitive help.
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MAINT Toolbar

The MAINT toolbar provides access to some of the most often-used
PathFinder functions, all of which can also be selected from menu bar
options. For more information on configuring the following system
settings, refer to Chapter 5, MAINT Application - System Settings.

Subscriber Settings Button
Clicking the Subscriber Settings button provides the same
function as selecting Edit > User > Show Users from the menu
bar. When you click on this button, the Select Subscriber to Edit
window displays. From this window, you can create, modify,
or delete subscribers and settings. Subscribers are defined as
PathFinder users who have both a mailbox and an extension.

Class of Service Button
The Class of Service button causes the Select COS to Edit
window to display, the equivalent of selecting
Edit > Class of Service from the menu bar. A Class of Service
(COS) defines settings that apply to a group of users. Clicking
this button allows you to create, modify, or delete a COS.

Voice Menu Button
Clicking the Voice Menu button is the same as selecting Edit >
Menus from the menu bar. Clicking this button causes the
Select Menu to Edit window to appear. From this window, you
can create a new voice menu, or you can modify or delete an
existing one.
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Time Control Button
The Time Control button causes the Select Time Control to Edit
window to display, just as if you had selected Edit > Time
Control from the menu bar. Time controls allow you to
manipulate PathFinder settings based on day, time of day, and
day of the week. The Select Time Control to Edit window allows
you to create, edit, or delete a time control.

Line Settings Button
Clicking the Line Settings button is the same as selecting Edit
> Line Settings from the menu bar. Clicking this button causes
the Line Settings window to display. From this window, you can
assign modules or applications to different phone lines.

Exit Button
Clicking the Exit button exits you from the program, the same
as selecting File > Exit from the menu bar. If you click on this
button, you exit MAINT.

Special Characters & Strings

The special characters and strings supported throughout MAINT are:

Table 4-1: Special Characters & Strings

Character/String Character Name Definition

& ampersand Flash-hook

, comma Pause

✳ asterisk ✳ DTMF star

# number sign # DTMF pound

@Ext -- At an extension

0 through 9 numbers 0 through 9 DTMF keys
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Access Levels & MAINT Passwords

The MAINT application allows you to configure PathFinder. This chapter
describes the functions available in MAINT’s File menu, which includes
options for configuring MAINT logins.

MAINT Logins
In many installations, more than one person interacts with PathFinder.
Some people only generate system reports, while others perform high-
end maintenance activities.

MAINT Logins allow you to create a list of users that are authorized to
perform PathFinder maintenance functions, and assign an access level to
each of those users.

Access Levels
Assigning levels of access gives the system administrator the ability to
grant only the access each individual needs. By requiring a person to
enter a name and password when starting MAINT, PathFinder knows to
whom complete access is granted and to whom restricted access is
granted. Access levels range from one to nine and have the following
privileges.
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Table 4-2: System Access Levels

Access Level Privileges

LEVEL 9 - Unlimited
Supervisor Access

Level 9 users have access to all MAINT menus and options.
Level 9 users also can view and change mailbox and/or extension
passwords.

LEVEL 8 - Limited
Supervisor Access

Level 8 users have access to all MAINT menus and options, with
the following restrictions:

Cannot edit MAINT logins
Cannot write or confirm INI files
Cannot re-index databases
Cannot select phone system (PBX Integrations)
Cannot configure Point-to-Point (an optional module)
Cannot configure Engine detection
Cannot edit INI settings
Cannot edit the Registry

LEVELS 6 and 7 -
Administrator Access

Users with Administrator Access have the same access privileges
as level 8, with the following restrictions:

Cannot modify any Module, System, or Telephony settings
Cannot view mailbox and/or extension passwords, but can
change them
Cannot edit fax settings

LEVELS 1 to 5 - Limited
Administrator Access

Users with Limited Administrator Access have the same access
privileges as levels 6 and 7, with an additional restriction: users
with Limited Administrator Access cannot view or change
mailbox and/or extension passwords.
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Setting MAINT User Passwords
To set user passwords:

1. Select MAINT Logins from the File menu. This displays a window
similar to the following:

Figure 4-5: Edit MAINT Users Window

2. To add a new MAINT user, click on Add. To edit an existing MAINT
user’s password, click on Edit.

3. If you are adding a new MAINT user, enter the user’s User Name,
Password, and access Level, and click on Accept. If you are editing an
existing MAINT user, change those items as needed and click on
Accept.

4. Click on Done when you are finished with this function.

A few important notes about passwords:
Once a password has been defined, you must enter it correctly
every time you wish to access PathFinder.
PathFinder passwords are case-sensitive. For example,
PassWord is not the same asPASSWORD.



5 MAINT Application -
System Settings

The MAINT application allows you to configure and control
PathFinder. The following menu options are available in MAINT:

File

Configuration

Edit

Reports

Help

This chapter gives an overview of the entire configuration procedure, describes
how to prepare PathFinder for configuration, introduces MAINT, and provides a
summary of this configuration program’s features and options.

A detail description of the menu options mentioned above are also provided in
this chapter.
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Module Settings

The MAINT application allows you to configure PathFinder. This section
describes the module settings functions available in the Configuration
menu in MAINT.

The Configuration menu provides access to module settings
configuration, a group of functions used to control how PathFinder
modules interact with the user. To access the module configuration
options, select Module Settings from the Configuration menu. The
following buttons display near the top of the window:

Figure 5-1: Module Settings Toolbar

Click on any of the buttons on this Module Settings toolbar to access the
corresponding configuration options.

Digit Lengths
The Digit Lengths settings determine the number of digits used in
mailboxes, extensions, and passwords. PathFinder uses this information
to determine how many digits to expect when asking a caller for a
mailbox, extension number, or password.

Figure 5-2: Module Settings: Digit Lengths Window
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Record/Playback
The Record/Playback settings are used to access PathFinder’s recording
and playback settings.

Figure 5-3: Module Settings: Record/Playback Settings Window

Field Indicates default length for…

Mailbox Length Mailbox Numbers (maximum 7 digits).
This is usually set the same as the extension length.
Leave this blank if allowing variable-length mailboxes.

Extension Length Telephone Extension Numbers (maximum 7 digits).
Leave this blank if allowing variable-length extensions.
This number may be determined by your phone system.

Minimum
Password Length

Password Digits (maximum 9 characters).

EXAMPLES -- Digit length for mailboxes, extensions, and passwords:
2 digits -- from 10 to 99
3 digits -- from 100 to 999
4 digits -- from 1000 to 9999
6 digits -- from 100000 to 999999
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Field Parameter determines…

Minimum
Record Length

This field determines the shortest allowable length of a recorded
message.
A value of 2 seconds is recommended as the minimum message
length. The range for this field is 1 to 999.

Truncate
Recording

This parameter determines how much time PathFinder trims from
the end of a mailbox message whose recording was terminated by a
silence or tone detection. PathFinder automatically removes trailing
tone and silence at the end of a message, so it is recommended to
leave this value at 0 seconds. Increase this value if the end of your
messages contain dial-tone noise or excessive silence.

NOTE: This setting is only used if PathFinder relies on silence or non-
silence for hang-up detection, and is not used for phone systems that
employ loop current hang-up.

Record Tone
Length

This setting determines the duration of the beep tone that
PathFinder gives callers before recording a message.

FF and REW
Speed

The information in the FF and REW Speed field sets the time intervals
that are skipped in a message when the designated REW ( 7 ) or
FF ( 8 ) keys on the telephone key pad are pressed. The
recommended interval is 50 to 100 tenths of a second. The range for
this field is 0 to 999 tenths of a second.
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Auto-Attendant
The Auto-Attendant settings provide access to caller-related Call Queue
Interval and Directory configurations.

Figure 5-4: Module Settings: Auto-Attendant Window

Field Description

Call Queue
Interval

The call queue interval specifies the amount of time before
PathFinder retries an extension when a caller is in queue. A
ten to twenty second interval is recommended. The range
for this field is 1 to 999.

Call queue interval is dependent on the extension’s class
of service.
Call queuing is disabled unless it is manually enabled in
the Class of Service configuration.
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Directory Types The Directory (also called the System Directory) is a list of
users in PathFinder. Directory functions describe how the
company directory should be configured.

Paged Mode -- Gives the caller several matching entries,
then a caller must press a key to go to the next page, or
set, of entries. This is a hybrid between List and Single
mode. PathFinder presents only eight matches at a time,
and the caller presses a number one through eight to
choose a match. The caller can press 9 to go to the next
page, or set, of eight matches.
List Mode -- Provides a caller with all matching entries in
a complete list. Each matching name and extension (or
mailbox) is played in order. At the end of the list,
PathFinder prompts the caller to enter the selected
extension number. If there are one hundred matches, all
one hundred names and extensions are played. The
caller can enter the desired extension or mailbox
number at any time during the list playback. NOTE:List
mode can reveal the entire list of extensions and/or
mailboxes.
Single Mode -- Provides the caller with a list of all
matching entries, one at a time. Callers must press a key
to indicate whether they want to select the most
recently read name or hear the next matching entry.
Single mode presents only two options to the caller for
each match.

Maximum Keys This is the maximum number of digits that the caller can
enter before PathFinder begins to look up directory entries.
The range for this field is 1 to 999.

Maximum Wait This is the maximum amount of time that PathFinder waits
for the Maximum Keys while a caller is entering numbers (to
spell the user/subscriber’s name on the keypad). The range
for this field is 1 to 999.

Field Description
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Logging
PathFinder continuously generates detailed information on its operation.

Figure 5-5: Module Settings: Logging Window

What To Log
The raw data are a chronological history of all events that occur in
PathFinder and can be used to evaluate real-time performance. Raw data
include time, date, line, module, and a description of each event. These
raw data can be formatted into a variety of reports that help measure
performance. Refer to “Logs Reports” on page 6-31 for more information
on these reports.

Log Files -- The Logging settings allow you to select which modules send
information to the log files.

The fewer modules selected, the less disk storage space needed and
the faster PathFinder operates.

The more modules selected, the greater the amount of information
available to help diagnose problems and to generate reports.

Each day's activity log output to the disk is stored in a unique file in the
log sub directory (\HELLONT\LOGS). The file name of each daily activity
log has the following format:

DL<YY><MM><DD>.LOG

EXAMPLE -- The log file for February 23, 1999 would be called
DL992302.LOG



Module Settings 5-7
Log Option Activity

Call Begin/End* The start and end of calls.

Voice Mail* All voice mail activities, except owner activities.

Auto-Attendant* All call transfer activities.

Menus* All menu selections.

Voice Mail Owner* Mailbox owner activities.

Directory Accesses of the company directory.

Track Messages Complete logging of message file names and when
messages are deleted, created, saved, etc.
Used to track complaints of lost messages, etc.

Message Manager Turns on logging of message manager activities.

Notification* PathFinder notification actions.

Time Controls* Actions controlled by time control files.

Fax Support* All fax support activities.

Integration* Tracks information received from the phone system.

Default The Default button activates the Log Option settings
indicated with an asterisk (*).
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What To Debug
The Logging settings also include debugging options. Module
debugging is a sophisticated diagnostic tool used to resolve problems
with PathFinder. DO NOT run PathFinder with Module Debugging on, as it
can slow performance. Use debugging only as needed.

Module debugging parameters include the following:

Once debugging has been activated, it generates large amounts of
data that can potentially fill up the disk drive. Select specific module
debugging options only at the request of Vodavi Technical Support.

Field Description

Basic Foundation Tracks basic information from the system, including which
modules are loaded into memory.

Voice Mail Tracks all voice mail activities, including length of message
and hang-up type.

Auto-Attendant Logs information regarding transfers, including call results.

Menus Detects what menu prompt is played and what keys each
caller presses.

Voice Mail Owner Tracks mailbox owner activities, including what messages
are played, saved and deleted.

Directory Oversees directory activities, including what keys are
pressed when a caller accesses the directory.

Events Tracks events, including pager and message waiting
indicator notification.

Message Manager Tracks events as the message manager processes them.

Notification Tracks notification of messages, including notification strings
and retries.

Time Controls Provides detailed information regarding time control processing.

Fax Support Monitors the fax support module.

Integration Tracks information packets received from the telephone system
regarding transfers.

All Off Clicking this button deactivates all debugging options.
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Operators
The Operators settings are used to specify the dialing sequence needed
to transfer a call to the operator.

Figure 5-6: Module Settings: Operator Window

There are several different types of operators in PathFinder. The operators
are called when a caller dials 0 at different times during PathFinder
operation. All operator settings are defined in the Registry. There are four
operators used in the system, as follows.

Field Description

General Operator The General Operator is the global default operator for all
operator functions. This is the dial sequence sent to the phone
system to reach the operator ( 0 ). In most situations, this is the
sequence dialed when the caller dials 0.

You need to specify the entire blind transfer string,
including flash-hook. Change the General Operator
parameter only if necessary for your phone system.
Although your implementation may differ, the normal
string would be &,0 .

NOTE -- Refer to “Special Characters & Strings” on page 4-9 for
information other special characters supported in MAINT.
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Voice Mail
Operator

The settings in the voice mail operator pane determine what
happens when a caller presses 0 while using voice mail. If an
operator is designated, a time-out or 0 key pad entry transfers the
caller to the designated operator. The operator can then provide
caller assistance.

The 0 as First Digit is Operator parameter is allowed here
because some phone systems use 0 as the first digit for
extensions. Make sure that this option is selected unless you
have such a phone system.
If None is indicated in the Voice Mail Operator field,
PathFinder uses the General Operator setting for any 0
dialed
NOTE -- Most phone systems do not allow extension 
numbers to start with 0. Typically, the digit 0 should only be 
used for operator assistance.

.Auto-Attendant
Operator

The Auto-Attendant Operator determines what actions are taken
when a caller presses 0 while in the auto-attendant module. If an
operator is designated, a time-out or 0 keypad entry transfers the
caller to the designated operator. The operator then provides
caller assistance.

If None is indicated in the Voice Mail Operator field,
PathFinder uses the General Operator setting for any 0
dialed.
As with the Voice Mail Operator, the 0 as First Digit is
Operator parameter is allowed here because some phone
systems use 0 as the first digit for extensions. Make sure that
this option is selected unless you have such a phone system.

Personal Mailbox
Operator

The Personal Mailbox Operator functions are defined in the
Mailbox Settings options for each user/subscriber.
To configure Personal Mailbox Operator options:

Select from the MAINT menu bar Edit > Users > Edit Users.
Click on Mailbox Settings, then edit the Operator field.
Refer to “Mailbox Settings” on page 5-49 for more
information.

Field Description
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Voice Mail
Voice Mail settings are used to configure the voice mail module.

Figure 5-7: Module Settings: Voice Mail Window

Field Description

Message
Clean Up

Specify when PathFinder is to delete messages that have exceeded the
retention period. (Refer to “Message Retention” on page 5-65.)

PathFinder performs this housekeeping function at the time specified in
this window for each day of the week selected. Message cleanup can be
set for a specific day of the week or for every day, and should occur when
the phone system is inactive, such as between midnight and 3:00 a.m.

MWI Refresh Some phone systems clear all message waiting indicators at a specific
time each day. The MWI Refresh setting should be set for a time after
such a phone setting has cleared all message waiting indicator lights.

If you have a phone system that clears all message waiting indicators
at a specific time each day, then in the Time field in the MWI refresh
pane, enter the time of day when PathFinder should re-light any
message waiting indicator lights for extensions that still have
messages waiting.
If your phone system does not periodically clear message waiting
indicators but instead leaves message waiting indicators illuminated
until users/subscribers retrieve their messages, then leave this field
blank.
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Quick Jump
Key

Specify the touch-tone key a caller can press to bypass leaving a
message once a mailbox greeting has begun.

When a caller presses the defined key, PathFinder jumps to a menu of
alternate options (e.g., “Press 1 to try another mailbox”).

Pager Mailbox
Delay

Specify the amount of time PathFinder delays when dialing a pager
number for notification. This value defines the delay after dialing the
pager number and before dialing the mailbox number. If using a
command file for notification, this value is not used.

Refer to Appendix A for more information on command files.
Refer to “Notification Settings” on page 5-73 for more information
on pager notification.

Password
Attempts

Enter the number of times a caller is allowed to try entering a password
to gain mailbox access. After this number is exhausted, the caller is
prompted to enter a different mailbox number. The range for this field is
1 to 9.
PathFinder keeps track of such attempts in its logs, which can help
determine if an unauthorized user is attempting to gain access to
PathFinder.

Notification On some integrated systems, PathFinder can accidentally become
connected to itself and create a repeating loop. For example, assume
that PathFinder is attempting to notify an extension owner of new
messages:
When it dials the extension, that extension is busy; therefore,

PathFinder is forwarded to the extension’s mailbox (in other words,
PathFinder calls itself).
PathFinder leaves a notification message in the extension’s mailbox.
As a result, PathFinder attempts to once again notify the mailbox
owner of the new notification message in his or her mailbox, creating
a repeating loop.

The Notify Send Keys are a series of DTMF key signals that PathFinder
sends with the message notification that cancel the incoming channel
and end the loop.
Since the keys are sent for all voice notifications, some users may find
this a nuisance, and the recommended setting is blank.

Field Description
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Language
PathFinder provides optional language support modules for a number of
different languages.

Figure 5-8: Module Settings: Language Window

.

Field Description

Default Language Use this menu to select the language that
.PathFinder uses as the default language.

Languages Allowed The following languages may be available:

English
Spanish
French

German
Kanji
Korean

Russian
Dutch
Custom

Malay
Tamil
Mandarin

Language modules are optional modules that are purchased separately.
You must purchase the optional multilingual module and language prompts
in order to use this feature.
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Retries/Timeouts
The Retries/Timeouts settings determine how PathFinder handles
erroneous input from callers.

Figure 5-9: Module Settings: Retries/TimeOuts Window

RETRY ATTEMPTS -- You should set the number of retries to a number
high enough so that callers who are unfamiliar with PathFinder are not
prematurely dropped.

TIME OUT INTERVALS -- Set the timeout option to an amount of time long
enough for the caller to complete the longest operation on PathFinder.
Because mailbox/extension owners are generally more familiar with
PathFinder than outside callers, it is recommended that they be given
fewer retries and a shorter time-out interval than outside callers.

Some modules use these settings, but basic PathFinder does not. Menus
have their own retries and time-out settings that take precedence when
they are active.
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Field Description

Caller Retries Number of times a caller can retry entering an
option. The range for this field is 1 to 999.

Owner Retries Number of times a mailbox owner is permitted to
retry entering an option. The range for this field is
1 to 999.

Inter-Digit Time Length of time between digits. Used in cases
where the length of the entry is unknown.
PathFinder assumes the caller is finished
entering digits if this length of time passes
after the most recent digit is entered. The
range for this field is 1 to 999.

Digit Time Digit Time is the length of time that a caller can
press a digit before PathFinder assumes that the
digit is being repeated. The range for this field is 1
to 999.

EXAMPLE: Assume that Digit Time is set to three
seconds:

If a caller presses and holds the 7 key for two
seconds, PathFinder will assume that the caller
has entered 7.
If a caller presses and holds the 7 key for four
seconds (one second more than the three
second digit time), PathFinder will assume
that the caller has entered 77.
If a caller presses and hold the 7 key for seven
seconds (one second more than twice the
three-second digit time), PathFinder assumes
that the caller has entered 777.
In other words … if Digit Time is set to X
seconds, then for each X seconds that the
caller presses a digit key, PathFinder assumes
that the caller has pressed that digit key once.
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System Settings
The PathFinder Configuration menu provides access to System Settings
configuration, a group of functions used to maintain the PathFinder
directory structure, identify communications and printer ports, and
define the use of non-voice channels. To access the module
configuration options:

Select System Settings from the Configuration menu.

Click on any of the buttons on this System Settings toolbar to access
the corresponding configuration options.

Figure 5-10: System Settings Toolbar

Directories
The Directories function defines paths so that PathFinder can locate
system files if they are placed in directories other than the defaults.

Figure 5-11: System Settings: Directories Window

DO NOT alter these subdirectories unless instructed to do so by Vodavi
Technical Support.
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Auxiliary Tasks
The Auxiliary Tasks function provides for definition of auxiliary channels.
Auxiliary channels are used to pass non-voice data as in a telephone
integration setting (Message Manager or SMDI integration controller).

Figure 5-12: Auxiliary Task Settings Window

Making Changes
You can alter the Auxiliary Task settings by highlighting the task and
selecting the appropriate action: Edit / Add / Delete.

When editing or adding a task (with a maximum of fifteen tasks),
complete fields at the bottom of the window as follows:

Field Description

Task The system assigns the next available task number.

Name Select or type the appropriate telephone system name.

Description Enter a description for this auxiliary task, to identify it in
the application and in reports.

Event Group Select the group for which this line is to handle the
action. Note that any event group you specify must have
at least one line assigned to it in the Line Settings
configuration (refer to “Line Settings” on page 5-102).

If Task is Message Manager, Event Group must be 1.
If Task is other than Message Manager, define Event
Group as 6 or higher.
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LPT / COM Ports
The LPT/COM Ports window is used to identify which printer port and
which COM port are used by the system.

Figure 5-13: LPT / COM Port Settings Window

Printer Port
Select the proper printer port - LPT1, LPT2, or None. Use LPT1 if a printer
is connected to your system, unless instructed otherwise by Enhanced
Systems or your dealer. Attach the software key to LPT2.

Serial Port
Select the proper COM port - COM1, COM2, COM3, or None.
Documentation specific to your application (e.g., paging and telephone
integration applications) will specify if you need to set serial port
parameters.

Time Periods
The Time Period settings provide definitions of the time periods for
PathFinder. They are used by some IVR modules to control how
PathFinder operates for a given time of day.
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Voice Mail, Auto-Attendant, & Menuing Time Periods
Time Periods are not used in the voice mail, Auto-Attendant or menuing
modules.Tocontrolhowthevoicemail,Auto-Attendant,andmenusprocess
acall,useTimeControlsettings(referto“TimeControlSettings”onpage 5-93).

Figure 5-14: Time Period Settings Window

Period Definitions

WORK HOURS -- Defines the start and end of the business day. Enter the
hour and minutes using GMT format (24 hour clock).

Example: 1:30 p.m. is entered as 13:30.

HOLIDAYS -- Define the start and end dates for holidays. You can add and
remove dates from this list. You can define a maximum of 20 holidays.

Editing IVR Time Period Settings

To edit an existing work hour setting, perform the following steps:

1. Highlight the time to be changed.

2. Enter the new hour and minutes in GMT format.

3. To enter a holiday date:

Highlight the Begin Date field and enter the month and day of the
holiday (01/01).

Then, highlight the End Date field and enter the end month and
day (01/02).

Click on Add.
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4. To remove a holiday setting:

Highlight the dates in the box.

Click on Remove.

Telephony Settings

The MAINT application allows you to configure PathFinder. This section
describes the telephony configuration functions available in the
Configuration menu in MAINT.

The PathFinder Configuration menu offers access to Telephony Settings
configuration, a group of functions used to control general telephony
operation of PathFinder. Telephony Configuration options are displayed
in the buttons near the top of the screen when you select Telephony
Settings from the Configuration menu.

Figure 5-15: Telephony Settings Toolbar

Click on any of the buttons on this Telephony Settings toolbar to access
the corresponding configuration options.

Refer to “Special Characters & Strings” on page 4-9 for a listing of
special characters that are supported by PathFinder.
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Voice Lines
The Voice Lines function displays the number of voice lines for which
your PathFinder installation is configured. Voice lines are those that can
be dialed.

Figure 5-16: Telephony Settings: Voice Channels Window

The number of voice lines that are displayed is the number of active voice
lines on your PathFinder implementation. The text below the Number of
Voice Lines field (“The key is licensed for X ports”) indicates how many
ports the software key allows.

MWI/Notification
The MWI / Notification function provides for control over message
waiting indicator and message notification functions.

Figure 5-17: Telephony Settings: MWI/Notification Window
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Number Length to Edit
Number Length to Edit shows the current length you are editing. If you are
usingmultiplenumberlengthsandneedtoviewadifferentone,selectithere.

Message Waiting

There are several methods for notifying a station of a new message, such
as MWIs or a stutter dial tone. The Message Waiting Set and Clear settings
define how PathFinder notifies the station of a waiting message.

Configure these settings in the following fields:

Set -- Enter the dialing sequence necessary to activate a message waiting
indicator for any extension that has one. Message waiting indication
must be accessible by dialing a sequence of numbers from a single line
telephone for PathFinder to make use of this capability.

Use the command @Ext to specify where the extension should be
located. For example, use &,*1,@Ext,#0 to set the lamp on
extension 345. Note that @Ext is case-sensitive.

If the phone system supports message count (as opposed to just a
message waiting light), use the command @NewMsgCnt to send the
number of messages.

Clear -- Enter the sequence that turns off the message waiting light.

Use the command @Ext to specify where the extension should be
located. For example, use &,*1,@Ext,#0 to clear the lamp on
extension 345. Note that @Ext is case-sensitive.

If the phone system supports message count (as opposed to just a
message waiting light), use the command @000 to clear the MWI.

MWI sequences can be controlled by COS. Refer to “Message Waiting
Indicator (MWI) Strings” on page 5-74 for more information.

If your phone system does not support message waiting indicators, leave
these fields blank.

This option works on some Vodavi Telephone Systems.
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Notification Prefix
In the Notification Prefix field, type the command string required by the
telephone system prior to dialing a notification number.

Refer to “Mailbox Settings” on page 5-49 for more information on
configuring notification in the Users Settings.

Refer to Appendix A for more information on command scripts.

Hang Up Detection
Hang-up Detection allows PathFinder to detect when callers hang-up
during a call. Unless properly set, PathFinder is unable to detect a hang-
up condition.

Detection Settings

Figure 5-18: Telephony Settings: Hang-Up Detection Window

This setting is used in a command file when using the
DialPrefixforWhereField; otherwise, it is not called when a command file
is being used for notification. Refer to “Notification Settings” on
page 5-73 for more information.
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Types of Hang-Up Detection
Loop Current Supervision -- Loop Current disconnects are always
activated by default. If available on your telephone system, activate Loop
Current Supervision.

When a drop in loop current is detected on a line, PathFinder will
disconnect. This is the preferred method for detecting hang-ups and is
the most reliable.

Tone or Silence Disconnect -- Some telephone systems provide a
continuous tone or silence to tell the voice processing system the call
should be disconnected.

The tone or silence disconnects are not as reliable as Loop Current
disconnects and may cause a line to remain connected longer than
necessary or result in false hang-ups and callers being disconnected.

Re-Order Tone -- Still other telephone systems send Re-Order tone to
the voice processing system for disconnect.

Re-Order Tone disconnect is a reliable method for disconnect, but require
some configuration in the PathFinder voice processing system.

General Tone Detection -- Some telephone systems send a tone that is
not continuous and is not a Re-Order Tone.

In this instance, you would use General Tone Hang-ups. This General
Tone can be learned via PBXpert and will generate disconnects as reliably
as Re-Order disconnect.
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Determining Tone Type
To determine what type of disconnect your telephone system provides,
pleaseconsultyourtelephonesystemmanual.Ifthemanualdoesnotprovide
this information, follow the steps below to determine your hang-up type:

1. Have someone call an extension.

2. Answer the extension.

3. Have the caller hang-up.

4. Listen to the system.

Refer to your telephone system documentation for more information.

Loop Current Drop
If the telephone system provides Loop Current Supervision, enable this
option in the telephone system. PathFinder will automatically recognize a
drop in loop current as disconnect with no configuration.

The minlcoff parameter in the Registry can be adjusted for PathFinder
to reliably detect loop current disconnects.

Tone Interval
Specify a number between zero and ninety-nine that represents the
detection interval. This interval defines the length of time, in seconds, for
the tone that sounds before PathFinder disconnects or hangs up a call.

If you hear… Then your telephone system…

silence provides Silence Hang-Ups.

a continuous tone provides Tone Hang-Ups.

re-order tone may provide Loop Current supervision or
Re-Order Tone detection.

You must know the type of hang-up detection your phone system
supports before you alter any hang-up detection parameters.
Refer to your phone system documentation if necessary.
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EXAMPLE: Entering 5 for the Non-silence interval instructs PathFinder to
listen for a steady tone that is five seconds long and, upon detection, to
treat the call as a disconnect.

If the interval is set too short, any pause could be interpreted as a
tone, signaling a false hang-up.

If the interval is too long, PathFinder can be tied up longer than
necessary.

Silence Interval
Specify a number between zero and ninety-nine that represents the
detection interval.

The silence interval defines the length of time, in seconds, for the silence
that elapses before PathFinder disconnects or hangs up a call. For
example, entering 5 for the Silence interval instructs PathFinder to listen
for a silence that is five seconds long and upon detection to treat the call
as a disconnect.

If the interval is set too short, any long noise (such as cellular phone
static) could be interpreted as a tone, signaling a false hang-up.

If the interval is too long, PathFinder can be tied up longer than
necessary.

The recommended interval for both silence and non-silence intervals
is five to seven seconds.

The recommended interval for both silence and non-silence
intervals is five to seven seconds.
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Re-Order Detection
Re-Order Detection should be used if there is a cadence of silence and
non-silence after a disconnect. Your telephone system documentation
should provide the exact cadence of silence and non-silence (tone). If not,
use PBXpert (refer to “PBXpert” on page 2-42) to learn the Re-Order tone.

General Tone Detection

Click on Set Tone Templates if you need to do any the following tasks:

Delete a tone template: Highlight the template and click on Delete.
No further action is necessary.

Modify a tone template: Highlight the desired tone template, then
click on Edit.

Add a new tone template: Click on Add.

Add or Edit Tone Template
If you select to edit or add a template, the following window is displayed:

Figure 5-19: Add Tone Template Window

To use this function, you must refer to your phone system
documentation regarding tone frequency for hang-up.

In order to determine what entries to make in the Add Tone Template
window, use PBXpert to learn the disconnect tone.
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For each tone template that you either edit or add, complete the fields in
this window as follows:

Field Description

Description Type a description that can help you remember this
tone template’s purpose.

Tone ID Enter a number from 101 to 120, following the previous
tone template in numeric sequence.

Repeat Count Should be set to 0 for continuous tones. For cadences,
it should be the number of times that the pattern
should cycle on/off.

Edge Select Rise if this is a leading-edge tone; select Fall if
this is a trailing edge tone. Typically, this value will be
set to Rise.

Frequency 1

Hz+/-

Specify the first frequency of the tone (always
included) in Hz.

Specify the maximum deviation from the first
frequency, in Hz.

Frequency 2

Hz+/-

Specify (in Hz) the second frequency if the tone is a
dual tone; if the tone is a single tone, set this field to 0.

Specify the maximum deviation from the second
frequency, in Hz.

NOTE -- Single tones have zero values for Frequency 2;
dual tones have non-zero values.

On Time For cadences, enter the length of time (in 10ms units)
tone is on. For continuous tones, enter 1/2 of debounce
time (in 10ms units).

x 10 ms + / -
for On Time

For cadences, enter the plus-or-minus deviation (in
10ms units) for on time. For continuous tones, enter 1/2
of debounce time (in 10ms units).
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Off Time For cadences, enter the length of time (in 10ms units)
tone is off. For continuous tones, enter 0.

x 10 ms + / -
for Off Time

For cadences, enter the plus-or-minus deviation (in
10ms units) for off time. For continuous tones, enter 0.

NOTES:
Continuous Tones have zero values for On Time and
Off Time deviations.
To debounce leading edge continuous tones to
prevent talk-off -- Set the On Time to 1/2 of the
desired debounce time (in 10ms units) and the On
Time deviation to -1/2 of the desired debounce
time (in 10ms units).
Cadence Tones have non-zero values for On Time
and Off Time deviations.

Tone Events Check On to activate this tone template. Check Off if
you need to disable this tone.

Options Unless otherwise instructed by Vodavi Technical
Support, ensure that the Set Wait check box is cleared
and that the Set Hang-Up check box is selected.

Set Wait determines whether a tone occurrence
should generate events to wait ( ) function.
Set Hang-up determines whether a tone
occurrence should set hang-up (H7) and terminate
Dialogic® operations.

Field Description
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Transfer Settings
Transfer Settings function provides control over call transfer activities.

Figure 5-20: Telephony Settings: Transfer Settings Window

Number Length to Edit
Number Length to Edit shows the defined extension length you are editing.
If you are using multiple extension lengths and need to view or change a
different length, select it here. For example, if there are subscribers on the
voice processing system with four and five digit extension lengths, you
will have to modify the transfer settings for both 4 and 5.

Transfer Fields

A typical transfer prefix is &. Complete the Transfer fields as follows:

Prefix -- Enter the flash-hook and/or tone dialing sequence that starts a
call transfer. On most phone systems this feature is accomplished
through a flash-hook and pause. If this is the case, enter &, (the comma
provides the pause) in this field. PathFinder will automatically dial the
extension number after dialing the prefix.

When addressing the following fields, refer to your phone system
manual as needed for the appropriate codes.

Transfer Prefix and Postfix settings can be controlled by the Class of
Service. Refer to “Transfer Strings” on page 5-81 for more information.
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Postfix -- Enter the flash-hook and/or tone dialing sequence needed to
end a call transfer (usually, this entry is not required).

Connect -- Enter anything required to connect a transferred call. Most
phone systems do not require anything for this feature.

Recall Caller On Fields
These settings are only used in Supervised Transfers. A typical transfer
prefix is &. If you are not using Supervised Transfers, leave these settings
as they are.

Complete the Recall Caller On fields as follows:

Busy -- Enter the value needed to abort a transfer to a busy number and
reconnect the caller to PathFinder. The typical value for this field is &,
which is a flash hook. Sometimes a tone dialing sequence is needed in
addition; for example, &,*1.

No Answer -- Enter the value needed to abort a transfer to an
unanswered number and reconnect the called party. On most phone
systems, this value is the same as for Recall a Caller on Busy.

Reject -- This feature allows PathFinder to retrieve a call if the extension to
which the call was transferred rejects it. This feature is used during Auto-
Attendant call screening. It can be viewed as Abort a Connected Transfer.
Typically, the dialing sequence is the same as for Recall Caller on Busy field.

Blind Transfer Delay
For Blind Transfer Delay, enter the number of seconds the system should
pause after dialing the transfer sequence and extension number but
before going on hook. The maximum value for this field is 999.

Flash-Hook Length
For Flash-hook Length, the default length of 1/2 second is appropriate for
most phone systems. If DTMF tones are audible when attempting a
transfer, this setting needs to be increased. If the telephone system
hangs up when attempting a transfer, this setting needs to be shorter.
Refer to your phone system documentation for additional information.

Selecting Use Perfect Call indicates that PathFinder should use the
Perfect Call settings. Refer to “Perfect Call” on page 5-33 for more details.
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Rings
The Rings function determines how PathFinder processes ring detection
on incoming calls.

Figure 5-21: Telephony Settings: Rings Window

Number of Rings Before System Answers
The Number of rings before system answers parameter determines the
number of times PathFinder allows the phone to ring before answering
an incoming call. One ring is a typical setting.

Number of Rings Before No Answer Detected

The Number of rings before No Answer detected parameter is used
during supervised dialing actions (such as a call transfer) to determine
how many rings must elapse before PathFinder terminates the activity. If
the line is not connected after the number of rings specified, the action is
aborted. Four rings is usually adequate.
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Ring Detection
Ring Count Reset Delay -- This setting is used in particular telephone
system integrations and typically should not be modified.

Minimum Ring ON -- This setting describes the ring cadence from the
phone system. Minimum ring ON is the time where there is a ring from
the phone system.

Minimum Ring OFF -- This setting describes the ring cadence from the
phone system. Minimum ring OFF is the time where there is no ring
from the phone system.

Ring Edge to Detect -- If Ring edge to detect is set to Rise, PathFinder
detects inbound rings more quickly. Set this to Fall to slow it down if you
occasionally get false rings.

Perfect Call
Perfect Call specifies the exact tones that make up the different
telephony signals (dial tone, busy signal, ringing, do not disturb, and the
like). Typically, these values are pre-programmed when you select your
telephone system. If these values are not defined, you can use PBXpert to
learn the tones. Refer to “PBXpert” on page 2-42 for more information.

Figure 5-22: Telephony Settings: Perfect Call Window
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Other MAINT Settings

The MAINT application allows you to configure PathFinder. This section
describes several miscellaneous configuration functions available in the
Configuration menu in MAINT, including PBX integrations, optional
modules, INI files, engine control, and the Registry.

PBX Integrations
This window is accessed by selecting PBX Integrations from the
Configuration menu. 

Also, after you have started PathFinder for the first time and have gone
through the First Time Questions window, you are prompted to configure
PBX integrations.

Figure 5-23: PBX Integration Window

The above window displays the current PBX selection.
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After you have selected a PBX from the list, the following window, which
allows you to select what options to install, is displayed.

Figure 5-24: PBX Integration (next) Window

Optional Modules
Optional modules are purchased separately from the standard PathFinder
software package. Some of these optional modules can be configured
here in the Configuration menu of MAINT. If you have purchased Point to
Point or Fax Options, these menu choices are available for modification in
the Configuration menu.

Refer to the Appendix C, “Optional Modules,” for more information on how
to configure individual optional modules.

If the Remove information before installing new? option is selected,
then the previous PBX’s options are removed.
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Registry
The PathFinder Registry is a database of parameters. Changes, settings,
and parameters set through Configuration menu options are stored in the
Registry.

To display the Registry, select Registry from the Configuration menu.
PathFinder displays a window with all the current Registry parameter
entries. This provides a helpful overview of all PathFinder settings should
troubleshooting be required.

Figure 5-25: Registry Window

Registry Maintenance
Buttons in the Registry window provide you with the ability to modify
various Registry parameters, both for hardware and software.

Delete Registry Item
The Delete function of the Registry window provides you with the ability
to select a specific item from the Registry list and delete it. After you
select the item, click on Delete. PathFinder prompts you to confirm that
you want to delete the item.

If you need to make changes directly to items in the Registry, you should
contact Vodavi Technical Support. These options, if used incorrectly, can
cause serious problems.
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Add or Edit Registry Item
The Edit function of the Registry window provides you with the ability to
select a specific item from the Registry list and edit it.

Occasionally, changes necessitate adding items to the Registry. This may
occur if new applications are added through new software modules, or if
existing modules are changed or upgraded. 
EDIT -- After you select the item, click on Edit. PathFinder displays the Edit
Registry Item window, where the changes can be made.

Refer to “Registry Item Fields” on page 5-39 for more information on
making these changes.

Figure 5-26: Edit Registry Item Window
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ADD -- To add a Registry item, click on Add in the Registry window.
PathFinder displays the Add Registry Item window, where the changes can
be made.

Refer to “Registry Item Fields” on page 5-39 for more information on
making these changes.

Figure 5-27: Add Registry Item Window

Add Registry items only under the direction of Vodavi technical support
staff or your PathFinder dealer.
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Registry Item Fields
The following fields are used to add or edit Registry items:

Field Description

Name The Registry item to add or modify. This entry is case
sensitive.

Value The current value for the setting.

Default Specifies a default value for this setting.

Description A general description of the setting.

Type Select the options that apply to this Registry item.
Defaults -- if you assigned a value in the Default field
Reloadable -- to indicate that PathFinder should be
reloaded when this parameter changes
INI Parameter -- if the value is to be written to an INI file

Write Empty -- if the value is to be written to even if
empty

INI File Settings Select the options that apply:
INI File -- If INI Parameter was checked above, use this
field to enter the name of the INI file to write to.
Section -- If writing to an INI file, specify the section in
which to write.
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User Settings

The MAINT application allows you to configure PathFinder. This section
describes the users (e.g., subscribers) functions available through the Edit
menu in MAINT.

Users (or “subscribers”) are people who have a mailbox and an extension
on PathFinder. Subscribers can leave, forward and retrieve messages.
They can have a voice mail greeting, and mailbox signature, and certain
subscribers have access to administrator options.

All users or subscribers have both a mailbox and extension on PathFinder.
Typically, the user/subscriber has an extension on the telephone system
as well. If the user/subscriber has no physical extension on the telephone
system, the voice mailbox can take messages for that subscriber at any
time.

This section discusses how to create, modify and delete users/
subscribers.

Creating Users
The PathFinder Create User function is used to generate a single
mailbox/extension, possibly for a new employee, or to create a template
mailbox to set up a group of users/subscribers.

PathFinder cannot perform messaging functions until subscribers’
mailboxes/ extensions have been defined and configured with the
appropriate parameters. Subscribers may be set up individually or in
groups, referred to as ranges. Any time you define a subscriber, you
create a mailbox and a corresponding extension.

The terms “user” and “subscriber” are used interchangeably
throughout this chapter and this manual.

Any attempt to transfer a call to an invalid mailbox causes PathFinder
to play the error prompt “Mailbox Number XXX Does Not Exist.” Any
attempt to transfer a call to an invalid extension causes PathFinder to
play the error message “Extension number xxx does not exist.”
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Assigning Mailbox & Extension Numbers
In many cases, the mailboxes assigned to subscribers can match their
extension numbers. If the mailbox number does not match the extension
number, they should at least correspond in some way that helps the
subscriber remember the mailbox number. For example, mailbox 1213
could be assigned for extension 213.

Template Users/Subscribers
When creating mailboxes and extensions, it is likely that you will have
many users/subscribers with the same features. For example, many
subscribers will have the same Class of Service, initial password and
mailbox settings. Creating a template user is a convenient way to create
identical mailboxes. A template user is a subscriber profile that is
representative of the settings for most users (or most users in a given
group) and is used as a model for creating other users.

Follow these steps to create a template user/subscriber:

1. Click on the Users icon in the toolbar (the leftmost icon).
Alternatively, you can also select from the menu bar Edit > Users >
Show List. The following window displays:

Figure 5-28: Select User to Edit Window
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2. Click on the Create Users button. The following window displays:

Figure 5-29: Create Users Window

3. Leave blank the First Name and Last Name fields in this template
subscriber window.

4. In the Mailbox and Extension fields, enter a dummy mailbox and
extension number outside the allowed range. For example, if the
allowed extension range for your telephone system is 100 to 200, you
could enter 500 or 999 as the dummy extension in the Extension field.
When you create individual subscribers, you will overwrite these
dummy values and assign distinct extension and mailbox numbers to
each subscriber whose profile is based on this template.

5. Click on Add User to List.

6. Refer to “Editing User Setups” on page 5-46 to edit this template
subscriber’s parameters. The parameters you define will apply to all
mailboxes that use this mailbox as a template.

7. Click on Create Users to return to the Select User to Edit window.
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You are now ready to create additional mailboxes. Each new mailbox that
you create using this mailbox as a template will have the same settings as
your template mailbox.

Single Mailbox

To set up a single subscriber, perform the following steps.

1. Click on the Users icon in the toolbar (the leftmost icon).
Alternatively, you can also select from the menu bar Edit > Users >
Show List. The following window displays:

Figure 5-30: Select User to Edit Window

You may also use the Edit option from the main menu to quickly edit,
add, or delete subscribers. This enables you to bring up subscribers using
their mailbox number and/or extension, instead of scrolling through the
entire list of subscribers.
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2. Click on the Create Users button. The following window displays:

Figure 5-31: Create Users Window

3. Enter the following information about this subscriber:

Mailbox -- Enter the subscriber’s mailbox number. This can be the
same as the subscriber’s extension, or it can be different as needed.

Extension -- Enter the extension to which this mailbox is linked.

First Name -- Enter the first name of the subscriber. Information in this
field will be use to create the company directory.

Last Name -- Enter the last name of the subscriber. Information in this
field will be use to create the company directory.

Mailbox Template -- If you have already created a subscriber whose
mailbox definition can serve as a template for this subscriber, select
that mailbox number in the Mailbox Template drop-down list.

4. Once all the information is entered, click on Add User to List.

5. Repeatthisprocessforanyadditionalsubscribersyouneedtoestablish.

6. When you have identified the last subscriber you need to create, click
on Create Users to return to the Select User to Edit window.

7. To further define mailbox parameters for a subscriber, refer to “Editing
User Setups” on page 5-46.
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Multiple Mailboxes
The Create Range option provides you with the ability to set up multiple
subscribers without the need to set them up individually. To create a
range of subscribers, perform the following steps.

If you created a mailbox for use as a template, all settings and parameters
from the template are copied to the range. A template mailbox is highly
recommended when creating a range of mailboxes. Refer to “Template
Users/Subscribers” on page 5-41 for details.

1. Click on the Users icon in the toolbar (the leftmost icon). Alternatively,
select from the menu bar Edit > Users > Edit User.

2. In the Select User to Edit window, click on Create Range. The
following window is displayed:

Figure 5-32: Create Range Window

3. In the Start Mailbox field, enter the first mailbox number to be used in
the mailbox range.
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4. In the Start Extension field, enter the a corresponding extension
number to be used for the first extension in the mailbox range.

5. If you have created a mailbox to be used as a template for default
settings in all mailboxes for this range, select it from the drop-down
list. If you do not want to use a template, delete any entry that
appears in the Template field.

6. For Number to create, enter the number of mailboxes you want to
create, beginning with the starting mailbox and extension.

7. Click on Create Range. This returns you to the Select User to Edit
window, where you can continue defining mailbox and extension
parameters (refer to “Editing User Setups” on page 5-46).

Editing User Setups
The Edit Mailbox function is used to make changes to the settings and
parameters of existing mailboxes. Note that, to edit mailbox parameters,
a mailbox must have previously been created with the Create or Create
Range function, as described earlier.

General User Settings
To edit general user/subscriber settings, perform the following steps.

1. If the Select User to Edit window is not already displayed, click on the
Users icon in the toolbar (the leftmost icon). Alternately, select from
the menu bar Edit > Users > Show List.

When creating a range, numbers are sequentially assigned to both
mailboxes and extensions. Therefore, the Start Mailbox and Start
Extension fields should correlate somehow, as in this example:

Start Mailbox: 100
Start Extension: 100

or

Start Mailbox: 2100
Start Extension: 100
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2. Highlight the subscriber to edit, and click on Select. The following
window displays:

Figure 5-33: Edit User’s Settings Window

3. Complete the fields for this subscriber as follows:

Extension -- The extension to associate with this mailbox. This option
allows you to change the extension associated with a mailbox
without affecting the mailbox message, signature, or greeting.

First Name and Last Name -- Change as needed. Information in these
fields is used to create the company directory.

Password -- Enter the number to be entered by the mailbox
subscriber to retrieve mailbox messages. Initially, it should be set to
some easy to remember code, like 1111; the subscriber can change
the password later depending on their COS settings.

Department -- Enter the department or area in which the employee
works (this field is used to provide additional information in reports).
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Class of Service (COS) -- From the drop-down list, select the COS to
associate with this mailbox. Refer to “Templates” on page 5-57 for
specific information on COS options.

Tutorial -- Determines if the tutorial is played when the mailbox
owner accesses PathFinder.

If this option is disabled, the subscriber’s COS does not allow for a
first-time tutorial.

If the option is enabled and not checked, the subscriber has
probably already heard the tutorial.

If the option is enabled and is checked, on the next call into
PathFinder, the mailbox owner will access the tutorial.

4. If needed, click on Mailbox Settings and/or Extension Settings, and
configure these windows as needed. Refer to “Mailbox Settings” on
page 5-49 and “Extension Settings” on page 5-51 for more details on
configuring these windows.

5. Click on Save to add this definition to PathFinder.

If the Class of Service field is left blank, PathFinder defaults to the
last COS used. In a configuration that uses multiple COSs, errors
could arise. You should assign a COS to each extension to avoid
possible problems.
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Mailbox Settings
To adjust Mailbox Settings, click on Mailbox Settings from the Edit User’s
Settings window (refer to “General User Settings” on page 5-46). The
following window is displayed:

Figure 5-34: Mailbox User’s Settings Window

Complete the fields in this window using the following guidelines.

Time Control
Unless there is a special circumstance, leave this value as None. Time
controls provide time-oriented call routing instructions (for example,
route unanswered calls to an extension during the day and a mailbox at
night). Refer to Time Control Settings in this chapter for additional
information.

Operator
Enter a personal operator for the mailbox. If a caller presses 0 (for the
operator) while in the mailbox, the call is transferred to an alternate
extension. This setting overrides the system-wide operator setting (refer
to “Operators” on page 5-9). This setting can be used to transfer calls to a
personal attendant.
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Cascade To
Message cascading is a feature that copies or moves messages left for the
originating mailbox to another mailbox. In order to use message
cascading, the originating mailbox’s COS must be configured to allow
this feature (refer to “Message Cascading” on page 5-75). This feature does
not work until COS settings have been properly configured. Typical uses
include archiving and notification of no answer to messages left in a
mailbox (e.g., for customer service).

Mailbox Action
Click on Play Greeting if PathFinder is to play the greeting recorded for
this mailbox when PathFinder answers the phone. Use the drop-down list
to select from various actions that the mailbox performs when a message
is left. These actions function as follows:

Field Description

Take a Message Records messages in the mailbox for later retrieval.

Forward to
another Mailbox

Sends the caller to an alternate mailbox where a message may
be left. The mailbox to which the caller was forwarded dictates
which Notification and MWI settings apply.

Forward to
Extension

Sends the caller to an extension. The mailbox to which the
caller was forwarded dictates which Extension settings apply.

Forward to
Menu

Sends the call to a menu where further options may be
provided to the caller. Refer to Menu Settings in this chapter
for more information on menus.

Forward to Time
Control

Causes PathFinder to execute the assigned time control and
take the appropriate action. Refer to Time Control Settings in
this chapter.

Forward to
Module

Automatically runs another module when the mailbox is
accessed. Special applications only.

Mailbox is Off Disables the mailbox’s ability to take messages. This option
plays the “Mailbox is off” prompt to the caller.

Mailbox is Full Plays a message to the mailbox owner stating the mailbox
cannot record any new messages until old ones are deleted.
This option plays the “Mailbox is full” prompt to the caller.
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Notification
Notification refers to external numbers (e.g., pager, mobile), not Message
Waiting Indicators. Refer to “Notification Settings” on page 5-73.

Select the type of notification PathFinder is to use when a message has
been left in the mailbox. Notification options include the following:

No notification: Disables message notification completely.

Immediate notification: Sends notification immediately upon
receiving messages.

Timed notification: Sets a time to notify mailbox owner of new
messages.

Urgent notification: Instructs PathFinder to send notification, but
only when new messages are marked Urgent.

Phone number: Enter the phone number to dial for notification. Do
not type dialing prefixes for long-distance numbers, outside line
access, and the like (e.g., 9, and/or 1). 

Pager notification: When choosing any method of notification, you
see a Pager Notification checkbox. Select this checkbox if the
notification number you have indicated is a pager.

Extension Settings
Extension Settings allow you to edit the actions for a mailbox number as
well as change transfer options. To edit Extension Settings, click on

If you have an integrated system, do not set notification to call an
internal extension, because the notification message could end up
being left in the extension owner’s mailbox. This would cause
PathFinder to send another notification message, creating a loop.
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Extension Settings from the Edit User’s Settings window (refer to “General
User Settings” on page 5-46). The following window displays:

Figure 5-35: Edit User’s Extension Settings Window

Time Control
Unless there is a special circumstance, leave this field blank. Time control
settings provide time-oriented call routing instructions (e.g., routing
unanswered calls to an extension during the day and a mailbox at night).
Refer to “Time Control Settings” on page 5-93 for more information.

Actions
PathFinder provides three Action fields that determine how PathFinder
process incoming calls. PathFinder refers to the three options in a
cascading order. That is, the first field has precedence over the second,
and the second field has precedence over the third.

The following illustrates an example scenario of Action options:

1. An incoming call is answered by PathFinder

2. PathFinder checks the first Action option for instructions on how to
process the call. The supervised transfer has been selected.
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3. PathFinder is instructed to perform a supervised transfer to the
extension.

4. The extension is busy. PathFinder pulls the call back from the
extension.

5. PathFinder checks the second Action option for instructions on what
to do next. The option Forward to Voice Mail has been selected.

6. PathFinder sends the call to the appropriate voice mailbox.

The fields associated with each Action field change to reflect the Action
selection.

For example, if Forward to Extension is selected in the Action field, the
field to the right of it changes to Extension to forward to. If the Action
selection is set to Forward to Menu, the field changes to Menu to forward
to and is used to enter the name of the menu to which calls are sent.

The following Action options are available:

Blind Transfer -- An unsupervised transfer to the requested extension.
This option is commonly used to transfer to a hunt group or in an
environment where you are sure the call can be answered, as in
integrated systems. Only one transfer type (Blind or Supervised) can be
selected at a time.

Supervised Transfer -- Allows PathFinder to monitor call transfers to
determine whether the called extension is busy or is not being answered.
If the call is not answered, PathFinder refers to the subsequent Action
entries for instructions on processing the call. Only one transfer type
(Supervised or Blind) can be selected at a time.

Screen Caller -- When a person dials an extension through the Auto-
Attendant, the Call Screening feature prompts the caller to state his
name. PathFinder lets the called party hear this name before the call
is actually transferred. The called party can either accept or reject the
call. This option works only with Supervised Transfer.

Holding Allowed -- Gives the caller the opportunity to hold on the
line in the event the called party is busy. This option works only with
Supervised Transfer. The caller hears the following prompt: “I'm sorry,
<extension name> is busy. If you would like to hold press 1. To try
another extension or leave a message for this extension, press 2.”
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Forward to Extension -- Forwards calls to the specific extension entered
in the Extension field.

Forward to Mailbox -- Forwards calls to the specific mailbox entered in
the Mailbox field. Usually this is the called extension's personal mailbox.

Forward to Menu -- Forwards calls to the specific menu entered in the
Menu field. Refer to “Menu Settings” on page 5-83.

Forward to Module -- Forwards callers to a custom script module (e.g.,
pharmacy refill, debit card)

Forward to Time Control -- Runs the designated time control file and
takes the actions designated for the current time. Refer to “Time Control
Settings” on page 5-93.

After selecting the desired Action 1, complete any fields to the right of
the Action 1 field. When Supervised Transfer is selected in the Action 1
field, the Action 2 field becomes active and can be edited.

When Action 1 is set at Supervised Transfer, and the transfer results in a
busy or no answer situation, the setting in the Action 2 field specifies
what should happen next. You may conditionally invoke Action 2 when
the following conditions existed after the Action 1 transfer:

Do always: The action always takes place. Only available for Action 2
and Action 3.

Only on busy: Instructs PathFinder to use this option if the transfer
results in a busy signal. This option must be used in conjunction with
the Only on no answer or Do always options. Only available for
Action 2 and Action 3.

Only on no answer: Instructs PathFinder to use this option if the
transferred call is not answered. Only available for Action 2 and
Action 3.

You may also conditionally invoke Action 3 when the above conditions
existed for the Action 2 transfer.
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User-Edited Features
In addition to the options described in this section, individual users/
subscribers can edit certain mailbox features over the telephone. The
options that subscribers can modify are defined in the Class of Service.
Refer to “Class of Service Settings” on page 5-56 for more information.

Subscribers can refer to the PathFinder User’s Manual for more
information about editing available features.

Deleting Users
Users/Subscribers may be deleted individually or in ranges. After a
subscriber has been deleted, the corresponding mailbox/extension
parameters and settings are erased. The number can be reused only after
it has been recreated with the Create User function.

Any voice files associated with the mailbox are automatically deleted
when the mailbox is deleted.

Deleting a Single User

The Delete User function is used to delete an individual user/subscriber
from PathFinder. This might be necessary for people who have left the
company or who have been transferred to another location.

To delete a mailbox, perform the following steps:

1. Select from the menu bar Edit > Users > Delete User.

2. Enter the mailbox number or extension number that you would like
to delete.

3. Click Delete User.

4. Confirm the deletion.

Alternatively, you can delete a user by performing the following steps.

1. Click on the Users icon in the toolbar (the leftmost icon) to display
the Select User to Edit window.

2. Scroll through the list to highlight the subscriber to delete.

3. Click on Select.

4. When the subscriber’s settings display, click on Delete User.
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Deleting a Range of Mailboxes
Delete Range is used to delete multiple mailboxes from PathFinder. Use
this function to delete a large contiguous block of mailboxes. All settings
and parameters are deleted as are the individual mailbox numbers. To
delete a range of mailboxes:

1. Click on the Users icon in the toolbar (the leftmost icon) to display
the Select User to Edit window.

2. Click on Delete Range.

3. Select the Start and End Mailbox or Extension, depending on the
delete criteria, from the appropriate pull-down menus.

4. Click on Delete User.

Class of Service Settings

The MAINT application allows you to configure PathFinder. This section
describes the Class of Service functions available through the Edit menu
in MAINT.

Definition
To understand Class of Service (COS), think of an airplane. Some
passengers fly first class, others fly business class, and some fly economy
class, each with different amenities and services. PathFinder can do the
same for subscribers, defining a virtually unlimited number of different
classes of service.

Each subscriber (or mailbox and extension pair) is associated with a COS
that defines its attributes. Grouping mailboxes and extensions into
classes of service lets you change options for all the mailboxes and
extensions in the same class simultaneously, simply by editing the COS
record.

This section instructs you how to create, edit, and delete a COS.
Instructions are also provided for creating a COS template, which can
come in handy if you are creating a number of COSs that are similar in
definition.
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Templates
If you are creating several classes of service, you probably have many
parameters that are the same for each. Using a template class of service is
a convenient way to create identical classes of service, each having the
same settings. You can then select the class of service when creating
subsequent classes of service that should share these settings.

To create a template class of service:

1. Click on the COS icon (the second button on the PathFinder MAINT
tool bar). The following window displays:

2. Select COS to Edit Window

3. Click on Create in the Select COS to Edit window.

4. Enter a name for the COS template, using any combination of
alphanumeric characters. Choose a name that describes the group of
users in this COS.

5. Click on Create to return to the Select COS to Edit window.
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6. Highlight the COS you created, and click on Select. The following
window displays, from which you can begin defining parameters for
the COS template.

Figure 5-36: Edit COS Window (for the COS named General)

7. Edit the COS parameters to meet your needs as a template. There are
seven edit categories, listed in the left side of this window. Once you
have selected a category, you can reach another by clicking on the
page controls that display at the bottom of the window. Refer to the
following topics for more information on each category:

“General Settings” on page 5-59

“Greeting Settings” on page 5-61

“Message Types Settings” on page 5-63

“Mailbox Caller Settings” on page 5-66

“Mailbox Owner Settings” on page 5-68

“Notification Settings” on page 5-73

“Auto-Attendant Settings” on page 5-77
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General Settings
Click on General in the Edit COS window to begin defining general
options for the COS. The following window is displayed:

Figure 5-37: Edit COS General Settings Window

Description
Enter a brief description of the COS (twenty characters maximum), to
help identify it in other operations.

Time Control

Calls are often processed differently in the evening, during the weekend,
or on holidays than they are during regular business hours. The time
control function lets you define a set of alternative actions that
PathFinder performs for a given time setting. Time controls are created by
selecting Time Control from the Edit menu. If you intend to use Time
controls, refer to “Time Control Settings” on page 5-93. Otherwise, set to
None.
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User Type
User Type designations were used in early versions of PathFinder to grant
or limit user options. Set User Type to 99 only when granting system
administrator access. For all other subscribers, this field should be set
to 1.

Event Counters
Event Counters provide an overview of how PathFinder is used.

Select the Callers check box if you want to maintain a count of
mailbox/extension access by callers (non-owners).

Select the Owners check box if you want to maintain a count of
mailbox/extension maintenance accesses by the mailbox owner.

Language
Mailbox and extension prompts can be played in an alternate language.
This parameter defines what language prompts will be used for each
subscriber. For example, when an owner accesses their mailbox, a
prompt tells the subscriber how many messages are in the mailbox. This
parameter defines the language for such prompts.

Languages other than English are optional modules and must be
purchased separately.

Restrict OutDial to
You can use this field to disable long distance dialing from the extension
or from mailbox notification by entering the number of digits required
for local calls (typically 7 or 10). This setting determines how many digits
PathFinder can outdial for notification or from an extension.
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Greeting Settings
Click on the Greeting button in the COS Edit window to begin defining
greeting options for the COS. The following window is displayed:

Figure 5-38: Edit COS Voice Mail Greeting Settings Window

Greeting Type

Select from the following types of pre-recorded messages, called
“prompts,” to be used when greeting a caller.

Personal
The Personal greeting option plays a greeting recorded by the mailbox
owner. If the owner does not record a personal greeting, the System
(default) greeting is used.
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System
The System greeting is a generic message used when no personal
greeting has been recorded. If both the Personal and System greetings
are activated, PathFinder plays the personal greeting when one has been
recorded.

System Add-on
The System Add-on is a smaller version of the System (default) greeting
that follows a personal greeting. This greeting plays, “Begin recording at
the tone. To stop recording, press any key . . .” and so on, whereas the
regular System greeting plays, “The person you have tried to reach is
unavailable. Begin recording . . . ” and so on.

Class of Service
The Class of Service greeting plays a single greeting for all mailboxes
that share the same COS. This is done to conserve disk space by
eliminating the need for each mailbox to have its own greeting prompt.

For example, Balagunda Corporation has a COS called SUPRT for all
technical support staff. The COS greeting file SUPRT.GRT might sound like
this: “The technical support representative you are trying to reach at
Balagunda Corporation is not available. Please leave a message at the
tone.”

Only one COS greeting can be recorded for each COS. Its file is stored in
the \HELLONT\VOX directory. By default, the greeting file is called <COS 
Name>.GRT, where <COS Name> is the name given to the COS and 
.GRT is the COS greeting identifier file extension.

Voice Insert
A Voice Insert greeting plays a COS prefix prompt followed by a name
prompt, which in turn is followed by COS postfix prompt. This is often
done to personalize a COS greeting while limiting the amount of disk
space used. For example, Balagunda Corp. set up a COS for all sales
people called SALES. The COS prefix file SALES.VI1, name prompt, and
postfix file SALES.VI2, might sound like this: “Thank you for calling the
Balagunda Corp. sales department. <Subscriber> is not available. Please
leave a message after the tone.”



Class of Service Settings 5-63
Only one COS prefix and postfix prompt can be recorded for any specific
COS. These files are stored in the \HELLONT\VOX sub directory. By
default, the prefix file is called <COS Name>.VI1, where <COS Name>
is the eight-character name given to the COS and .VI1 is the identifier
for the first portion of the voice insert greeting. The suffix file is called
<COS Name>.VI2, where <COS Name> is the eight-character name
given to the COS and .VI2 is the identifier for the second portion of the
voice insert greeting.

Greeting Length
Enter the maximum length, in seconds, for personal mailbox greetings
created by users assigned to this COS. Maximum value for this field is 999.

Message Types Settings
Click on Message Types in the Edit COS window to begin defining
message type options for the COS. The following window is displayed:

Figure 5-39: Edit COS Voice Mail Message Settings Window
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Message Type
PathFinder mailboxes can be used to store a variety of messages. Select
the types of messages to be allowed in mailboxes for this COS.

If more than one type of message is selected, specify one as the default.
This setting applies only to inbound messages, not to the notification
type. The types of messages that are allowed are as follows:

Voice
Callers can record voice messages, and the mailbox owner can listen to
recorded voice messages.

Fax
A caller can leave a fax directly in a subscriber’s mailbox. In order to
retrieve a fax message, a subscriber must send it to a fax machine for
printing. PathFinder must have fax ports in order to receive fax messages.

Page
A caller can enter DTMF digits. The mailbox owner can listen to the DTMF
digits converted to regular speech, or the DTMF digits can be displayed
on a pager. For example:

A caller leaves a page message of 5557890.

If the subscriber tries to retrieve this message, PathFinder plays: “Five,
five, five, seven, eight, nine, zero.”

If a subscriber has a pager for notification of new messages (and is
not using a notification command file), PathFinder sends these DTMF
digits to the paging company and the mailbox owner is notified on
the pager rather than via the voice mailbox.

Message Type Menu

Select this option if you want PathFinder to present the caller with a
menu such as: “To leave a voice message, press 1; To send a fax, press 2.”

A single mailbox can store any combination of message types.
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Leave this option off if mailbox owners are offering access to different
message type options in their individual mailbox greetings.

Message Length
This option determines the amount of time allocated to a message. After
the specified number of seconds has elapsed, the caller is presented with
the normal Send menu as if the caller had pressed a key to stop recording.
A length is 120 seconds is recommended.

Message Count
This option determines the maximum number of messages that can be
stored in a mailbox. When the number of messages in a mailbox exceeds
this parameter, the mailbox plays a Full message. No further messages
are accepted until the number of messages in the mailbox is reduced. A
maximum of fifty messages is recommended.

Message Retention

PathFinder can automatically delete messages that have been stored
longer than a specified amount of time. Specify that time period in this
field. Thirty days is the recommended default retention period; this can
be extended or shortened, depending on your specific needs and hard
disk storage capacity. The maximum value for this field is 999.

Record Key
Leave this off if you want PathFinder to automatically begin recording a
voice message. When this is turned on, the caller must first press a key to
start recording.
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Mailbox Caller Settings
Mailbox caller options are choices given to a caller when leaving a
message. These options are available only after the caller presses a key to
terminate recording a message.

Click on Mailbox Caller in the Edit COS window to begin defining
mailbox caller options for the COS. The following window displays:

Figure 5-40: Edit COS Voice Mail Caller Settings Window

Record Stop Key
Select this option to activate the one-key urgent message send feature.
With this option turned on, if an outside caller presses 8 to end the
recording of a voice message, the message is marked as urgent, sent, and
the caller proceeds to Last Options.
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Caller Record Options
If this option is selected and the caller presses a key after leaving a voice
message, the caller hears the following menu of options:

Press 1 to send the message

Press 2 to play the message

Press 3 to cancel

Press 4 to append the message

Press 5 to re-record the message

Caller Send Options

Select Urgent, Confidential, or both if you want callers to be able to
specify those options for the messages they leave.

Urgent messages are preceded by an Urgent prompt and are played
as the first of a group of messages.

Confidential messages cannot be forwarded.

Last Options

Select according to what you want PathFinder to do once the caller has
left a message. If set to Off, PathFinder says, Thank you and hangs up. If
set to On, PathFinder’s default menu options are played. If set to Menu,
the Last Options Menu is played (refer to “Last Options Menu” on
page 5-67).

Setting this to Off limits a caller’s ability to navigate PathFinder.

Last Options Menu

This determines what menu PathFinder plays if Last Options is set to
Menu (see above). For more information on menus, refer to “Menu
Settings” on page 5-83.
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Mailbox Owner Settings
Mailbox owner options determine the modifications individual
subscribers can make to their personal mailboxes. Click on Mailbox
Owner in the Edit COS window to begin defining mailbox owner options
for the COS. The following window is displayed:

Figure 5-41: Edit COS Voice Mail Owner Settings Window

First Time Help

Check this option if you want each new subscriber prompted to record
such essential parameters as a greeting, a mailbox name, and a password.



Class of Service Settings 5-69
Message Date Time
PathFinder can announce the date and time that a message was received
at the beginning of a message.

Select Auto-play to have the date and time announced automatically
at the beginning of every played message. If you leave this option off,
the subscriber must press 8 to check the date and time.

Select Play entire date to have the month, date, and time included in
every date announcement. If you leave this set to off, for messages
received today, only the time is repeated; messages received
yesterday include the word “yesterday” and the time; messages
received during the current week include the day of the week (e.g.,
Wednesday) and the time. Messages received more than a week
earlier include the month and date of the message as well as the time
it was received.

Oldest Message First

If this option is selected, messages are played in chronological order,
starting with the oldest message in the mailbox. If this is left off, the
newest message in the mailbox is played first when a subscriber checks
the mailbox, with remaining messages played in the reverse of order
received. Subscribers typically prefer that this option be left off.
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Owner Play Options
Mailbox owners can be given several options for processing played
messages, making mailbox management as simple or as sophisticated as
desired. Detailed instructions on using these options are included in the
PathFinder User's Manual and on the Quick Reference Card. The following
options are available.

Field Description

Save Msgs Allows subscribers to save messages for later retrieval.

Confirm Deletes Requires subscribers to press the [#] key after
pressing [3] to delete a message, as a safeguard
against accidental deletion.

Forward Msgs Allows subscribers to forward messages to other
mailboxes or to an outside number.

Reply To Msgs Allows subscribers to press [5] while listening to a
message and reply to the message.

Dial Source Allows the subscriber to connect to the person
responsible for sending the message. This can also
include outside numbers if the originating phone
number is known.

Skip Message Allows subscribers to skip messages by pressing [6]
and [3] while listening to a message.
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Owner Send Options
These parameters determine the functions available to subscribers when
sending messages. Detailed instructions on using these options are
included in the PathFinder User's Manual and on the Quick Reference
Card. The following options are available.

Field Description

Not Allowed Used for creating simple mailboxes to which none of
the following options can apply.

Urgent Allows the subscriber to assign urgent status to a
message. Urgent messages are preceded by an Urgent
prompt and are played as the first of a group of
messages.

Confidential Allows the subscriber to specify that a message cannot
be forwarded.

Future Send Allows delivery of messages at a future time and date.

Outside Numbers Allows the subscriber to send a message to an outside
number.

System Lists Allows the subscriber to send messages to a system-
wide list (the list is maintained by the administrator).

Confirmation Enables the subscriber to request receipt information
for a marked massage, so PathFinder notifies the
sender when a message has been heard.
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Owner Edit Options
These parameters determine the mailbox customization available to
subscribers within this COS. Detailed instructions on using these options
are included in the PathFinder User Guide and the Quick Reference Card.
The following options are available.

Mail

Field Description

Password Enables the mailbox owner to change the mailbox
password. This is typically turned off when a mailbox
is for temporary use, as with hotel guests.

Greeting Allows mailbox owners to edit their own greetings;
this option typically is enabled.

Name Allows the owner to change the mailbox name, which
is used in prompts associated with the mailbox.

Notification Allows the owner to change such notification settings
as the extension or phone number to call, and the
time of notification (such as for a pager).

Mailbox State Allows the owner to turn the mailbox off, set it to
greeting only, forward calls to an extension, forward
calls to a mailbox, or forward calls to menu. Typically
not used when a simple mailbox is desired.

Personal Lists Allows the subscriber to create up to ten personal lists
and maintain them over the telephone.

Guest Mailboxes Allows the owner to communicate with a guest who
does not have a mailbox on PathFinder.

Auto-Attendant Allows the mailbox owner to edit extension settings.

Note Pad Grants the mailbox owner access to a personal voice
note pad. The voice note pad is similar to a note pad
referenced with an index. The index can be any eight-
digit number with an associated voice file.
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Notification Settings
PathFinder has a variety of notification options that are used to tell
mailbox owners when they have received a new message. Click on
Notification in the Edit COS window to display these options. The
following window is displayed:

Figure 5-42: Edit COS Voice Mail Notification Settings Window

Transfer Out Allows the mailbox owner to transfer to other
extensions or mailboxes. This option should be turned
off in a service bureau application or when the Auto-
Attendant is not used.

Delete Unheard Allows the mailbox owner to pull back messages that
were sent to another local mailbox. PathFinder
prompts the owner for the destination mailbox, and
then check to determine if any unheard messages
from the owner are still in the mailbox. PathFinder
plays each message and allows the owner to
selectively delete them.

Field Description



5-74 Class of Service Settings
Message Waiting
PathFinder can send message waiting commands to telephone systems
that support message waiting indicators or similar notification devices.

Off -- PathFinder does not send message waiting indicators to subscriber
stations with this COS.

On: First Message -- PathFinder sends message waiting indicators only
when the first message is received. This setting is particularly useful when
the message waiting indicator is toggled between off and on.

On: Every Message -- PathFinder sends a message waiting indicator for
each new message received by the subscriber.

Message Waiting Indicator (MWI) Strings

Normally, a phone system defines the MWI strings by the length of the
extension in MWI/Notification. On some phone systems, it is necessary to
define MWI strings on a per COS basis. The COS message waiting
indicator string settings take precedence.

Default message waiting indicator settings are defined in the
Configuration menu of MAINT. Refer to “MWI/Notification” on page 5-21.

Event Handler Group

The Event Handler facility is used to program PathFinder’s notification
lines. The default Event Handler Group is 5. For notification to work, at
least one of the phone lines must be assigned an event handler. Refer to
“Setting Up Phone Lines” on page 5-102 to complete configuration of the
event handler.
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Voice Notify Options
These options apply when PathFinder plays messages to the caller during
notification. Refer to Appendix A for more information on how to
configure PathFinder to play messages to the caller during notification.

Set to Password Required to force the owner to enter a password to
retrieve messages.

Set to Msg Pickup Allowed to allow message retrieval without
password entry.

Message Cascading
This powerful option gives PathFinder great flexibility in delivering a
message. Any incoming message, depending on the cascade setting, can
be copied or forwarded to other mailboxes.

When Message Cascading is activated, either the message itself or a copy
of the message also automatically “cascades” to another mailbox. Refer
to “Original Message” on page 5-76 for selecting options to decide what
happens to the original message in the primary mailbox.

Use the following guidelines to set Message Cascading options:

Set to Off to turn this option off.

Set it to Immediate to cause cascading to begin immediately,
allowing the message to be copied or forwarded to another mailbox.
As an example, if the Message Cascading option is set to Immediate
notification, then the following process occurs:

Mailbox A gets a message.

Mailbox A has notification activated.

The message immediately cascades to Mailbox B.

Allowing message pick up without a password can undermine the
privacy and security of the mailbox.

Refer to “Cascade To” on page 5-50 for more information about
configuring cascading options.
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Refer to “Original Message” on page 5-76 for selecting options to
decide what happens to the original message in the primary
mailbox.

Set it to When Notify Fails to allow the message to be copied or
forwarded to another mailbox or other mailboxes only when the
notification has failed and a mailbox owner has not retrieved the
message. As an example, if the Message Cascading option is set to
When Notify Fails, then the following process occurs:

Mailbox A gets a message.

Mailbox A has notification activated, and the complete
notification takes 30 minutes.

If the owner of Mailbox A does not save or delete the message
after 30 minutes, then the message will cascade to Mailbox B.

Refer to “Original Message” on page 5-76 for selecting options to
decide what happens to the original message in the primary
mailbox.

Select the On Urgent Only checkbox to activate either When Notify
Fails or Immediate cascading only for messages marked Urgent.

Original Message
These options are available when Message Cascading is set to Immediate
or When Notify Fails.

Leave as New leaves the original message as a new message in the
original mailbox. Remember that all new messages in the original
mailbox will be cascaded. As an example:

A subscriber receives a new message at 9:00 a.m., and that
message is cascaded.

The mailbox owner does not save or delete the message.

The subscriber receives a new message at 4:00 p.m.

Both new messages will be cascaded.

Set to Save Message to cause the message to be saved in the original
mailbox once the forwarding is completed.

Set to Delete Message to cause the original message to be deleted
from the original mailbox once the forwarding is completed.
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Notify Interval
This parameter determines the time interval between each notification
attempt until the owner retrieves the message. The time is measured in
minutes, with a maximum interval of 999 minutes.

Notify Retries

This parameter determines how many times PathFinder attempts to
notify a mailbox owner after receiving a new message. The maximum
number of attempts is 99.

Retry Pager
This option only applies to pager notifications. It allows notifications to a
pager to be repeated if PathFinder detects a busy or no answer when
calling a paging company. In other words, if PathFinder detects a busy or
no answer, PathFinder does not consider that an attempt to notify the
paging company has been made and retries the attempt later.

Notify Script

This powerful feature allows complex notification scripts to be created on
a per COS basis. This option can only be used if a notification script has
already been written. Refer to Appendix A for instructions on creating
notification scripts.

Auto-Attendant Settings
These options determine the handling of several automated operations
with PathFinder.
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Click on Auto-Attendant in the Edit COS window to display these
options. The following window is displayed:

Figure 5-43: Edit COS Automated Attendant Settings Window
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Call Options
Call options describe what extension settings the subscriber can change
via their mailbox. Typically, these options should be disabled as the
subscriber could significantly alter the behavior of their mailbox and
extension settings.

Select Blind Transfer to allow unsupervised call transfer where
PathFinder forwards the call to the requested extension. This option is
commonly used with hunt groups.

Select Supervised Transfer if you want PathFinder to monitor the
transfer to determine whether the called extension is busy or is not
being answered. If you select Supervised Transfer, you can check
either or both of the following:

Screening -- When a caller dials an extension, Call Screening prompts
for a name. This information is given to the called party before the
call is actually transferred. The called party can either accept or reject
the call.

Holding -- This allows the caller to hold if the called party is busy.
PathFinder plays: “I'm sorry, <subscriber's name> is busy. If you would
like to hold, press 1. To try another extension or leave a message for
this extension, press 2.”

Extended Options
This option provides the mailbox owner with more control over the
forwarding of the mailbox and extension. Without this option on, the
owner can only modify extension settings. With this option on, the owner
can specify a destination mailbox or extension.

Hold Type
This setting determines what callers hear if an extension is busy and they
elect to be put on hold.

Setting this to Silence keeps the call connected, but the caller hears
nothing while on hold.
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Dial Hold Sequence causes PathFinder to execute a flash-hook when
the caller is placed on hold (if provided by the phone system, the
flash-hook activates background music).

If set to Play Hold Files, the caller hears recorded messages prepared
for PathFinder. Up to nine hold files can be recorded. Hold files are
saved in the VOX subdirectory, and have the following naming
convention:

HELLONT\VOX\AAHOLD.0

HELLONT\VOX\AAHOLD.1

HELLONT\VOX\AAHOLD.2

Hold Interval
This setting determines how long PathFinder waits before retrying a busy
extension. For example, if PathFinder attempts to ring a busy extension,
and if the hold interval is set to ten seconds, it retries the extension every
ten seconds until a connection is made or until the retry limit is reached.
The time is measured in seconds, with a maximum interval of 999
seconds.

Call Queuing
This option allows multiple calls to be placed on hold for a single
extension. Turning on call queueing causes PathFinder to hold the calls in
a queue until they are answered. Queued calls are answered in the order
received. Refer to “Auto-Attendant” on page 5-4 for more information on
Call Queue Intervals and the like.

Call Holding must be enabled in the subscriber’s Extension settings for
Call Queueing to function properly. Refer to “Extension Settings” on
page 5-51 for more information.

Screen Length

This option determines the amount of time by which a caller must
respond with a name when prompted to do so through Call Screening.
The time is measured in seconds, with a maximum value of 999 seconds.
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Play Call Source
Activating this option means that if a message is left in a mailbox to
which an extension was forwarded, the originally dialed extension is
identified at the start of the message with a prompt (e.g., “Message from
John Smith,” if the call was originally intended for John Smith’s extension,
which was forwarded to the extension from which the message is
retrieved).

Transfer Strings

Default transfer strings are typically configured in the telephony settings.
Refer to “Transfer Settings” on page 5-30 for more information. Any setting
configured here overrides the default configuration. Configure the
transfer prefix and postfix for any subscriber using this class of service.

Creating a COS
A class of service provides an easy way to modify an entire group of
mailboxes or extensions. By supporting multiple COSs, PathFinder
provides you the ability to provide subscribers with options to features
on an as-needed basis.

To create a new COS, perform the following steps:

1. Click on the COS icon (the second button on the PathFinder MAINT
tool bar). The following window is displayed:

Figure 5-44: Select COS to Edit Window
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2. Click on Create in the Select COS to Edit window.

3. If you are using a template COS, select the template from the drop-
down list.

4. Enter a name for the COS (twenty characters maximum), using any
combination of alphanumeric characters. Choose a name that
describes the group of users in this COS.

5. Click on Create to return to the Select COS to Edit window.

6. Highlight the COS you created, and click on Select. The following
window is displayed, from which you can begin defining the COS.

Figure 5-45: Edit COS Window (for the COS named General)

7. Edit the parameters for this COS. There are seven edit categories,
listed at the left of this window. Once you have selected a category,
you can reach another by clicking on the page controls that display at
the bottom of the window. Refer to the following topics for more
information on each category:

“General Settings” on page 5-59

“Greeting Settings” on page 5-61
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“Message Types Settings” on page 5-63

“Mailbox Caller Settings” on page 5-66

“Mailbox Owner Settings” on page 5-68

“Notification Settings” on page 5-73

“Auto-Attendant Settings” on page 5-77

Modifying a COS
If you need to make adjustments to the COS you’ve defined, perform the
following steps:

1. Start up PathFinder MAINT.

2. Click on the COS button on the toolbar.

3. Highlight the COS to modify, then click on Select.

4. Click on the button that corresponds to the category of function to
be changed. If you need to move from one category to the next, use
the page controls that appear at the bottom of the window after you
select a category.

Deleting a COS
To delete a COS entirely, perform the following steps:

1. Start up PathFinder MAINT.

2. Click on COS on the toolbar.

3. Highlight the COS to delete, then click on Delete.

Menu Settings

The MAINT application allows you to configure PathFinder. This section
describes the menu functions available through the Edit menu in MAINT.
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PathFinder provides sophisticated multi-level menuing capabilities that
can be used to direct users and callers to information, assist them in
performing tasks, and guide them in their use of PathFinder. Menus
combine other modules and features to create sophisticated call
processing applications. Before going into a detailed description of the
menu module, two terms must be defined:

Menu: A list of actions executed through touch-tone keys. For
example, “Press 1 for sales. 2 for support. 3 for administration....” A
menu can invoke up to fourteen actions, with each action
corresponding to a key on a standard telephone keypad (including *
and #), plus two actions as defaults.

Action: An instruction that is selected from the Menu Action List. It
tells PathFinder how to respond when a specific key is pressed. An
action can invoke another module (transfer a call to an extension
through the Auto-Attendant) or perform a special feature (play a
prerecorded message).

Before setting up complicated, multi-level menus, read through the
information in this section. It is important that you understand the
mechanics of building a menu before you begin.

Designing a Menu
A good way to begin creating a menu is to draft it on paper. Initially, ideas
may not seem sufficiently organized to warrant flow charting; if this is the
case, just jot them down. Don't worry about the specific order of menu
items at this stage; it is more important to get all the ideas down so that
alternatives won't be forgotten. Once this is done, begin the process of
building a menu flow chart.
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The flowchart below illustrates the design of a typical multi-level menu.
As you create your own menu, you should include as much detail as
possible to avoid menu conflicts. Once you have generated a flowchart,
you are ready to begin creating your menus.

Figure 5-46: Sample Flow Chart for Menu Design

“Thank you for calling the Balagunda Corporation.
Please press . . . “

1 2 3

21

“For sales
information.”

“For
technical
support.”

“If you know the
extension of the
party you are
trying to reach.”

“Thank you for
contacting the
sales department.
Please press . . . “

“For the
Eastern region.”

“For the
Western region.”

…transfer to the
Technical Support

Hunt Group.
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A menu must be created before you can add commands to it or make
changes to it. To work with menus, click on Menu on the tool bar. The
following window displays:

Figure 5-47: Select Menu to Edit Window

From here, you can create a menu, delete a menu, or select a menu to
edit.

Creating a Menu
To create a menu, perform the following steps:

1. In the Select Menu to Edit window, click on Create.

2. Enter a name for the menu, up to eight characters.

3. Select from the Template field’s drop-down list a template menu
upon which the new menu can be based. For example, if a menu
called Day already exists, and you want to create a new menu called
Night that is similar to the Day menu, select Day as the template
menu. You may also choose to leave the Template field blank.

4. Click on Create Menu to return to the Select Menu to Edit window,
highlight the new menu name, and click on Select to move to the
Edit Menu window.
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Deleting a Menu
To delete an old or unneeded menu:

1. In the Select Menu to Edit window, highlight the menu to remove.

2. Click on Delete, then click on OK when the confirmation prompt is
displayed.

Editing a Menu
The Edit Menu function is used to edit both new and existing menus.

To edit a menu, perform the following steps:

1. In the Select Menu to Edit window, highlight the desired menu, then
click on Select. The following window is displayed:

Figure 5-48: Edit Menu Window (for a menu named “Banking”)

Prompts that are associated with the deleted menu remain on
PathFinder so that other menus can use them. Eventually,
PathFinder clean-up procedures delete unused prompts.



5-88 Menu Settings
2. The menu name is listed at the top of the editing window. Configure
fields and options in the general pane as follows:

Password -- Specify the password to protect the on-line recording
action. This password is required when a caller accesses the action
Record Prompts.

Description -- Enter a brief description of the menu’s function to
remind you of its purpose.

Time Out -- Specify the length of time after which, if the caller presses
no key, the specified action is to run.

Time Control -- Calls are often processed differently in the evening,
during the weekend, or on holidays than they are processed during
regular business hours. The time control function lets you define a set
of alternative actions that PathFinder performs for calls during
defined time periods. Refer to “Time Control Settings” on page 5-93 for
more information on time controls. If you do not intend to use time
controls, set this value to None. Use caution when configuring this
option, as it may cause unexpected behavior.

Retries -- Specify the number of times a caller can initiate an invalid
option. If the caller initiates more than the maximum number of
allowed invalid options, the Max Retries key action is taken. The
maximum value for this field is 999.

3. Settings in the voice prompts pane describe information played for
callers to assist them in deciding which keys to press. The voice
prompts are played in order from Introduction, to Body, to Instructions.
If no voice prompt is defined, PathFinder plays the next prompt in the
sequence. To the caller, the sequential voice prompts appear as a
single prompt.

Usually, the first menu in a multi-level structure has an introduction
and possibly a body prompt file. Almost all menus have instruction
prompt files. Additionally, the introduction prompt is played only
in the initial (first) menu, and any subsequent menus will not play
the introduction prompt. However, these prompt files are
dependent on the application design.
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Configure the voice prompts pane as follows:

Introduction -- Type or select the prompt file to be played first. This
prompt should include something like: “Thank you for calling Widget
Corporation.” Typically, only the first menu accessed for a caller plays
an Introduction prompt.

Body -- Type or select the prompt file to be played after the
introduction prompt. This prompt is not used in most menus. A
typical body prompt might be:
“Widget Corporation is a company that specializes in high-tech
widgets . . . ”

Instructions -- Type or select the prompt file to be played after the
body prompt (if there is one). The instructions prompt should contain
information the caller needs to decide which keys to press. A typical
instruction prompt would be:
“For sales, press one; for support, press two . . . ” and so on.

The ellipses ( . . . ) button displays a list of all user-recorded prompts.
This allows you to select a pre-recorded prompt.

4. The bottom part of the window addresses Key Actions. Key actions
determine the response invoked when a particular key is pressed.
Each dial-pad key has an accompanying key action field.

Menus are often designed to branch to other menus (submenus).
PathFinder plays an introduction prompt for only the very first
menu accessed. Any introduction for a submenu must be recorded
as part of the body prompt (or the instruction prompt, if there is no
body prompt). For example, a “Sales” submenu instruction prompt
might be: “Thank you for calling the sales department. For
distribution sales, press 1; for direct sales, press 2... “

There is a special field labeled Time-Out. The Time-Out field indicates
what happens when the caller does not press any keys before the
time-out period elapses.

The Max Retries key action is another special field. The Max Retries
setting indicates what happens when the caller presses an invalid
key one time more than the retries setting.
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Clicking any Key Action button displays the list of options. When you
select an option, further options display in the right side of the
window, when appropriate. Define each key in this window. Refer to
“Key Action Definitions” on page 5-90.

Key Action Definitions
Define key actions in the Edit Menu window by clicking the
corresponding Key Action button. Fields in the resulting window can be
configured as follows:

Table 5-1: Key Action Definitions

Key Action Definition

MAILBOX Sends the caller to a specific mailbox.

Ask for Mailbox PathFinder prompts the caller to enter a mailbox number. For example, if
the 1 Key is set to Ask for Mailbox, then callers press 1, they hear, “Enter
the mailbox number of the person you are trying to reach. Press zero for
the operator. Press the star key for the directory.”

Start Key The first digit of the mailbox you are trying to access. For example, if the
2 Key is set to Start Key, then when the caller presses 2, they will not hear
a prompt, and the system will wait for more digits.

NOTE -- If you assign 2 as the mailbox Start Key, then you must have mailbox
numbers that start with the digit 2.

Specific Mailbox
Number

The caller is transferred directly to the mailbox indicated. For example, if
the 3 Key is set to send to Specific Mailbox Number 4401, then when
callers press 3, they are transferred directly to mailbox 4401.

EXTENSION Sends the caller to a specific extension.

Ask for
Extension

PathFinder prompts the caller to enter an extension number. For example,
if the 1 Key is set to Ask for Extension, then callers press 1, they hear
“Enter the extension number of the person you are trying to reach. Press
zero for the operator. Press the star key for the directory.”

Start Key The first digit of the extension you are trying to access. For example, if the
2 Key is set to Start Key, then when the caller presses 2, they will not hear
a prompt and the system will wait for more digits.

If you assign 2 as the extension Start Key, then you must have extension
numbers that start with the digit 2.
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Specific
Extension
Number

The caller is transferred directly to the extension indicated. For example, if
the 3 Key is set to send to Specific Extension Number 123, then when
callers press 3, they are transferred directly to extension 123.

Menu Executes the selected menu.

Owner Access Gives access to mailbox owner menus. This is used with in-band
integration or to provide access through a hidden key on a menu.

Run Module Runs other modules that PathFinder supports.

Time Control Enter the time control to run. This option takes actions based on time,
date, and day of the week settings. Refer to “Time Control Settings” on
page 5-93 for more information on time controls.

Command File Runs the command file script. Refer to Appendix A for additional
information on command files.

Company
Directory

Provides a company directory listing, for either mailboxes or extensions.

Fax On Demand Refer to the Fax-related sections of the Optional Modules manual for more
information on this option. Fax modules are optional and are sold
separately. You can activate this option if you have purchased the Fax
module(s). The following choices are available:

May be left blank to have the caller select fax documents
May contain a document number
May contain ADMIN to allow the caller to access fax-on-demand
administrative functions

Run ActiveVex Runs an ActiveVex module. ActiveVex is a proprietary development
language used to create custom applications.

Operator Transfers caller to the General Operator. Refer to “Operators” on
page 5-9 for more information on Operator settings.

Invalid Option Plays the message “Invalid option” and repeats the instructions.

Disabled Key Pressing a key with this action has no affect at all. It is as if the key were
never pressed.

Table 5-1: Key Action Definitions

Key Action Definition
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Play Prompt Plays the indicated voice prompt file. Alternatively, you can select a
prompt based on its directory location (directory number listed below)
and the specific file name, such as 4:help.vox. The available
directories include:

1: Modules 4: VOX 7: dBase
2: Prompts 5: Mailbox 10: Data
3: Messages 6: Menus 20: Data

For example, to have PathFinder play the mailbox greeting for mailbox
345, type 3:345.GRS as the prompt name.

Play
Instructions

Replays the instructions prompt, such as, “To hear this menu again
press...”. Only the instruction prompt associated with the menu is played.

Record Prompts Allows a caller to re-record prompts for a menu. The caller, after pressing
the key associated with this action, is prompted for the menu password.
The Introduction, Body, Instructions, or any play prompt file attached to a
particular key can then be recorded or edited.

Change
Language

Changes the prompt files that are used to those recorded in the selected
language. Only languages that you have purchased are available.

Hang Up Plays the hang up message “Thank you for calling” prior to disconnecting
the caller. For example, a menu might include this option at the end of a
list, “Press 1 for sales, 2 for support, # to return to the previous menu, and
9 to hang up”. If the caller presses 9, the hang up message plays.

Max Retries This field determines the number of incorrect attempts that callers are
given when entering key presses.

Time-Out The amount of time the caller has in which to enter a response after all
menu prompts have been played. PathFinder executes the Time-Out
action once this time limit has been exceeded. 5 seconds is usually
sufficient. The maximum value for this field is 999.

Table 5-1: Key Action Definitions

Key Action Definition
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Time Control Settings

The MAINT application allows you to configure PathFinder. This section
describes the time control functions available through the Edit menu in
MAINT. Time controls are settings that allow PathFinder to activate or
disable extension and mailbox features depending on date, day, and/or
time settings.

Time controls can be used to route calls, send callers to voice mail, and
play menus, among other things based on time and day settings.

Up to ten distinct time periods can be defined within a time controls
setting, allowing you to make a time control as simple or as complex
as needed.

Time control searches by date, then by day, then by time.

Time controls can be chained together to allow more than ten day/
time options.

You can use the time control function to:

Edit a time control

Create a new Control

Delete a Control
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Setting Up Time Control Parameters
To work with time controls, click on the Edit Time Control Records icon
on the toolbar (fourth icon). The following window displays:

Figure 5-49: Select Time Control To Edit Window

Creating a Template Time Control
If you are creating multiple time controls with similar settings, the use of
a template time control is helpful. The template time control is a time
control with the basic settings defined and is copied when creating new
time controls. Typically, you would use the 8-5 time control as the
template time control. However, if you would like to create a specific
template time control, perform the following steps:

1. In the Select Time Control to Edit window, click on Create. This displays
the Create Time Control window.

2. Enter a name of up to eight characters in the Time Control Name field.

3. Click on Create to return to the Select Time Control to Edit window.

4. Edit the new template time control; refer to “Editing a Time Control” on
page 5-96.
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Creating a Time Control
A time control must be created before it can be edited. Creating a time
control is the process of assigning the time control a name and entering a
description.

To create a new time control, perform the following steps.

1. In the Select Time Control to Edit window, click on Create. The
following window displays:

Figure 5-50: Create Time Control Window

2. Enter a name of up to eight characters in the Time Control Name field.

3. If you want to use an existing time control as a template for the one
you’re creating, select it from the Template Time Control pull-down list.
If no template is selected, the Time Control will be blank.

4. Click on Create to return to the Select Time Control to Edit window.

5. You can now edit the new time control; refer to “Editing a Time
Control” on page 5-96.
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Editing a Time Control
The edit time control function is used to edit both new and existing time
controls. If the Select Time Control to Edit window is not displayed, click on
the Edit Time Control Records icon on the toolbar. To edit the time
control, perform the following steps.

1. Highlight the time control to edit, then click on Select. The following
window displays:

Figure 5-51: Edit Time Control Window

2. If necessary, type a description for the time control.

The window illustrated above shows a newly created time control, with
all fields blank. When you edit an existing time control, the fields already
have options entered and displayed.
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3. To define the first line item of the time control, click on 1. The
following window displays:

Figure 5-52: Edit Time Control Line Item Window

4. In the date fields, enter a Start and End date, using MM/DD format
(01/01 through 12/31), to indicate specific starting and ending dates
to which this line item in the time control applies.
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5. In the time fields, enter a Start and End time, using GMT, twenty-four
hour format (00:00 through 24:59), to indicate the specific times
during the day that this line item in the time control is active.

6. In the day of week fields, select the checkbox for each day to which
this line item in the time control applies, and clear the checkbox for
each day to which this line item in the time control does not apply.

7. In the Time Period field, enter a number from 1 to 9 to distinguish
different time-related events within a time control. Time Period is
most often used to control what mailbox greeting is played when a
mailbox is reached. Typically, PathFinder uses 1 for daytime, 2 for
evening, and 3 for weekend. If in doubt, set the Time Period field to 1.

When specifying start and end dates and times, the following
guidelines apply:

Leaving the Start field blank will cause PathFinder to assume
the lowest value, i.e. 01/01 or 00:00.
Leaving the End field blank will cause PathFinder to assume
the highest value, i.e. 12/31 or 23:59.
Leaving both fields blank will cause PathFinder to assume all
dates or times, i.e. 01/01 to 12/31 or 00:00 to 23:59.
The Start date/time must always be earlier than the End date/
time. A Start Time of 17:00 and an End Time of 08:00 (i.e., 5:00
p.m. to 8:00 a.m.) is INVALID and may cause PathFinder to
behave erratically.
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8. Click on Edit Action to select the specific action to be performed
during the indicated dates, days of the week, and hours during the
day. The following window displays:

Figure 5-53: Edit Time Control Window

9. Click on the action key that you want to configure. A brief description
of each action appears to the right of the window as it is selected.

If you do not select any action, no time control action is performed.
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10. Select options from the time control action list as follows:

Field DEscription

Mailbox Sends the caller to the specific mailbox you select from a
drop-down list. Selecting Ask for Mailbox causes
PathFinder to prompt the caller for a mailbox number.

Extension Sends the caller to the specific extension you select from a
drop-down list. Selecting Ask for Extension causes
PathFinder to prompt the caller for an extension number.

Menu Executes the selected menu.

Owner Access Prompts the caller for a mailbox and password, or only for a
password if you select the mailbox from the drop-down list.

Run Module Runs other PathFinder modules.

Time Control Loads a time control and executes the time control action
for the computed time period.

Command File Runs the indicated command file. Refer to Appendix A for
more information on command files.

Company Directory Provides a company directory listing according to your
selection for Mailbox mode or Extension mode.

Fax on Demand Provides a choice of entries including blank (caller select
document to be faxed), a document number to be faxed to
the caller, or ADMIN (allow caller to access Fax on Demand
administrative functions). This option functions only if you
have purchased the optional Fax-On-Demand module and
have enabled it on the software key.

Run ActiveVex Enables the ActiveVex module. ActiveVex is a proprietary
development language. Select this option only if you have
an ActiveVex module installed on your system.
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11. Click on OK until you return to the Edit Time Control window.

Repeat steps 3. through 11. of the above process until all lines of the time
control have been defined. Clicking Edit 6-10 in the Edit Time Control
window provides access to a second series of lines.

Once all options have been set and saved, you can begin to use the time
control. Time controls can be used in mailbox, extension, and menu
settings. Refer to Chapter 5 for details on using time controls.

Voice Mail, Auto-Attendant, & Menuing Time Periods

Mailbox Settings

Extension Settings

General Settings

Editing a Menu

Setting Up Phone Lines

Deleting a Time Control
As demonstrated above, time controls can be as simple or as complex as
needed. When used in conjunction with menuing options (refer to “Menu
Settings” on page 5-83), time controls provide PathFinder with a
tremendous amount of control and flexibility in processing calls.

The delete time control function is used to remove any time control that
is no longer of use. To delete a time control, perform the following steps.

1. Click on the Edit Time Control Records icon on the toolbar.

2. Highlight the time control to delete, then click on Delete.

3. When prompted if you want to proceed with the deletion, click on
OK.
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Line Settings

The MAINT application allows you to configure PathFinder. This section
describes the line settings available through the Edit menu in MAINT.

The modular nature of PathFinder allows you to assign a specific module
or application function to each telephone line (also referred to as a port
or channel). When a caller dials a specific line, PathFinder runs the module
that has been assigned to that port.

Assigning Port Modules
You should read this section before actually assigning any modules to a
line. Then, read the sections of the manual that describe the modules you
plan to install. When you have finished, return to this section to complete
setup for your PathFinder phone lines.

System Partitioning

It is important to note that each line is independent from the other lines
and can be programmed to perform a unique function. This is referred to
as system partitioning. It allows you to run multiple telephone
automation applications with a single PathFinder installation.

To program system partitioning, perform the following procedure for
each line:

Select the line

Select a module to install on the line

Define parameters, if any, that regulate how the installed module
functions

Setting Up Phone Lines
Each phone line must be set up to run an initial module when PathFinder
starts. This is the process of selecting a starting function for each line and
assigning any needed parameters to that line. You can selectively define
separate functions for every phone line.
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To set up phone lines, perform the following steps:

1. Click on the Line icon in the toolbar. A window similar to the
following displays:

Figure 5-54: Line Settings Window

2. Default PBX Name field: Allows you to specify the PBX name to be
used for any lines that do not have a PBX name explicitly defined. In
most configurations, you can leave this value blank or set it to
ANALOG.

3. Highlight the line to configure in the Line field, then click on Next.
The following window displays:

Figure 5-55: Edit Line Settings Window
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4. Click on Next to display the Event Handling Group window:

Figure 5-56: Edit Line Setting Window

5. Click on Next to display the Blockage Group window:

Figure 5-57: Edit Line Setting Window
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6. Click on Next to display the PBX Name window:

Figure 5-58: Edit Line Setting Window

7. Select a module from the list, address the options that appear at the
right of the window (they vary according to the module selected),
then click on OK. Refer to “Suggested Initial Module Settings” on
page 5-107 for more information on configuring these fields:

Field Description

Mailbox Prompts the caller to select a voice mailbox or sends
caller to a specific mailbox, depending on your
selection from the drop-down list.

Extension Prompts the caller to select an extension or sends caller
to a specific extension, depending on your selection
from the drop-down list.

Menu Plays the selected PathFinder menu.

Owner Access Grants access to mailbox owner privileges for a specific
mailbox, or prompts the caller for a mailbox, with
password prompting in either case.
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8. Once you have selected the module and clicked on OK, you are
returned to the Edit Line Settings window.

Figure 5-59: Edit Line Settings Window

Run Module Activates the selected module.

Time Control Loads a time control file and takes the menu action
specified in the current time period.

Command File Runs the specified command file. Refer to Appendix A
for information on command files.

Company Sends the caller to the company directory, in your
choice of mailbox mode or extension mode.

Fax On Demand Provides a choice of entries including blank (caller
select document to be faxed), a document number to
be faxed to the caller, or ADMIN (allow caller to access
Fax on Demand administrative functions). The Fax-On-
Demand option is available only if you have purchased
the optional Fax-On-Demand module and have
enabled it on your software key.

Field Description
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9. Address the remaining fields as needed, according to the following
guidelines:

Event Group: Select the group whose action is managed by this
line. Multiple lines can be assigned to an event group, enabling
any available line in that group to be used for the action. Note
that at least one channel must be assigned to any event group
you specify for Auxiliary Tasks, for Class of Service, and for
outgoing faxes.

Block Group: Blockage detection determines when all lines
assigned to a block group are in use. When all lines assigned to a
particular block group are servicing a call, that group is
considered blocked and a log line is generated. If, for example, all
lines are in block group 1 and blockage is detected for that group,
PathFinder is completely busy.

PBX Name: Select the appropriate PBX name. For most inband
integrations, the PBX Name field should be left as ANALOG. For
some other integrations, the PBX Name field will need to ba
changed. Do not change this field unless you are instructed to do
so by Vodavi Technical Support.

10. Repeat this process for each line.

Suggested Initial Module Settings
Set the initial module for each line according to PathFinder’s use and
configuration.

The following are suggestions on appropriate uses of various options:

If all calls to PathFinder are processed the same manner, regardless of
time or date, use the same menu option for all ports.

If calls are processed differently based on the time or date the call is
received, select the Time Control option, along with the appropriate
time control file.

If your system has in-band integration, or if you prompt callers for
only an extension or mailbox, select the Mailbox option.

Select the Extension option if you have PathFinder running as a
simple Auto-Attendant setup.
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Select the Run Module option if you are running a custom module,
such as IVR.

Choosing Command File allows you to control the call more directly,
through the use of a script, or through special functions of the PBX.
This option requires some programming. Refer to Appendix A for
more information.



6 Lists and Reports

The MAINT application allows you to configure PathFinder. This
chapter describes the system lists functions available through the
Edit menu in MAINT. One of the easiest ways to send a single
message to many different mailboxes is through a system
distribution list. PathFinder supports two types of distribution lists:

System lists: Set up by the System Administrator; discussed in
this chapter

Personal lists: Set up by individual users; discussed in the
PathFinder User’s Manual

As an example, a system distribution list could be created for the Sales
department. The Sales Manager (or any other PathFinder subscriber) could
use this system distribution list to send one message that would be
received simultaneously by each Sales employee in the list.
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Distribution Lists

System distribution lists have the following characteristics:

The number of lists that can be created is limited only by disk space.

System lists do not need to be “front-ended” by a mailbox.

System lists can be maintained using MAINT or over the telephone.

System lists can contain up to 200 entries. An entry may be a mailbox
number or another list number, allowing you to chain lists together.

System lists allow users to route messages simultaneously to groups of
mailboxes. In addition to mailbox numbers, system lists can contain other
list numbers, making it possible to create unlimited distribution lists.

Creating a System List
To create a system distribution list:

1. Select System Lists from the Edit menu.

Figure 6-1: Edit > System Lists
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The following window displays
:

Figure 6-2: System Lists Window

2. Click on Create List to display the following window:

Figure 6-3: Create a System List Window
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3. Assign a number for the list and type a description to describe the
list’s purpose. Click on Create to return to the System Lists window.

4. In the System Lists window, highlight the name of the list you are
creating, then click Edit to display the following window:

Figure 6-4: Edit System List Window

5. You have created a system list. You can edit your new system
distribution list to add mailbox numbers, list numbers, and other
numbers.

Do not enter a number that is also used as a mailbox number. Doing
so will cause any message intended for the distribution list to be
sent instead to the mailbox.
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Editing a System List
To edit a system distribution list by adding or deleting mailbox users or
system list numbers, perform the following steps.

1. From the main MAINT window, select Edit > System Lists from the
menu bar.

2. Select the system list that you need to edit, then click Edit.

3. For each mailbox user you want to add, select the mailbox user from
the Mailbox pull-down menu and click on Add Mailbox. Repeat this
process for each mailbox user you want to add.

4. For each previously-created system distribution list you want to add,
select the from the system distribution list from the Other Lists pull-
down menu and click on Add List. Repeat this process for each
system distribution list you want to add.

5. To delete a user from the list, highlight that user in the list members
pane at the top of the window, then click on Delete Member.

6. When you are finished editing the distribution list, click on Done.

Deleting a System List
To delete a system list, perform the following steps.

1. From the main MAINT window, select Edit > System Lists from the
menu bar.

2. Highlight the list to be deleted.

3. Click Delete List.

4. When prompted to confirm the deletion, click OK.

You must first create a list before you can edit it. Refer to “Creating
a System List” on page 6-3 for more information.
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System Reports

Reports Overview
The MAINT application allows you to configure PathFinder. The following
sections describe the Reports menu in MAINT, which includes options
related to the following:

PathFinder activity

Reports settings

PathFinder directory

PathFinder logs

Messages

Greetings & Signatures

Customized reports

Reporting setup

PathFinder provides you with the ability to generate a variety of reports
for diagnostic and information purposes. Reports can help diagnose
problems, allocate resources, and improve PathFinder’s efficiency. This
chapter discusses the various reports that can be output by PathFinder
and how best to utilize them.

Reports Criteria
Reports criteria are used to select specific data when generating a report.
To generate any of the PathFinder reports, select the report type from the
Reports menu. A window displays in which you select the criteria
appropriate to the particular report. The active fields available for
selection criteria depend upon the report being generated.
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Dialog Box Options

Date
Enter the complete start and stop dates, which must be in MM/DD/YY
format (e.g., for November 21, 2001, enter 11/21/01). If the date fields are
left blank, Maint selects all records with any date.

Time
Enter the complete start and stop times in 24-hour format (HH:MM:SS). If
left blank, Maint selects all records with any time.

Mail Box, Extension, Menu, COS, or Time Control
Use the dropdown lists to select the appropriate first and last items for
selection criteria.

Name, Fax Documents, or Look For
Enter the appropriate selection criteria range for the report you want to
generate.

Dialog Box Considerations
All reports are viewed with Notepad. If you wish to print or save a
report, use Notepad to do this.

In the Settings reports, if no data are available for a particular field,
that field is not shown in the report. For example: If the Department
field is blank, no Department field appears in the report.

When entering selection criteria for a report, PathFinder remembers
the last criteria entered in any report and offers that as a default
selection. For example, if you run a mailbox settings report, the
mailbox range used in that report appears when you run a different
report with a mailbox range criterion.

The windows shown in the Reports chapter are intended to illustrate
report structures, and may not reflect actual information or data.
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Setup Reporting
The Setup Reporting item in the Reports menu is used to select the lines
you want printed per page, header options, and the speed at which
reports are generated. The Report viewer field allows you to indicate what
application is used to display reports.

Figure 6-5: Setup Report Generation Window

For the Generation speed setting, select one of the following options:

Select Normal if MAINT is running on the same computer as the
PathFinder engine.

Select Fast if MAINT is running on a separate computer.

Select Custom and enter a value only if instructed to do so by Vodavi
Technical Support.

By default, the Notepad application is used to view reports. If you want to
use a different viewer, specify it in the Report viewer field, along with the
complete path.
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Activity Reports

The MAINT application allows you to configure PathFinder. This chapter
describes the Activity reports functions available through the Reports
menu in MAINT.

Activity reports reflect PathFinder use. Data for the reports are obtained
from the PathFinder system logs.

Usage
The Usage report displays call traffic information.

Figure 6-6: Usage Report Example

Data
The data are sorted by date and time (hour) and display the total number
of calls (inbound and outbound) as well as the combined duration of all
calls.



Activity Reports 6-11
Use
This report demonstrates when PathFinder is the most and least active. Its
uses include:

Determining staffing requirements

Determining volume of after-hours calls

Mailbox Usage
The Mailbox Usage report provides the log lines related to mailbox
activity. The report, sorted by date, tracks each time the mailbox was
accessed, the length of the message left, and the number of times that
the owner accessed the mailbox.

Figure 6-7: Mailbox Usage Report Example
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Data
The report, sorted by date, tracks the number of occurrences (counts)
and total durations for several mailbox statistics for each mailbox,
including the following:

Use
A review of the Mailbox Usage report reveals the amount of activity of
each mailbox on PathFinder. Owners of mailboxes with low activity may
not fully understand how to use PathFinder and may need more
instruction. On the other hand, when disk space is in short supply, users
with high activity should be reminded to remove messages.

Take note of the average length of a call. When the average length
approaches the maximum message length, the max message length may
need to be increased.

This report can also be used in client bill-back situations (like shared
tenant environments) executive suites, or hotels. The report can be
output to disk, then imported into a billing program.

Mailbox number and
name of mailbox owner

Message Length (elapsed
time of recording)

Line call came in on Number of messages
recorded (Msg Left)

Time of mailbox entry Out-dial/Notification
events

Number of messages
retrieved (MAINT)

Total Trunk Access

Duration between the caller's initial connection to PathFinder
and subsequent hang-up after leaving a message or time
required for mailbox owner to retrieve messages
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Extension Usage
The Extension Usage report identifies inbound call activity to a specific
extension.

Figure 6-8: Extension Usage Report Example

Data

The report, sorted by date, documents inbound calls and their results.
The report documents the time that the call was made as well as its
duration. Duration is defined as the elapsed time between the initial
connection and the subsequent hang-up from PathFinder. In addition,
the report documents specific call activity.
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Possible data includes:

Answered -- Call was answered

No Answer -- Extension did not answer

Busy -- Extension was busy

Connect -- Call was connected

No Ring Back -- Extension did not respond

Blind Transfer -- Call transfer type

The Extension Usage report describes the results of a call transfer
initiated by PathFinder. The call can either be connected or dropped. A
dropped call (either a busy or unanswered extension) may route to a
mailbox, operator, or menu.

Use

A review of the Extension Usage report can help with the following:

Scheduling agents or operators more effectively

Determining a need for additional phone lines

Identifying subscribers who miss a large number of calls

Menu Activity
The Menu Activity report identifies user traffic within menus, indicating
what information callers are most interested in by the number of times
specific menus are accessed.

This can help determine a menu’s usefulness and whether the number of
channels that allow access to it are sufficient to support the traffic.
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Figure 6-9: Menu Activity Report Example

Data
The Menu Activity report documents the following:

Date: The selected reporting period

Menu: The selected menu that is the subject of the report

Time: Time of day that the menu was accessed

Key Pressed: The caller's key selection while in the menu

Use

This information may be useful to others besides the system
administrator. For example, with the following menu: “Press 1 for
information on product X; press 2 for information on product Y . . . ”, the
sales manager may be interested in the number of requests for each
option. The Menu Activity report includes the total number of requests
for each menu key.
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Fax Documents
If your PathFinder implementation has the optional fax support module
installed and you have created a Fax-On-Demand application, you may
have discovered how confusing it can be keeping track of the fax
documents. The Fax Documents report handles this chore for you.

Figure 6-10: Fax Documents Report Example
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Data
The Fax Documents report provides the following information:

List of all fax documents on PathFinder

Date each was created

Time each was created

File size

Use

This information can be used by the system administrator to keep track of
all fax documents currently on PathFinder. This can be helpful in
maintaining a Fax-On-Demand application.

Notification Usage
The Notification Usage report indicates the number of times a mailbox
was notified.

Figure 6-11: Notification Usage Report Example
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Data
The Notification Activity report provides the following information:

Date -- The selected reporting period

Mailbox -- The selected mailbox for the report

Time -- Time of day that the notification was executed

Attempt -- Attempt number of notification

Line -- Line number where the notification went out

Use
This information can be used to determine if notifications are being
executed in a timely fashion.

Setting Reports

The MAINT application allows you to configure PathFinder. This section
describes the Settings reports functions available through the Reports
menu in MAINT.

Settings reports identify various PathFinder settings that were entered
during configuration. Information is available for mailboxes, extensions,
and menus.
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Mailbox Settings Summary
The Mailbox Settings Summary report summarizes the configuration of
each mailbox in PathFinder.

Figure 6-12: Mailbox Settings Summary Report Example

Data
This report presents, for each mailbox, the following data:

Mailbox number

Associated extension number

Mailbox owner's name

Mailbox state

Use

This information can be used to keep track of all mailboxes on PathFinder.
This can be helpful in maintaining mailboxes in a dynamic work
environment.
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Mailbox Settings Detail
The Mailbox Settings Detail report provides an in-depth review of the
configuration of each mailbox in PathFinder.

Figure 6-13: Mailbox Settings Detail Report Example

Data
This report provides the following data:

Mailbox number

Associated extension number

Mailbox owner's name

Mailbox state

Class of service for which the mailbox is a member

Group (Department)

Notification state
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Use
This information is helpful in resolving problems with mailboxes.

Extension Settings Summary
The Extension Settings Summary report summarizes the configuration of
each extension in PathFinder.

Figure 6-14: Extension Settings Summary Report Example

Data

Each extension is defined by the following:

Extension owner

Associated mailbox number

User name

Transfer options

Action options
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Use
This information is helpful in resolving problems with extensions, such as
transfer and forwarding problems.

Extension Settings Detail
The Extension Settings Detail report provides more detailed information
about each extension in PathFinder.

Data

In addition to the information contained in the Extension Settings
Summary report, the Extension Settings Detail report provides the class of
service assigned to the extension.

Figure 6-15: Extension Settings Detail Report Example
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Use
This information is helpful in resolving problems with extensions, such as
transfer and forwarding problems.

Class of Service Settings
You can run a report for details on each defined class of service.

Data
The Class of Service Settings report presents the following information:

The class of service name and description

General settings

Voice mail and Auto-Attendant settings, including notification
settings

Figure 6-16: Class of Service Settings Report Example
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Use
Use the COS report to review and maintain class of service options.

Menu Settings
The Menu Settings report provides a complete description of each menu
and the action programmed for each key.

Figure 6-17: Menu Settings Report Example

Data

The following information is presented for each menu:

Menu name

Key actions: The action assigned to each key on the telephone
keypad (refer to “Key Action Definitions” on page 5-90 for more
information)
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Use
The purpose of this report is to describe all of the menu settings in a
simple and easy format. You can easily determine how the key actions of
your menus are configured.

Time Control Settings
The Time Control Settings report lists options for the selected time
controls.

Figure 6-18: Time Control Settings Report Example
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Data
This report gives information on the following data:

Time Control name

Description

Date

Day

Time

Action

Use
Use this report to review the various time control settings. It can be
helpful in planning new time controls and maintaining those currently on
PathFinder.

Registry Settings Summary
The Registry Settings Summary report identifies the various registry
settings.
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Data
This report provides a system-wide overview of current Registry settings.

Figure 6-19: Registry Settings (Summary) Report Example

Use
This is a comprehensive report that includes all system settings. As such,
it is a powerful troubleshooting and supervisory tool for maintaining
PathFinder.



6-28 Setting Reports
Registry Settings Detail
If you need more information than what is included on the Registry
Settings Summary report, you can run a Registry Settings Detail report.

Data
The Registry Settings Detail report provides the same information as the
Registry Settings Summary report, but also includes an explanation of
each setting, default values, and the type of registry variable.

Figure 6-20: Registry Settings (Detail) Report Example

Use
This is a comprehensive report that not only includes all system settings,
but a description of each. As such, it is a powerful troubleshooting and
supervisory tool for maintaining PathFinder.
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System Distribution Lists
The System Distribution Lists report provides a listing of each system
distribution list used on PathFinder.

Figure 6-21: System Distribution Lists Report Example

Data

The System Distribution List report contains the following data:

List Number

Members’ extension numbers

Members’ names

Use
This is a comprehensive report that lists all current system lists. As such, it
is a powerful evaluation and supervisory tool for maintaining PathFinder.
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Directory Reports

The MAINT application allows you to configure PathFinder. This section
describes the Directory reports function available through the Reports
menu in MAINT.

There is only one directory report. It gives a listing of all subscribers with
their first name, last name, extension number and mailbox number.

Directory Report
Directory reports can be generated for the entire directory, or specific
name ranges can be designated.

Figure 6-22: Directory Report Example
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Data
The Directory report associates subscribers with specific mailboxes and
extensions.

Use
Print this report regularly and reference it for maintenance. The Directory
report also can be used to create company telephone lists.

Logs Reports

The MAINT application allows you to configure PathFinder. This section
describes the Logs reports functions available through the Reports menu
in MAINT.

Log reports provide information about PathFinder and error messages.
Logs are used as diagnostic tools to trace PathFinder activity, and are
primarily used for debugging and technical support functions.

For more information on Log Files, refer to page 5-6.
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Daily Log
The Daily Log report provides a detailed listing of general PathFinder
activity.

Figure 6-23: Daily Log Report Example

Data
All entries are listed by time of occurrence and by line number.

Use
Review this report to check on daily PathFinder activity. This report
should not be confused with the Error Log. There are instances, however,
when both are used together for diagnostic purposes.
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Maintenance Log
The Maintenance Log report tracks all activity within MAINT.

Figure 6-24: Maintenance Log Report Example

Data
Any time a report is run, a mailbox is created, or a menu is modified, a line
is added to the Maintenance log.

Use

Review this report to see what changes have been made in MAINT. Each
line of the report lists a specific action or activity initiated during a MAINT
session. This can be used to track system administration functions and to
verify who is accessing MAINT and what they are doing. This can be very
helpful in troubleshooting PathFinder problems.
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Error Log
The Error Log report lists any error messages resulting from the operation
of PathFinder.

Figure 6-25: Error/System Log Report Example

Data

Both hardware and software malfunctions are reported.

Use

Review this report to check on errors in PathFinder activity. Each line of
the report specifies a specific error condition that has occurred. Each
error condition is listed by time of occurrence.
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Messages Reports

The MAINT application allows you to configure PathFinder. This section
describes the Messages reports functions available through the Reports
menu in MAINT.

Message reports provide the system administrator with a means to
determine the current status of messages in PathFinder mailboxes.

Message Summary
The Message Summary report summarizes various status conditions for
PathFinder mailboxes.

Figure 6-26: Message Summary Report Example
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Data
The following fields are displayed with the message summary report:

Mailbox -- Mailbox owner name and mailbox number

New -- Total number of new messages

Saved -- Total number of saved messages

Time -- Total time for all messages

Disk Space Used -- Total occupied disk space per owner

Use
This report shows the total messages stored on the hard drive for each
mailbox. It can help determine if messages are being stored too long or if
PathFinder resources are being monopolized by any one user.

Message Detail
The Message Detail report allows the system administrator to select a
mailbox and view its current status.

Figure 6-27: Message Detail Report Example
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Data
The following fields are displayed within this report:

Mailbox: Mailbox owner name and mailbox number

New: N for new message

Saved: S for saved message

From Mbx: Mailbox message was sent from

Size: Message size in seconds

Date/Time: Date and time message left

File: File name of the message

Use

This report shows all messages that are stored on the hard drive. It can
help determine if messages are being stored too long or if PathFinder
resources are being monopolized by any user.

Greetings & Signatures

The Greetings & Signatures report allows the system administrator to
determine the total amount of greetings & signatures recorded by
mailbox holders. Each mailbox holder can have multiple greetings or
signatures recorded.

Use

This report is another tool that the system administrator has to analyze
and control proper distribution of PathFinder resources.
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Customized Reports

Customized reports provide flexibility to isolate certain assurances within
the log and provide detail information. For instance, using customized
reporting, the system administrator can report on all “track messages”
log lines and actually display the life of a message as it moves through
the system. In addition, some IVR systems can use customized reporting
to show information about the IVR that is not available through standard
reports.

Use

This report is another tool that the system administrator has to analyze
and control proper distribution of PathFinder resources.



7 Boom Box and Monitor
Applications

The Boom Box application allows you to create and edit voice prompt
files used by PathFinder. This chapter provides an introduction to this
application and details on its installation as well as an introduction to
the prompts that can be created and used in conjunction with the
Boom Box application.
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Boom Box Application

Boom Box can be used on any machine that has either Dialogic® voice
ports configured or a WAV device with speakers and a microphone.

Boom Box is usually used on the same PC where PathFinder is running.
However, Boom Box can be used on another PC that has another Dialogic
voice port or a WAV device, and then the prompt file(s) can be copied to
PathFinder.

Boom Box can work on the following:

Standalone single prompt files (VOX), or

Multiple voice prompts combined into one voice prompt file (VOX)
with a matching index file (VDX).

The VOX files used by PathFinder are in the Dialogic 8-bit ADPCM format
at 24khz. Boom Box can produce these same ADPCM files and can also
produce WAV files.

Requirements
Boom Box requires the following:

Windows NT® 4.0 (Service Pack 4)

A Dialogic card, or a WAV device with microphone and speakers

Installation
Boom Box is automatically installed when running the install PathFinder
software.

After installing your PathFinder software, you can access the Boom Box
application by selecting from the Start menu the following path:
Programs > PathFinder Voice Processing > Boom Box.



7-2 Boom Box Application
Boom Box’s main window is shown below:

Figure 7-1: Boom Box Main Window

Menu Bar Options
The Boom Box application has four menus available in the menu bar.

File

Voice Port

Convert

Help

File Menu

The File menu allows you to create, access, and save Boom Box files as
well as exit the Boom Box application.

It is recommended that the PathFinder voice engine be shut down to
record voice prompts using Boom Box. If you would like to record prompt
files while the PathFinder engine is running, use the Record Prompts
option on a menu. Refer to “Menu Settings” on page 5-83 for more
information.
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File > New
The File > New option allows you to create either indexed or non-indexed
prompt files. If you create a new indexed file, you can only create VOX file
types.

File > Open
The File > Open option allows you to open prompt files. It does not
matter if the files are indexed or not-- Boom Box determines that for you.

File > Save
This option saves the current prompt file that you are working on.

File > Save As
This option saves the current file you are working on as another file.

Voice Port Menu
The Voice Port menu allows you to manipulate lines and ports.

Voice Port > Answer
With this option, call into the phone lines and select the extension you
want to reach. Then select Answer to answer the phone.

Voice Port > Disconnect
This option disconnects the phone line.

You cannot change a non-indexed prompt file into an indexed prompt
file.

The File > Save As option cannot save VOX files as WAV files or WAV files
as VOX files.

The Voice Port menu can only be used when you’re playing VOX files. It
is used only through the Dialogic voice port device, not through the WAV
device.
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Voice Port > Change Port
This allows you to set the port (phone line) that you want Boom Box to
answer.

The Set Port window is shown below:

Figure 7-2: Set Port Window

Convert Menu
The Convert menu allows you to convert WAV files to VOX files. The
Convert menu can only be accessed when you have a WAV file open.

Help Menu

The Help menu allows you to access the Help files for Boom Box. These
files can be accessed at any time.

Do not set the port to a port being used by PathFinder while
PathFinder is running.
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Buttons
The following buttons can be accessed from the main Boom Box window:

Edit Options
Clicking the Edit button from the main Boom Box window allows you to
edit any type of prompt.

Figure 7-3: Boom Box Edit Window

Table 7-1: Boom Box Window Buttons

Button Description

Play Plays the current file (non-indexed) or prompt (indexed).

Record Records the current file (non-indexed) or prompt (indexed).

Stop Stops playing or recording.

Edit Clicking the Edit button allows you to edit any type of
prompt. Refer to “Edit Options” on page 7-5 for more
information on these options.

Disconnect Disconnects the phone line. This is only available if working
with a VOX file.

Add Prompt Clicking the Add Prompt button allows you to add a prompt.
Refer to “Add Prompt” on page 7-7 for more information on
this option.
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Edit Functions Buttons
The following buttons are available in the edit functions area in the Edit
window.

Table 7-2: Edit Functions Buttons

Button Definition

Play Plays the current file (non-indexed) or prompt (indexed).

Stop Stops recording or playing.

Record Records the current file (non-indexed) or prompt (indexed).

Undo Undoes most of the changes made to the current file or
prompt. If you make a change that cannot be undone, a
prompt displays saying that you cannot undo this change
unless you do not save.

Play Beginning Plays the first (x) seconds of current file (non-indexed) or
prompt (indexed), where (x) is the number in the text box.

Play Ending Plays the last (x) seconds of current file (non-indexed) or
prompt (indexed), where (x) is the number in the text box.

Cut Beginning Cuts the first (x) seconds of current file (non-indexed) or
prompt (indexed), where (x) is the number in the text box.

Cut End Cuts the last (x) seconds of current file (non-indexed) or
prompt (indexed), where (x) is the number in the text box.

The Step Size field at the top left of the screen determines the number of
seconds of the file or prompt to play or cut from the beginning or end. You
can set the step size to larger or smaller values depending on how much
you need to play or cut from the prompt.
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File Functions Buttons
The following buttons are available in the file functions area in the Edit
window.

Add Prompt
Clicking the Add Prompt button from the main Boom Box window allows
you to add a new prompt to the current file.This option is only visible if
working on an indexed prompt. The Add Prompt window is shown below:

Figure 7-4: Add Prompt Window

Table 7-3: File Functions Buttons

Button Definition

Append This appends a non-indexed prompt file to the current file or
prompt.

Write This writes the current prompt to a non-indexed prompt file.
This does not save the currently opened file.

Read This reads in a non-indexed prompt file on top of the current
file or prompt.

Delete This option deletes a prompt from an indexed file.

Save This saves the changes made to the current file or prompt.

Exit Exits the Edit window and returns you to the main Boom Box
window.
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File Information
At the bottom of the main menu is the file information pane. Please note
that you do not type or otherwise enter this information; instead, it
automatically displays based on specific information relevant to your file.
The five File Information fields are as follows.

Name -- The name of the file you are working on.

Type -- Either indexed or non-indexed.

Format -- Either ADPCM for VOX file type or WAV for WAV file type.

Device Type -- Specifies how the file is played or recorded. There are
two options:

A sound card if you open a WAV file, or

A Dialogic card if you open a VOX file.

Device Status -- Specifies whether you can play or record (or edit). If
this is green, you can play, record, or edit. If it is red, you cannot play,
record, or edit. This is green when you answer (VOX) or when you
have a sound card. It is red when you first open the VOX file or when
you disconnect it.

Troubleshooting
You can carry out Dialogic-based or WAV-based Boom Box
troubleshooting.

Dialogic-based Troubleshooting:
Make sure that the Dialogic voice board is installed correctly.

Be sure that the Dialogic voice drivers are correctly configured and
started.

Make sure the phone extension (or phone through extension
simulator) is connected to a voice port. Please note that you cannot
plug a phone directly into a dialogic port.

Make sure Boom Box is configured to use the correct voice port
phone extension connected to.
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Make sure Boom Box is not using a voice port already in use by
PathFinder or other Dialogic-based application.

WAV-based Troubleshooting:
Be sure that the WAV device is installed correctly.

Be sure the speakers are connected correctly, turned on, and are loud
enough.

Make sure the microphone is installed correctly.

Make sure the microphone gain (sensitivity) is not set too soft or too loud
(often an optional setting).

Boom Box System Prompts
The Boom Box application allows you to create and edit voice prompt files
used by the PathFinder voice processing system. In this section, the
system prompts that are used with the Boom Box application are
discussed in detail.

System Prompts
PathFinder uses a group of pre-recorded messages and phrases called
voice prompts to communicate with callers. PathFinder constructs
understandable messages by selecting different prompts and playing
them together as a single message. PathFinder uses two types of
prompts, Indexed and Non-Indexed. Indexed prompts are located in a
single indexed file that contains many prompts. Non-Indexed prompts
only contain one prompt per file.

All files are stored in the C:\HELLONT\VOX directory unless otherwise
noted.

Indexed vs. Non-Indexed Prompts
Non-Indexed prompt files are of type VOX only. Indexed prompts can be
either VOX or VDX file pairs.
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Non-Indexed Prompts
Many prompts used by the standard PathFinder modules, as well as many
used by custom IVR modules, are simple non-indexed prompt files. This
means there is only one prompt recorded in each VOX file, and there is no
index associated with that VOX file. To play the prompt, PathFinder
simply plays the entire file.

Non-indexed prompts are good for applications in which there are just a
few prompts, or in which these prompts may need to be re-recorded
while PathFinder is in use.

Indexed Prompts

Many prompts used by the standard PathFinder modules, as well as some
used by custom IVR modules, are stored in indexed prompt files
(matching VOX and VDX files). This means there are one or more
individual prompts recordings in the VOX file, with named segments in
the VDX index file that indicate where each prompt begins and how long
it is. To play an indexed prompt segment, PathFinder looks up the
segment name in the VDX file to get the start location and length, and
plays just that portion of the prompt from the VOX file.

Indexed prompt files are good for applications in which there are a large
number of prompts and it helps organization on the disk to keep them all
together in two files instead of in many. They are also beneficial when the
prompts are not going to need to be re-recorded while PathFinder is in
use.

Non-Indexed Prompts
The list below outlines the customizable (non-indexed) prompts that are
used in PathFinder. All prompts should be located in the VOX directory.
You can create a blank prompt (with 1 byte of data) to suppress certain
prompts. But more commonly, you would record new information to
replace the default prompt.
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Replacement Prompts
All prompts below can be recorded using Boom Box.

Table 7-4: Non-Indexed (Customizable) Prompts

File Name Description
Replaces

Indexed File . . .
Sample(s)

VOPGPRE.VOX Preamble prompt
that plays in front
of a numeric page

H!VO0.VOX:
VoPagePreamble

“Page message is . . .”
“You have a message to call . . .”

FXDMND1.VOX Prompt played
before FxInstruct1
or FXDMND2.VOX
that can be used to
give the caller more
information

N/A “You have reached the Vodavi
fax-on-demand line. Please note
that document 411 is a catalog
of available fax documents.”

FXDMND2.VOX Tells callers how
many fax prompts
they can select

H!FAX0.VOX:
FxInstruct1 and
FxInstruct2

“You will be prompted to select
which documents should be
faxed. You may select up toX
fax documents.”

VMINSTR.VOX Voice mail
instructions
prompt

H!XX0.VOX:
VmInstructions

“Enter the mailbox number of
the person you are trying to
reach. Press zero for the
operator. Press the star key for
the directory.”

VMSYSGRT.VOX First system
greeting. Played if
selected in COS

H!XX0.VOX:
VmSysGreeting

“The person you have tried to
reach is not available. Please
leave a message after the tone.”

VMSYSGR2.VOX Second system
greeting. Played if
selected in COS

H!XX0.VOX:
VmSysGreeting2

“Begin speaking at the tone.
When you are finished
recording you may hang-up or
press any key for more options.”

VMRECKEY.VOX Asks caller to press
a key to start
recording

H!XX0.VOX:
VmRec Key

“Press one to start recording.”

VMRECOPT.VOX Record option
prompt

H!XX0.VOX:
VmRecordOption

“To send message, press one; to
play, press two; to cancel, press
three.”

<COS>.PBG Numeric message
begin prompt.
Played when
mailbox is set to
take numeric
messages

N/A beep-beep-beep
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<COS>.PDN “Numeric message
done” prompt.
Prompt played after
the caller enters the
numeric page

N/A Busy signal or some type of
completion tone

<COS>.GRT COS Greeting.
Played if COS is set
to play the COS
greeting

N/A “You have reached the sales
department. Please leave a
message after the tone.”

<COS>.VI1 COS Voice Insert -
played before
mailbox name

N/A “You have reached the voice
mailbox of . . . ”

<COS>.VI2 COS Voice Insert -
played after
mailbox name

N/A “ . . . Please leave a message
after the tone.”

<COS>.LOP COS Last options H!XX0.VOX:
VmLastOptions

 “Press one to reach another
mailbox. Press nine to
disconnect.”

DIRGETDI.VOX Prompt asking for
lookup digits in
directory

H!XX0.VOX:
DirGetDigits

“Enter the first four characters
of the person's last name. For Q
press seven. For Z press nine.”

AAINSTR.VOX Auto-Attendant
instructions

H!XX0.VOX:
AaInstructions

“Enter the extension number of
the person you are trying to
reach. For the company
directory press the star key. To
reach an operator, press zero.”

AAHVCALL.VOX Prompt
announcing that an
extension has a call

H!XX0.VOX:
AaHaveCall

“You have a call.”

AAHOLD.0 to
AAHOLD.999

Hold files played
when the system
needs to put a
caller on hold and
the COS says use
hold files

N/A AAHOLD.0: “Please hold. We
appreciate your patience . . . ”
AAHOLD.1: “Please continue to
hold . . . ”

AACALLFO.VOX Announces that the
extension has a call
for a particular
extension

H!XX0.VOX:
AaCallFor

“Call for . . .”

Table 7-4: Non-Indexed (Customizable) Prompts (Continued)

File Name Description
Replaces

Indexed File . . .
Sample(s)
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PathFinder Monitor Application

The PathFinder application is run and monitored via a Monitor application
window. This chapter discusses the PathFinder Monitor application, its
available options, and its operation.

The PathFinder Monitor application is designed to allow the
Administrator to view PathFinder status and settings. Monitor also allows
you to connect to local (on the same machine) engines and remote
engines via TCP/IP connections.

The Engine is PathFinder’s workhorse. The MAINT application defines
how the engine operates; the engine receives the incoming telephone
calls and performs the actions defined in the MAINT application.

Startup & Orientation
After installing PathFinder, run the Monitor application to start the voice
processing engine. By default, Monitor connects to the local voice
processing engine.

Running the Monitor Application
Start up the Monitor application by selecting from the Start menu
Programs > PathFinder Voice Processing > PathFinder.

AASCNASK.VOX Prompt asking
callers to say their
names

H!XX0.VOX:
AaScreenAsk

“Whom may I say is calling?”

AAXFRMSG.VOX Prompt telling
callers you are
going to be
transferred

H!XX0.VOX:
AaTransfer1 and
AaTransfer2

“Please hold while I transfer you
to . . . ”

Table 7-4: Non-Indexed (Customizable) Prompts (Continued)

File Name Description
Replaces

Indexed File . . .
Sample(s)
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Once PathFinder is selected, a window similar to the following is
displayed:

Figure 7-5: Monitor Application Window

Configure Host Information
To configure the host information, select from these options.

Server

Configure Server information in the following window:

Add / Edit / Remove Server

Connect / Disconnect

Start Server
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Stop Server

- Immediately

- Stop Each Line When Idle

- When All Lines Are Idle

- Cancel Shutdown

- Don’t Wait for Terminations

Monitor Display Windows

Blockage (Groups)
Displays the number and total time a blockage occurred on the system.
Refer to “Setting Up Phone Lines” on page 5-102 for more information.

This window displays duration and counts for system blocks:

Figure 7-6: Monitor [Blockage Groups] Window
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Counters (Event)
The Event Counters window allows you to view PathFinder event counters.
Refer to “Event Counters” on page 5-60 for more information.

Figure 7-7: Monitor [Event Counters] Window
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Line View (Status)
This window allows you to view the real time status of your inbound
lines. Auxiliary lines are also displayed. Double-click on (or right-click for a
menu) any of the line icons to view details for that line.

Figure 7-8: Monitor [Line View] Window

You can also restart a line via the line detail (or via the right mouse-click
menu).

Displays totals for inbound calls. You can view today’s totals as well as
totals for the entire application.
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8888 Back-Ups / Logs / Errors
/ and Troubleshooting

This chapter contains the information needed to help you maintain
the PathFinder system by providing: a system back-up procedure,
statistical logs, and answers to the most common system problems.
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Backing Up PathFinder

PathFinder allows you to back up important files in case of a catastrophe.

Backups can be very important and we recommend backing up often.
There are several ways that PathFinder can be backed up.

Table 8-1: PathFinder Backup Methods

Method Description

Network
If the network is backed up periodically and PathFinder is a node
on the network, then network backups are sufficient. Consult your
network administrator for more information.

Tape
If there is a tape drive on the PathFinder PC, Windows NT supports
periodic automatic backups of PathFinder. Consult your Windows
NT manual on how to perform tape backups.

Manual

PathFinder can be backed up when there is a change made to
PathFinder in order to protect the data. Typically, these backups
are performed manually and are described below. You can
manually back up PathFinder at three levels.

Level One -- To back up all of the vital programming of PathFinder.
Back up the \HELLONT\DBASE directory by the method best suited to
your application. Be certain to back up all subdirectories under these
main directories.
Level Two --Includes the first level, and subscriber greetings, menu
greetings and other static voice prompts. Back up the
\HELLONT\DBASE, \HELLONT\VOX, HELLONT\MESSAGES\*.SIG, and
HELLONT\MESSAGES \*.GR? directories by the method best suited to
your application. Be certain to back up all subdirectories under these
main directories.
Level Three --Contains the first and second levels, and all mailbox
messages. This is a complete backup of PathFinder, and depending
on the number of messages on PathFinder, it could involve a large
amount of data. Back up the \HELLONT\DBASE, \HELLONT\VOX, and
HELLONT\MESSAGES\*.*. Be certain to back up all subdirectories
under these main directories.
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Log Files & Error Messages

PathFinder outputs three types of logs:

System Error

Maintenance Access

Daily System Activity

All log files are in ASCII text format, which allows them to be printed or
viewed with a simple text editor, like Notepad or Write.

System Error Log
The PathFinder Error log is directed to a file named ERROR.LOG. The Error
log file is stored in the \HELLONT\LOGS directory. The Error log file
contains general PathFinder information. The Error log file is a cumulative
file. Once PathFinder is initialized the Error log file is written. Each time
PathFinder is reset or there is a general problem, the new log information
is appended to the existing Error log file.

Each line in the Error log file contains four fields, as follows:

Table 8-2: System Activity Log Fields

Field Indicates …

First what type of log line is listed. The column contains an
alpha character.

Second the date the Error log line was generated.

Third the time the Error log was generated in a
hh:mm:ss.ttt format.

Fourth the error condition (text varies in length).
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Several lines that appear in the Error log do not indicate errors. These
lines are similar to the following:

Figure 8-1: Error Log Example

The first ten lines indicate that the voice-processing engine was started
correctly. The last three lines indicate that the voice-processing engine
was terminated correctly. This is just a sample; your situation may be
different.

System Maintenance Log
The maintenance log is made up of separate files. Each day that the
MAINT application is accessed, it generates a separate file. The files are
stored in the \HELLONT\LOGS directory. The name of the file is
MTyymmdd.LOG, where yy is the year, mm is the month, and dd is the
day. For example, the log for May 7, 1999 would be named
MT990507.LOG.

The maintenance log file can keep track of unauthorized user access to
MAINT. Each time MAINT is accessed, it generates log lines indicating
what the maintenance user did. MAINT outputs maintenance activity log
lines similar to those found in the Error log.

B 07/30/98 10:51:03.568 --- Hello! Startup - Version 7.0.192
B 07/30/98 10:51:03.658 --- Logging State is 4
B 07/30/98 10:51:03.788 --- Engine Serial Number: 900680
B 07/30/98 10:51:17.969 --- enabling tcp/ip inbound telnet
B 07/30/98 10:51:17.979 --- tcpip: you are known as esivmail
B 07/30/98 10:51:18.009 --- Fast function trigger rate is 50
B 07/30/98 10:51:18.019 --- Default thread priority 0
B 07/30/98 10:51:18.019 --- Main process priority 0
B 07/30/98 10:51:18.019 --- Main thread priority 2
P 07/30/98 10:51:19.521 --- tcpip:memupdates on
P 07/30/98 10:51:38.358 --- tcpip:memupdates off
P 07/30/98 10:51:39.380 --- tcpip:memupdates off
B 07/30/98 10:51:41.653 --- Hello! Terminating.
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In general, each log line has three fields:

System Activity Log
The System Activity log is made up of separate files. Each day PathFinder
runs, it generates a separate file. The files are stored in the
\HELLONT\LOGS directory. The name of the files is DLyymmdd.log,
where yy is the year, mm is the month, and dd is the day. For example, the
log for May 7, 1999 would be named DL990507.LOG.

The System Activity log is more complicated than the Error log. Every
phone call PathFinder takes generates log lines indicating what the caller
did. PathFinder outputs system activity log lines similar to those found in
the Error log (refer to “System Error Log” on page 8-2).

Table 8-3: System Activity Log Fields

Field Indicates …

First the time the Error log line that was generated.

Second the type of log generated: INFO or DEBUG.
INFO data typically consists of logins, logouts, and
actions on the database.
DEBUG data typically consists of specific actions on
the databases.

Third the message describing why the line was generated.
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In general, each log line has four fields:

Activity Log - Sample #1

Below is an excerpt from a daily log file representing a typical blind
transfer call into PathFinder. The call was generated with default logging
options enabled.

Figure 8-2: Typical Blind Transfer Call Log

Extension 242 is set to forward on busy or no answer to voice mail.

The call was placed into PathFinder and the caller was transferred to
extension 242.

Then, extension 242 either didn't answer or was busy.

Therefore, the call was forwarded to mailbox 1242.

Table 8-4: System Activity Log Fields

Field Indicates …

First the type of log line generated.

Second the time the line was generated, in hh:mm:ss.ttt format.

Third the channel (line) that output of the line. A line number of
three hyphens (---) indicates a system message from
PathFinder.

Fourth the log message which can be very simple or very complex.

C 11:06:56.833 1 Log: Start Call
C 11:06:59.677 1 Log: Menu MAIN9711  11:06:57 Keys 2:AaSTART
C 11:07:00.729 1 Log: AutoA 242 Access
C 11:07:06.537 1 Log: AutoA 242 Blind Bl Connect 242
C 11:07:06.537 1 Log: Stop Call 11:06:56 
C 11:08:35.074 1 Log: Start Call
C 11:08:36.767 1 Log: Menu MAIN9711  11:08:35 Keys 8:Vm
C 11:08:40.252 1 Log: VMail 1242 Take message
C 11:08:41.754 1 Log: Stop Call 11:08:35 
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Activity Log - Sample #2
Below is an excerpt from a daily log file representing a typical supervised
transfer call into PathFinder. The call was generated with default logging
options enabled.

Figure 8-3: Typical Supervised Transfer Call Log

The call was started at 08:19:54.687.

The NITE9608 menu was accessed, and the caller pressed the 2 key
(which is assigned the Extension/Auto-Attendant Start Key).

Then, they entered 60. This is apparent because the caller was
transferred to extension 260.

PathFinder detected a no answer condition.

Because PathFinder received a No Answer condition, the caller was
transferred to mailbox 1260.

The caller recorded a message for 1:41 minutes and then pressed the
# key.

The last line shows that the call ended.

Ca represents the Supervised Transfer option, andHo represents
the Call Holding option when using supervised transfers.

C 08:19:54.687 1 Log: Start Call
C 08:19:59.985 1 Log: Menu NITE9608    08:19:55 Keys 2:AaSTART
C 08:20:00.796 1 Log: AutoA 260 Access
C 08:20:25.201 1 Log: AutoA 260 Call 260 NoAnswer Ca
C 08:20:25.211 1 Log: AutoA 260 To mailbox 1260
C 08:20:36.487 1 Log: VMail 1260 Take message
C 08:22:18.604 1 Log: VMail 1260 Voice 00:01:41 K#
C 08:22:20.186 1 Log: Stop Call 08:19:54 H7
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Debugging
PathFinder can give more or less information depending on the level of
debugging enabled on PathFinder. Refer to “Logging” on page 5-6 for
more information on logging and debugging options. Below is a sample
of the Activity Log - Sample #2, but with all debugging options enabled.

Notice the line at 08:20:05.853. It describes the transfer string sent
to the telephone system in order to transfer the call to extension 260.

(This data is often used by technical support for troubleshooting.)

Figure 8-4: Supervised Transfer Log (w/debugging)

C 08:19:54.687   1 Log: Start Call
C 08:19:55.248   1 H!KERNEL Debug: gRunCode <TcESIMAIN>
C 08:19:55.268   1 H!KERNEL Debug: gRunCode <MnNITE9608>
C 08:19:59.985   1 Log: Menu NITE9608   08:19:55 Keys  2:AaSTART
C 08:19:59.985   1 H!KERNEL Debug: gRunCode <Aa>
C 08:20:00.796   1 Log: AutoA 260 Access
C 08:20:00.796   1 H!AUTOA Debug AutoA 260 Action=<Ca> Data=<260>
C 08:20:00.876   1 H!AUTOA Debug: Before prompt H0 Key?0
E 08:20:05.853   1 dialvox:call: <&,6#260> entered
E 08:20:22.347   1 dialvox:call: <&,6#260> result=8(8:1:0) drvrst=Idle
C 08:20:22.347   1 H!AUTOA  Debug:   Transfer (Call) Result=8
C 08:20:22.357   1 H!AUTOA  Debug:   Connect=[8]: No Answer
C 08:20:22.357   1 H!AUTOA  Debug:   HangUp=0
C 08:20:22.367   1 H!AUTOA  Debug:   HangUp Type=H0
C 08:20:22.367   1 H!AUTOA  Debug:   Processing (Call) Result [8].
C 08:20:22.377   1 H!AUTOA  Debug:   Telephony Type [].
C 08:20:22.377   1 H!AUTOA  Debug:   gFncResult [8].
C 08:20:25.201   1 Log: AutoA 260 Call 260 NoAnswer Ca
C 08:20:25.211   1 Log: AutoA 260 To mailbox 1260
C 08:20:25.211   1 H!KERNEL Debug: gRunCode <Vm1260>
C 08:20:36.487   1 Log: VMail 1260 Take message
E 08:22:18.394   1 dialvox:DialVox/record: 
D:\HELLONT\MESSAGES\0\6\V1260.L01:8302:180 s=300 m=0 result=0 oh=5 sh=5
C 08:22:18.604   1 Log: VMail 1260 Voice 00:01:41 K#
C 08:22:19.044   1 H!KERNEL Debug: gRunCode <Aa>
C 08:22:19.655   1 Log: AutoA 999 does not exist.
C 08:22:20.186   1 Log: Stop  Call 08:19:54 H7
C 08:22:18.644   6 H!KERNEL Debug: wait(0) = 1.
C 08:22:18.644   6 Log: Start Call
C 08:22:18.654   6 Debug: Event Queue (3) <0 1> 
C 08:22:18.664   6 H!KERNEL Debug: get_event(10/06/
1998,08:22:18,MmNmVT1260.NJ9,0)
C 08:22:18.674   6 H!KERNEL Debug: gRunCode <MmNmVT1260.NJ9>
C 08:22:18.704   6 Log: MsgMan Nm VT1260.NJ9
C 08:22:18.744   6 H!DBASE  Debug: Mbx:1260 Set Online <Ft No00-1>.
C 08:22:18.764   6 Log: Stop  Call 08:22:18 
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Multiple Line Calls
There may be several telephone calls active on PathFinder with each line
behaving differently. Below is a log line indicating telephone calls on
lines one, two, and three.

This complete log shows a call placed on line three with several calls
placed before the call on line three was completed.

Figure 8-5: Multiple Line/Call Log

C 09:50:27.474   1 Log: Start Call
C 09:50:34.123   3 Log: Start Call
C 09:50:34.234   2 Log: VMail 1230 Take message
C 09:50:34.274   2 Log: VMail 1230 To operator mailbox 0
C 09:50:34.324   2 Log: VMail 0 To time control OPERATOR
C 09:50:34.364   2 Log: AutoA 00 Access
C 09:50:38.690   3 Log: Menu MAIN9711   09:50:34 Keys  8:Vm
C 09:50:38.690   3 H!KERNEL Debug: gRunCode <Vm>
C 09:50:39.641   1 Log: Menu MAIN9711   09:50:28 Keys  *:Aa
C 09:50:40.252   1 Log: AutoA 160 Access
C 09:50:41.254   2 Log: AutoA 00 Blind Bl Connect 0
C 09:50:41.254   2 Log: Stop  Call 09:49:36 
C 09:50:47.383   1 Log: AutoA 160 Blind Bl Connect 160
C 09:50:47.383   1 Log: Stop  Call 09:50:27 
C 09:50:49.796   3 Log: VMail 1249 To owner
C 09:50:55.815   3 Log: Owner 1249 VN:0 VS:5 PN:0 PS:0 FN:0 FS:0
C 09:51:19.318   1 H!KERNEL Debug: wait(0) = 3.
C 09:51:19.328   1 Log: Start Call
C 09:51:22.723   1 Log: Menu MAIN9711   09:51:19 Keys  2:AaSTART
C 09:51:22.723   1 H!KERNEL Debug: gRunCode <Aa>
C 09:51:22.964   1 Log: AutoA 212 Access
C 09:51:32.838   1 Log: AutoA 212 Blind Bl Connect 212
C 09:51:32.838   1 Log: Stop  Call 09:51:19 
C 09:52:11.303   1 Log: Start Call
C 09:52:22.319   2 Log: Start Call
C 09:52:28.758   2 Log: Menu MAIN9711   09:52:22 Keys  #:Pi #:Pi 9:Hu
C 09:52:28.758   2 Log: Stop  Call 09:52:22 
C 09:52:28.999   3 Log: VMail 1260 To owner
C 09:52:32.894   3 Log: Owner 1260 VN:0 VS:21 PN:0 PS:0 FN:0 FS:0
C 09:52:36.950   1 Log: Menu MAIN9711   09:52:11 Keys  #:Pi #:Pi 9:Hu
C 09:52:36.950   1 Log: Stop  Call 09:52:11 
C 09:52:37.942   2 Log: Start Call
C 09:52:44.391   2 Log: Menu MAIN9711   09:52:38 Keys  #:Pi #:Pi 9:Hu
C 09:52:44.391   2 Log: Stop  Call 09:52:37 
E 09:55:38.201   3 dialvox:DialVox/record: 
D:\HELLONT\MESSAGES\0\6\VI1260.M0C:8302:180 s=300 m=0 result=0 oh=5 sh=5
C 09:55:40.534   3 Log: Stop  Call 09:50:34 
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Menu Logs
The third line of this log shows which menu was picked (Demo), the time
the call was made (10:25:08), which key the caller pressed for options
2, and where the menu forwards (Salesmnu), after menu has finished.

Figure 8-6: Menu Selection Log

No Answer Log
This log simply shows that there was no answer at extension 621 when
the call came through.

Figure 8-7: No Answer Log

Auto-Attendant Logs

General Call Data
This is an example of someone calling extension 624. The extension is
busy as written in the first line. The abbreviations CaScHo stand for (Ca)
Supervised Transfer, (Sc) Screening, and (Ho) Holding.

In other words, the supervised attendant transferred the call; it was then
screened, and put on hold. The second line shows that it was held only
once. The third line shows that the phone system tried the line once
again. The last shows that the phone system sent the caller to mailbox
1624.

Figure 8-8: Auto-Attendant Log (Single Call)

10:25:08 04 Log: Start Call
10:25:08 04 Log: Vmail 1304 Access
10:25:27 04 Log: Menu Demo 10:25:08 Keys 2: MnSALESMNU
10:25:32 04 Log: Stop Call 10:25:08

08:13:07 11 Log: Notify (1) 1621 NoAnswer at 621

09:23:16 05 Log: AutoA 624 Call 624 Busy CaScHo
09:23:25 05 Log: AutoA 624 Hold Holding 1
09:23:46 05 Log: AutoA 624 Call 624 NoAnswer
09:23:46 05 Log: AutoA 624 To mailbox 1624
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Main Menu (No Action) Log
This log shows that the caller reached the MAINMENU and did not do
anything. The menu took the Maximum Silence action which, was to
hang up.

Figure 8-9: Auto-Attendant Log (Main Menu - No Action)

Operator (Blind Transfer) Call Log

This example shows that the caller pressed 0 at the menu and was
transferred to the operator as a blind transfer.

Figure 8-10: Auto-Attendant Log (Operator Call - Blind Transfer)

Voice Mailbox Directory Log

This line shows that the caller pressed V for a directory of voice
mailboxes.

Figure 8-11: Auto-Attendant Log (VM Directory)

14:23:37 01 Log: Stop Call 15:00:55 H2: Max Silence

08:55:21 05 Log: Menu DEMO 08:55:20 Keys 0:0p
08:55:24 05 Log: Menu DEMO Transfer to Operator

11:07:23 04 Log: Directory   Run:Vm
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Troubleshooting

This section gives technical information on how to diagnose problems
that could occur on PathFinder. The information in this section is highly
technical, and unless the procedures are performed as instructed,
PathFinder may fail to operate. A good working knowledge of Windows
NT, DOS, and PC-based systems is essential.

Technique
The most important troubleshooting technique is isolating problems.
Typically, problems fall into four categories:

Problems with the telephone system

Malfunctions in the PC hardware

Problems with the operating system

Problems with PathFinder

Problems with the Telephone System
Problems with the telephone system will cause problems in PathFinder
during call transfers. The best way to determine if the problem is with
PathFinder is to eliminate the possibility that the telephone system is the
problem, as follows:

1. Pull a telephone list from PathFinder and plug it into either an analog
telephone or a test set.

2. Simulate the action PathFinder should take.

3. If the problem remains on the analog telephone, then the problem is
within the telephone system.

4. If the problem is solved by the analog telephone, then the problem
may be within PathFinder.
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Problems with the PC Hardware and/or Operating System
Problems with the PC hardware or operating system manifest themselves
in various ways. Depending on the type of BIOS in the system, hardware
problems may appear at the boot-up level or as an error reported by the
operating system. The Event Viewer, Windows NT Diagnostics, and
Control Panel programs are useful troubleshooting tools within the
Windows NT Operating System.

Problems with PathFinder

Problems with the voice processing software are typically related to time
control configuration, message waiting indicators, message cascading
and supervised transfers. The logs from the voice processing engine are
vital to troubleshooting these types of problems.

Questions & Answers

Q: Each time I try to start the voice processing engine, I get the following
error: “Could not find Streams Environment. Please reload drivers.”

A: The Streams Environment has been installed incorrectly. Refer to
“Install Streams Environment” on page 2-19.

Q: Each time I try to start the voice processing engine, I get the following
error: “TCP/IP Connectivity is not set up correctly on this machine. I am
unable to determine your host name and address. Please install TCP/IP
and related services before using Monitor.”

A: The TCP/IP protocol has not been correctly installed. Refer to
“Configuration” on page 2-26.

Q: Each time I try to start the voice processing engine, I get the following
error: “Could not start Dialogic service: Please reload drivers.”
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A: The Dialogic® Board configuration software has not been run or has
not been installed properly. Consult the Event Viewer in the
Administrative Tools program group to give more information on the
error. Please correctly configure your Dialogic board. Refer to “Install and
Configure Hardware” on page 2-5.

Q: Message Waiting Indicators are not lighting on my system. What is
wrong?

A: There could be several problems. Follow these steps when
troubleshooting MWI problems:

Verify that you can set and clear message waiting indicators from an
analog telephone set.

Verify the MWI settings are correct. Access the MAINT application.
Select from the menu bar Configuration > Telephony Settings > MWI/
Notification. Verify the Message Waiting Set and Clear settings are
accurate for your telephone system. Verify that the correct Number
Length is defined in the Number Length to Edit selection box is
chosen.

Verify that the E in @Ext is capitalized in the Message Waiting Set
and Clear settings.

Verify that there is no setting in the Class of Service > Notification >
MWI Strings On and Off.

Verify that the Message Waiting setting is not Off.

Verify that there is at least one line (Line Settings) set to service the
Event Group defined in the Class of Service > Notification > Event
Handler Group.

Verify that under Configuration > System Settings > Auxiliary Tasks
there is at least one task defined as MSGMAN that services event
group one.
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Q: Calls are not being routed to extensions properly.

A: First, replace PathFinder with a single line telephone set and verify that
transfers work properly without PathFinder. If you are unable to do hook-
flash transfers with the single line telephone then check all phone system
settings and retry the test.

Verify the entire path by which a call is handled. Typical problems include
incorrect Time Control and Menu settings. Compare your Time Control
and Menu settings with the default Time Control and Menu settings
described in this manual. Use the defaults described in this manual as a
template for configuring your Time Control and Menu settings.

Q: Call transfers are not working correctly.

A: Follow the steps below to troubleshoot call transfers.

1. Verify the transfer is works properly with either a single line
telephone or test set, then attempt the transfer. If the transfer does
not work properly with the single line telephone, verify the telephone
system settings, then retest. If this does not work, the problem is
within the telephone system.

2. Check to make sure that you have the correct prefix settings to
perform a transfer. Select from the menu bar Configuration >
Telephony Settings > Transfer Settings. Make sure the Transfer Prefix
and Transfer Postfix are set correctly. Consult your telephone system
documentation for the correct settings.

3. Check the flash hook length setting is correct. To check this setting,
select from the menu bar Configuration > Telephony Settings >
Transfer Settings. The setting should match what is configured in
your telephone system.

Q: Caller hears DTMF during an attempted transfer.

A: The flash hook setting is probably too short. To check this setting
select Configuration - Telephony Settings - Transfer Settings. The setting
should match what is configured in your telephone system.
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Q: PathFinder seems to answer the call, but then hangs up almost
immediately. What is wrong?

A: Check your time control settings. PathFinder may be approaching the
end of a time control setting. If there is no definition for the current date
and time, PathFinder doesn't know what to do and hangs up.
Additionally, review the logs for Hx settings to determine the type of
hang-up PathFinder is performing.

Q: Supervised transfers are not working on my system.

A: There could be many causes of the problem. See below for possible
solutions:

When you select a telephone system, PathFinder creates a series of
subscribers. The default subscribers are programmed to use blind
transfers. We recommend using blind transfers unless required by the
customer.

PathFinder may require the ring and busy tones to be learned by
PBXpert. Refer to “PBXpert” on page 2-42.

If you are using Supervised Transfers, the extensions using
supervised transfers should not be set to Forward on Busy or No
Answer. Also, any recall times in the telephone system are disabled.

Q: Call Queuing does not work.

A: For call queuing to work, you must use supervised transfers and call
holding must be enabled. Additionally, call queuing must be enabled in
the Class of Service.

Q: PathFinder does not answer calls.

A: There could be many causes of the problem. See below for possible
solutions:

Verify the calls are routed to the voice mail system by substituting an
analog telephone or test set for PathFinder. If the phone does not
ring, check your Hunt Group or Phone system settings.
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If the line is ringing, move the phone line to another voice processing
port. If PathFinder does answer, the problem is likely with the voice
processing board. First run the Universal Dialogic Diagnostics
program found in the Dialogic System Software program group. If
any errors occur, correct the problem and re-test.

Check the Number of rings before system answers incoming calls field in
the Configuration > Telephony Settings > Rings window. It should be
set to a number between one and three. If the number is too high, it
may give the impression that PathFinder is not answering.

If PathFinder occasionally does not answer calls during heavy traffic
periods, it is possible that the hunt group on the telephone system is
not configured correctly. Check all telephone system programming.

Q: PathFinder takes a long time to release the line after a caller has hung
up.

A: PathFinder detects a loop current disconnect by default. The
telephone system you are using may not use loop current disconnects.
Consult your telephone system manual to verify the telephone system
does not use loop current disconnects. If the telephone system does not
support loop current disconnects, PBXpert needs to be run to learn the
tones. Refer to “PBXpert” on page 2-42.

Q: How do I record prompts for the Menus I created?

A: There are two ways to record Menu prompts:

Boom Box: Boom Box allows you to record menu prompts via the
sound card in your computer or via the Dialogic board on PathFinder.

Record Prompts: When Record Prompts is set as a Key Action in a
Menu, this allows access to prompts in that Menu level. Refer to “Key
Action Definitions” on page 5-90.



A Command Files &
Notification Scripts

Command Files are used in PathFinder to expand the basic
capabilities to meet the needs of special notification/paging
systems, phone systems, TIE lines, and special installations.
Command files can be used in many places, such as:

Mailbox notification (refer to “Notification Settings” on page 5-73)

Extension forwarding (refer to “Setting Up Phone Lines” on page 5-102)

Mailbox forwarding (refer to “Setting Up Phone Lines” on page 5-102)

Time controls (refer to “Time Control Settings” on page 5-93)

Directly from a menu (refer to “Editing a Menu” on page 5-87)
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Command Files

A command file is an ASCII text file with one command per line. An ASCII
text file is also known as a plain text file. You can use any editor, including
Microsoft Word, Notepad, or Edit to create a Command File. Be certain
when using any editor to save the file in a “Text Only” format. One
command per line means that each command should be on a single line.

For example, to dial a number and Quit, the file must look like this:

Dial=9,17701234567 

Quit 

When typed as follows, the file does not work:

Dial=9,17701234567 Quit 

Guidelines
Only the commands listed below may be used. Any other lines are
discarded.

If a line starts with the “;” (semicolon) character then the rest of the
line is ignored. For example, the command
;Dial 9,17701234567
is ignored by PathFinder because of the semicolon in the beginning
of the line.

In the list below, items in brackets (< and >) are variables and
represent strings that you must supply. In the Command Descriptions
below we describe what type of variable to use. For example,
Call=<DTMFString> means that the command string uses a
DTMF String to determine what number to call. A DTMF string is a
series of DTMF tones, like pressing keys on a telephone key pad.

Anytime a <Mailbox> or <Extension> appears, leaving it out
causes the command file to use the global mailbox and extension.
Typically, the global mailbox or extension is the last mailbox or
extension accessed by PathFinder.
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Command Descriptions

Table A-1: Command Descriptions

Command / String Action Description

Quit Quits this command
file.

PathFinder then puts the line on-hook and prepare
for another call.
Typically, this is the last line in the file because it
ends the command file. If PathFinder reaches the
end of a command file, a “Quit” command is
implied.
Related Commands: OnHook

OnHook Puts phone on-hook. Typically, this command is used to place the line
On-hook after completing a call.
Caution: In a very active system, this command
could cause PathFinder to answer an incoming call
before PathFinder is ready.
Related Commands: OffHook, Quit

OffHook
[=Delayed]

Takes phone off-hook. If “=Delayed” is specified, then the phone is not
placed off- hook until a dial or call is actually
executed. This is useful when the time between the
OffHook and Dial is too long.
Except for notification, the phone line is typically
already off-hook. Doing a second off-hook does
not affect anything.

Call
=<DtmfString>

Calls the number. Using the Call feature is like using supervised
transfers when transferring an Auto-Attendant call
to an extension. The voice mail system remains on
the line and listen to the Call Result.
This command is not complete until a Connect,
Busy, or NoAnswer is detected.
Note: The “Call” command works in conjunction
with the CallResult command.
Related Commands: CallResult, OffHook, Sleep
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CallResult
<07-12>=<Command...>

Branch on result of a
call; 7=busy, 8=no
answer, 10=connect.

The command in the <Command…> field is
executed if the CallResult<07-12> is true.
You can enter a block of commands to run if a
specific call result is met. For example, you can
have the following commands executed if the
CallResult is a connect:
- CallResult10=DialMailbox
- CallResult10=OnHook
- CallResult10=Quit
If the call is connected then we dial the mailbox
number, go on hook, and quit the file.
NOTE: CallResult does not work when used in
conjunction with the Dial command. You must use
the Call command.
Related Commands: Refer to example below for
additional information.

LogCallResult Logs the results of the
call in the daily log file.

The log line looks similar to this:
Related Commands: CallResult

Dial
=<DtmfString>

Dials the number in
the <DtmfString>.

Using the Dial command is like using blind
transfers in the Auto-Attendant. PathFinder only
dials the number and immediately execute the
next command. It does not listen on the line to
check if the call was connected.
NOTE: The Dial command does not work with the
CallResult command.
Related Commands: Sleep, Dial

Sleep
=<SecondsToSleep>

Pauses for the
specified seconds.

Allows PathFinder to wait for a number of seconds
before performing the next command.
Related Commands: Dial, Call

PlayFirstMessage
=[ New | Save | Kill | Delete ]

Plays the first
message.

Without a parameter, the message is left as a new
message. You may also specify Save, Delete, or Kill
to act on the message.
New leaves the message as new in the mailbox.
Save marks the message as saved in the mailbox.
Use Kill or Delete to remove the message after
playing.
The person receiving the call is not able to
manipulate the message after listening to the
message. In other words, they are not able to save,
delete, or forward the message.
Related Commands: Dial, Call

DoMessageRetrieval
=<Mailbox>

Allows message
retrieval.

Allows the caller to retrieve and manipulate
messages as if they were calling into PathFinder
accessing their voice mail box as an owner.

Table A-1: Command Descriptions (Continued)

Command / String Action Description
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CommandFile
=<NewCommandFile>,
<Path>

Runs another
command file.

The <NewCommandFile> variable is the name of
the alternate command file. The <Path> variable
tells the exact path to find the
<NewCommandFile>. The command typically is
typically called by
CommandFile=CFILES/000.CF,0
The <Path> is a numeric value and matches the
path settings in the Registry.
The command file listed in <NewCommandFile>
executes all commands and terminates It does not
return control to the originating command file.

Say
=<FileName>, <Path>

Says a file. Plays the prompt file listed in <FileName>. The
<Path> variable tells the exact location to find the
<FileName>.

Log
=<LogString>

Logs the string to the
daily log file in the
<LogString>.

The <LogString> variable can be anything you
would like.
The <Path> is a numeric value and matches the
path settings in the Registry.

Status
=<StatusString>

Shows string in status
box.

Status allows you to change the run-time status
associated with a line. This is what you see in
monitor in Windows NT voice mail systems.

Echo
=<On|Off>

Turns Status() on off. Echo toggles command line debugging on & off.

Mailbox
=<Mailbox>

Opens the mailbox
defined in <Mailbox>.

Takes the action defined in <Mailbox>'s actions. If
no mailbox is defined, it uses the global mailbox.

Extension
=<Extension>

Transfers to the
<Extension>.

Takes the action defined in the <Extension>'s
actions. If no extension is defined, it uses the global
extension.

Module
=<ModulesName>,
<glb_parameter>

Runs module in
<ModulesName>.

If the Module requires any parameters use the
<glb_parameter> to define the parameters.

Line <00-32>
=<Command...>

Checks current line. It is a command used to branch based on if the
current channel is “correct”. For example, if you only
wanted to do something on line 5, then you would
use:
Line05=Call=9,7706621503

Table A-1: Command Descriptions (Continued)

Command / String Action Description
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Notify Does notification for
the global mailbox.

This is used to restart notification for the global
mailbox if PathFinder has not extinguished the
notification retries. This is similar to the “Pager Uses
Retries” field in the COS record. Pager Uses Retries
is not active for command file paging. Use the
Notify command to force using retries.

DtmfRead
=<count>, <terminate>,
<time>

Reads DTMFs. PathFinder either waits for these digits or if the
digits are already in the buffer (the caller has
already entered the digits) PathFinder does not
have to wait. The command waits for 3 terminating
conditions: <count> digits are read, one of the
digits specified in the <terminate> parameter is
read or <time> seconds passes.
An example of a command is:
DtmfRead=5, 7, 10
Where PathFinder waits for 5 digits, 7 is the
terminating digit and PathFinder waits 10 seconds.
Related Commands: Dtmf<String>, WriteDtmf

Dtmf <String>
=<Command...>

Reads Branch on
Dtmf…

If the <String> value matches the value received in
DtmfRead, then perform the <Command>.
Dtmf 34567=Dial=7701234567
If PathFinder receives the string “34567” from the
“DtmfRead” command, it dials the DTMF number
“7701234567”.
Related Commands:DtmfRead, WriteDtmf

WriteDtmf
=<FileName>, <path>

Appends Dtmf
contents to file.

Write the DTMF string received in <DtmfRead> to
the <FileName>. The <FileName> is in the <path>.
WriteDtmf=Kelly.txt
Related Commands: DtmfRead, Dtmf<String>

HangUp
=<Command...|Off>

On hangup does
(DtmfRead only).

If you receive a HangUp command while reading
DTMF digits with the “DtmfRead” command, then
perform the command in <Command>.
HangUp=DialMailboxWhere
If Hangup=Off, PathFinder does not look for a
hangup event and continues to wait for DTMF
digits.
Related Commands: DtmfRead

Menu
=<Menu Name>

Runs the Menu… defined in <Menu Name>.

Table A-1: Command Descriptions (Continued)

Command / String Action Description
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DialMailbox Dials global mailbox
and mailbox number.

Using the Dial command is like using blind
transfers in the Auto-Attendant. PathFinder only
dials the global mailbox number and execute the
next command. It does not listen on the line to
check if the call was connected.
Related Commands: Sleep, Dial

CallMailbox Calls the global
mailbox.

Using the Call feature is like using supervised
transfers when transferring an Auto-Attendant call
to an extension. The voice mail system remains on
the line and listen to the Call Result.
Note: The “Call” command works in conjunction
with the CallResult command.
Related Commands: CallResult, OffHook, Sleep

DialExtension Dials global mailbox. Using the Dial command is like using blind
transfers in the Auto-Attendant. PathFinder only
dials the global mailbox number and execute the
next command. It does not listen on the line to
check if the call was connected.
Related Commands: Sleep, Dial

CallExtension Calls the global
extension.

Using the Call feature is like using supervised
transfers when transferring an Auto-Attendant call
to an extension. The voice mail system remains on
the line and listen to the Call Result.
NOTE: The “Call” command works in conjunction
with the CallResult command.
Related Commands: CallResult, OffHook, Sleep

Debug
=<On|Off

Turns CommFile
debugging on and off.

This writes debugging information to the daily log
files.

CallMailboxWhere Calls the number in
the Notification
Number setting of the
global mailbox.

Using the Call feature is like using supervised
transfers when transferring an Auto-Attendant call
to an extension. The voice mail system remains on
the line and listen to the Call Result.
NOTE: The “Call” command works in conjunction
with the CallResult command.
Related Commands: CallResult, OffHook, Sleep

DialMailboxWhere Dials the number in
the Notification
Number setting of the
global mailbox.

Using the Dial command is like using blind
transfers in the Auto-Attendant. PathFinder only
dials the number and executes the next command.
It does not listen on the line to check if the call was
connected.
NOTE: The Dial command does not work with the
CallResult command.

Table A-1: Command Descriptions (Continued)

Command / String Action Description
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DialMailboxBeeperFile

DialPagerFile

Dials the digits found
in the latest page or
message.

Dials the digits left as a pager message in the
mailbox. For example, if you call this command in
the Command File and there was a pager message
in the mailbox, PathFinder would outdial the DTMF
tones left as a pager message.
If no page message is sent, then PathFinder dials
the mailbox number.
Related Commands: PreventMboxAsPage

`<0-6>
=<Command...>

Executes the
<Command..>.
Sunday=0, Monday=1,
…, Saturday=6.

if today's day of week matches
Related Commands: Time

Time<HH:MM>-
<HH:MM>= <Command...>

Executes the
command…

if the current time falls between the times. First
time must be the lowest and you cannot wrap
around to the next day. For example:
- Time10:00-00:30=DialMailboxWhere
- Is not valid. To accomplish the same thing use:
- Time10:00-11:59=DialMailboxWhere
- Time00:00-00:30=DialMailboxWhere

DeliverNewFax
=<Dtmf String>

Delivers new faxes… to the number specified or to the mailbox
Notification Number field if none specified. Always
uses the global mailbox.

CancelPendingNotifies Cancels all pending
notifications for the
global mailbox.

The command deletes all queued notification
requests. It does not modify paging files.

PlayVoicePage Plays the next voice
message file.

Should only be used on voice pagers.
Related Commands: PlayFirstMessage.

DialPrefixForWhereField Dials the dialing prefix
defined in the Registry
based on the length of
the number in the
Notification number
field of the global
mailbox.

For example, the registry contains the variable
“AaDialPrefix07=9,”. The notification number from
the global mailbox has 7 digits. When sending the
DTMF for the Call or Dial commands, we first dial
<AaDialPrefix07>, then the number defined in the
Notification number for the global mailbox. More
specifically, we are sending a notification for
mailbox 1221 with a notification number of
“1234567”. The command file is written as:
- OffHook
- Sleep=1
- DialPrefixForWhereField
- DialMailboxWhere
PathFinder would go off-hook, sleep for 1 second,
dial “9,” and then “1234567”.
Related Commands -- DialMailbox

Table A-1: Command Descriptions (Continued)

Command / String Action Description
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DeleteAllPages Deletes all pager
messages…

associated to the global mailbox.

ProcessNextEvent Processes the next
event for this channel
group.

This is used to speed up the event handling
because the channel does not have to go back to
the wait state. If the next event is a notification
event, then PathFinder can process it much more
quickly than if the command file did a “Quit” and
returned to the main loop. If no events are due for
this channel, then the next instruction in the
command file after “ProcessNextEvent” is executed.

AbortIfNoPages Aborts (Quits) the
command file…

if no paging messages exist.

PreDialDelay=xx

PostDialDelay=xx

Uses the pre and post
dial delays to pause
between taking the
phone off-hook and
dialing.

These statements are only useful if
OffHook=Delayed is also used. Normally, these are
only used when the execution of the command file
is progressing too slowly to use the Sleep=X
command.
Related Commands: OffHook, Sleep

LoadMailboxBeeperFile Loads the next page
message into
memory…

when DialMailboxBeeperFile is called, PathFinder
does not have to hit the disk.
Helps speed up the notification process.
Related Commands -- DialMailboxBeeperFile

PreventMboxAsPage Prevents the mailbox
number from being
sent as a page
message.

If a page message is left in the mailbox and the
pager notification is initiated, you typically would
want the page message sent. If the caller didn't
leave a page message, but left a voice message,
then you can use this command to continue the
execution of the command file.
Related Commands: DialMailboxBeeperFile

RestartIfNewMessage Restarts this
command file (with
the same global
mailbox)…

if new voice messages exist.

DeleteAllNewMessages Deletes all new
messages…

for the global mailbox.

WaitForEvent
=<Seconds>

Waits the specified
number of seconds for
an event.

An event is defined as an incoming call, hangup,
interline message, etc.

Table A-1: Command Descriptions (Continued)

Command / String Action Description
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WaitResultX
=<Command..>

Uses WaitResultX to
break out the
message.

Waits for the result of the event in the
“WaitForEvent” and execute the <Command>
based on the result. The “WaitResultX” has a similar
function to “CallResult”
Related Commands: WaitForEvent

NewMessagesXXX-XXX
=<Command..>

Executes the
command based on
the new message
count.

Indicates different commands to be executed
based on the number of new messages.

DialNewMsgCount
DialSavedMsgCount
DialNewOnlyMsgCount
DailUrgentMsgCount

Dials the DTMF
digits…

representing the New or Saved voice message
counts for the global mailbox.

GlbMailbox
=<mailbox number>

Changes the global
mailbox to a new
mailbox.

Normally, when command files are used to do
mailbox notification (or in paging systems),
GlbMailbox is set to the mailbox number doing the
notify. This command could be used to change the
global mailbox. This is common for cascaded
pagers.

PlayMailboxGreeting Plays the Standard
mailbox greeting…

for the global mailbox.

DebugOff Turns CommFile
debugging on and off.

This writes debugging information to the daily log
files.

AbortIfNoNewVoMsgs Aborts command
file…

if no new messages, or new urgent messages are in
the global mailbox.

MsgSourceOk
=<Command…>

Branch to run
<Command>…

if a new message has been forwarded to your
mailbox.
Related Commands: DialMsgSource

DialMsgSource Dials digits in Msg
Source…

if a message is forwarded to your mailbox, the
Command file sends the originating mailbox
number.

Version Sets a local variable… indicates the version of the Command File.

Table A-1: Command Descriptions (Continued)

Command / String Action Description
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Quick Commands

QuickCommand=<command sequence> 

Quick commands allow you to replace the longer command strings
above with shorter mnemonic described below. Additionally, processing
of the command file is much faster when using mnemonics.

Quick Command Descriptions

Both the Dw, Tw and Dp commands are preloaded so that the
information (page file or the mailbox's Where field) is loaded and the
complete QuickCommand executes very quickly.

Table A-2: Quick Command Descriptions

Command Description

Qu Quit

On OnHook

Of OffHook

Sl Sleep, requires one digit seconds, Sl5 = Sleep=5,Sl5Sl5=Sleep=10

Dw DialMailboxWhere

Dp DialMailboxBeeperFile, dials pager file

Pm PlayFirstMessage, followed with d=Delete, s=Save n=New

Ne ProcessNextEvent

Za Zap (erase) all messages

Ap Abort if no pages

Rp Restart if pages exist

No Notify

Tw Where field is timed. (placed before Dw)

Rn Restart if new messages.
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Example
QuickCommand=OfSl1DwSl3DpSl1OnNeQu is equivalent to:

Even though this is not as quickly, it works.

Combining Commands
You may also combine Quick Commands and regular commands as
follows:

Technical Notes

When creating a command file for pager notification, the timing of the
digits to be sent from the voice mail system to the pager is critical. The
command file must be sychronized with the timing of the pager being
used. When determining the timing of the pager:

1. Call the paging company.

2. Calculate the amount of time from when you dialed the last digit to
the pager company and the time the pager company asks for the
digits to be sent to the pager.

3. Modify the Sleep time to be the time you calculated for the digits to
be sent to the pager.

For further information, contact technical support.

OffHook Sleep=1

Sleep=2 OnHook

DialMailboxWhere ProcessNextEvent

Sleep=3 Quit

DialMailboxBeeperFile

QuickCommand=OfSl1DwSl3

DialMailboxBeeperFile

Sleep=1

QuickCommand=OnNeQu
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Pre-Defined Command Files

The self-contained voice mail unit has several pre-defined command files.
The command files are located in the \HELLO\CFILES subdirectory. They
have the following file names:

The numeric portion of the name describes the number of seconds after
dialing the pager number (but before sending the mailbox digits to the
paging company).

Sample Pager Files
Below is a sample of the pager file that we use. It is from PAGER10.CF; this
is similar to PAGERXX.CF and 0XX.CF files.

PAGER10.CF
PAGER12.CF
PAGER14.CF
PAGER16.CF
PAGER18.CF
PAGER20.CF
PAGER22.CF
PAGER24.CF
PAGER6.CF
PAGER8.CF

006.CF
008.CF
010.CF
012.CF
014.CF
016.CF
018.CF
020.CF
022.CF
024.CF

106.CF
108.CF
110.CF
112.CF
114.CF
116.CF
118.CF
120.CF
122.CF
124.CF

OffHook DialUrgentMsgCount
Sleep=2 Dial=*
DialPrefixForWhereField DialNewOnlyMsgCount
Sleep=3 Dial=*
DialMailboxWhere DialSavedMsgCount
Sleep=10 Dial=#
DialMsgSource OnHook
MsgSourceOk=Dial=* Notify
Dial=* Quit
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Below is a sample of the pager file that we use (it is from 110.CF, this is
similar to 1XX.CF files):

Modifying Command Files

Use a text editor such as Notepad.exe to view or modify a command file.

Examples

A sample command file that mailbox 232 would use for notification is
listed below. The file first takes the phone off-hook and dial a beeper
number. If a connect is detected (CallResult = 10) the mailbox number is
sent, and the file Quits. If we do not get a connect, the file calls another
phone number and, upon a connect, sends the last message received. If
the last number does not answer, we schedule another notify.

OffHook Dial=*

Sleep=2 DialNewOnlyMsgCount

DialPrefixForWhereField Dial=*

Sleep=3 DialSavedMsgCount

DialMailboxWhere Dial=#

Sleep=10 OnHook

DialMailbox Notify

Dial=* Quit

DialUrgentMsgCount
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The sleep= commands are used to give the phone line time to settle.

Figure A-1: Command File - Sample

; Mailbox 232's notification file
OffHook
Sleep=1
Call=9,14046621503
Sleep=2
; If we got a connect then send the mailbox and hang-up
CallResult10=DialMailbox
CallResult10=OnHook
CallResult10=Quit
; We did not get connected - so try another number.
OnHook
Sleep=1
OffHook
Call=9,011241230909
Sleep=2
; If we got a connect then play the message and hang-up.
CallResult10=PlayFirstMessage
CallResult10=OnHook
CallResult10=Quit
; Still no connect, so re-schedule notification.
OnHook
; The next two lines are simple time of day services.
DayOfWeek0=Console=Today is Sunday
Time10:00-14:00=Console=Time us between 10am and 2pm.
; The next 2 lines demonstrate linking of time of day
;    commands.
DayOfWeek3=Time10:00-10:30=Status=Wed 10:00-10:30am
DayOfWeek6=Time08:00-17:00=Menu=SAT_WORK
; Re-issue another notify
Notify
; Quit this command file
Quit



B Installation Forms

This chapter contains the Installation Forms to be used when
installing the PathFinder application.





Installation Forms B-1
BASIC INFORMATION

Job Name: _________________________________________________  Sales Rep:_________________

End User Contact (Administrator): _______________________________ Phone: ____________________

End User Contact responsible for recording custom prompts: ____________________________________

Installer: __________________________________ User Trainer:________________________________

Installation Dates: Start:_____________ Complete: ___________________

End User Training: _________________

Telephone System Information

Type of telephone system (brand & model):

How many digits are there in the telephone system's station or extension numbers? ____________

Is the telephone system capable of supporting In-Band Integration? Yes No

If YES, is the telephone system equipped to support In-Band Integration? Yes No
 (this includes both telephone system hardware & software)

What DTMF Digits does the telephone system use to turn on voice mail indicators: _________________

What DTMF Digits does the telephone system use to turn off voice mail indicators: _________________

Does the telephone system use a Hook Switch Transfer on Single Line Ports? Yes No

Number of CO Lines or Trunks connected to the telephone system: ___________________

Number of telephones (extensions) connected to the telephone system: _________________

List the single line port extension numbers that are to be used for Voice Mail Ports:

1_______ 2_______ 3_______ 4_______ 5_______ 6_______ 7_______ 8_______

Will the Single Line Ports be placed in a voice mail group (hunt group)? Yes No

What is the telephone system's voice mail group number or numbers? _________________________
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BASIC INFORMATION - (continued)

Voice Mail Functions

Number Of Voice Mailbox Users (Subscribers): _______________

Number of Internal Subscribers (who have a phones in the telephone system): ______________

Number of External Subcribers (who do not have a phones in the telephone system): _________

Are internal subscribers going to forward their phones to their mailboxes? Yes No

Will the telephone system provide Preset Call Forwarding to voice mail? Yes No

Will Subscribers use Pager Notification? Yes No

Automated Attendant Functions

When is Automated Attendant to be used? Daytime _____ Night _____ Both _____ Never _____

Will Automated Attendant be used as an overflow answering point (to help the live system operator)? _____

Number of CO Lines to be directly answered by Automated Attendant: ________

FAX Detection  -  Will the system be set to automatically route Fax calls? Yes No

Fax Transfer Prefix:__________________________   ("&" = flash and a "," [comma] = pause)

Fax phone number or extension number: ____________________________________________

Operator  -  What do telephone system users normally dial to reach the system Operator? ______________

Voice Mail Equipment Considerations

Where is the voice mail system to be located? __________________________________________

Is this location environmentally stable (air conditioned & heated)? Yes No

Will the systems be connected to a dedicated and grounded 120 volt, 60 Hz AC outlet? Yes No

WARNING:  Questions on this page answered as NO represent less than ideal conditions, and may cause imme-
diate or delayed malfunctions, or may disrupt certain voice mail and telephone system capabilities.   
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SUBSCRIBER INFORMATION

Complete one copy of this form for each Subscriber or group of Subscribers

Subscriber Name or Group Description: ____________________________________________________

Mailbox/Extension Number(s):Department: __________________________________________________

Class Of Service (COS)? ________________________________________________________________

Mailbox Settings

Operator:__________ Cascade:__________ Mailbox Time Control (special use): ____________

Mailbox Action Play Greeting: Yes No

Action:Destination: ____________________________________________________________

Notification:___________________________ Phone Number: ___________________________

Pager Notification: Yes No Time (if timed notification): _______________________

Extension Settings

Extension Time Control (special use): _____________________________________________

Action 1  -  when calls are first transferred to the extension

Action: __________________  Destination: _________________________________

Supervised Transfer Options (circle one): Screen Caller Allow Holding

Action 2 - Do Always Only On Busy Only On No Answer

Action: __________________ Destination: _________________________________

Supervised Transfer Options (circle one): Screen Caller Allow Holding

Action 3 - Do Always Only On Busy Only On No Answer

Action: __________________ Destination: _________________________________

Supervised Transfer Options (circle one) : Screen Caller  Allow Holding
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CLASS OF SERVICE (COS) INFORMATION

Complete 1 copy of this form for each Class Of Service

COS Name (number): __________________________ Description: _____________________________

General Settings

Time Control (special use): _____________________ Restrict Outdial - Number of digits: _____________

User Type: ( 01 = normal, 99 = Administrators) Event Counter (circle one): Owners Callers

Message Settings

Message Type: Voice Page

Default Message Type: Voice Page Play Message Type Menu

Message Properties: Length: ______ (sec.) Count:______ (messages)  Retention: _____ (days)

Record Key - Wait for key press before recording messages? Yes No

Greeting Types: Personal System Class Of Service Voice Insert

System Add On Greeting Length:________ (sec.)

Park and Page active? Yes No

Callers: Stop Record Key: _________ Record Options On? Yes No

Send Options: No Options Urgent Confidential Last Option On or Off: ________

Maintenance Settings

First Time Help (circle one)? Yes No Say Date and Time type: _______________________

Message Order: First in - First Out Last In - First Out

Owner Play Options: Save Messages Forward Messages  Dial Source

Confirm Delete Reply To Messages Skip Messages

Owner Send Options: Not Allowed do not allow the following options Urgent Future Delivery

Confidential System List Outside Number  Confirmation
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CLASS OF SERVICE (COS) INFORMATION - (continued)

COS Name (number): __________________________ Description: _____________________________

Owner Edit Options: Password  Delete Message Sent Auto Attendant

                               Greeting  Mailbox State   Notepad

                                  Name/Signature Personal Lists    Transfer Out

                                 Notification  Guest Mailboxes

Notification Settings

When will the system set Message Waiting? _________________________

Message Wait Set Sequence:(special use) __________________________

Message Wait Clear Sequence:(special use) _________________________

Event Handler Group: ___________________ (special use - default is set to 5)

Voice Notification Options: Password Required Message Pick-Up Allowed

Cascading: When will Cascade occur: ________________________ Urgent Only Option

Cascade Message Save & Delete Options: Save as New Delete Original Save Original

Notification Interval: ___________ (minutes) Notification Attempts: ____________ (number of tries)

Pager Retries? Yes No Notification Script:_________________________________________
(special use - default is Pager12.CF)

Auto Attendant Settings

Call Options: Blind Transfer Call Screening Supervised Transfer Call Holding

Hold Interval: ________________ (sec.) Hold Type: _____________________________

Call Queing? Yes No

Screen Length: _________ (sec.)  Play Original?: Yes No

Transfer Prefix: _______________________________________

Transfer Postfix: ______________________________________
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MENU INFORMATION -- Day

Complete one copy of this form for each Menu

Description: __________________________________________________________________

Number: __________ Password:__________ Time Control:_______________ (special use)

Instructions: __________________________________________________________________
 (special use - This is the Menu's number .VOX file name for prompts.)

Time Out: _________ (sec.) Max Retries:___________  (number of retries before hangup)

Keys Actions - including additional parameters: mailbox numbers, menu numbers, etc.

* ____________________________________________________________________

# ___________________________________________________________________

0 ___________________________________________________________________

1 ___________________________________________________________________

2 ___________________________________________________________________

3 ___________________________________________________________________

4 ___________________________________________________________________

5 ___________________________________________________________________

6 ___________________________________________________________________

7 ___________________________________________________________________

8 ___________________________________________________________________

9 ___________________________________________________________________

Prompt script for this mailbox - to be recorded via Administrator
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
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MENU INFORMATION -- Night

Complete one copy of this form for each Menu

Description: __________________________________________________________________

Number: __________ Password:__________ Time Control:_______________ (special use)

Instructions: __________________________________________________________________
 (special use - This is the Menu's number .VOX file name for prompts.)

Time Out: _________ (sec.) Max Retries:___________  (number of retries before hangup)

Keys Actions - including additional parameters: mailbox numbers, menu numbers, etc.

* ____________________________________________________________________

# ___________________________________________________________________

0 ___________________________________________________________________

1 ___________________________________________________________________

2 ___________________________________________________________________

3 ___________________________________________________________________

4 ___________________________________________________________________

5 ___________________________________________________________________

6 ___________________________________________________________________

7 ___________________________________________________________________

8 ___________________________________________________________________

9 ___________________________________________________________________

Prompt script for this mailbox - to be recorded via Administrator
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
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TIME CONTROL SETTINGS

Complete one copy of this for each Time Control

Time Control Name (Number): ________________

Description: _________________________________________________________________________

System Searches for a match, sequentially starting at item 1

Item Number: __________

Start Time: ___________ Mark active days for these hours:
MO TU WE TH FR SA SU

End Time: _____________  

Action (the menu or mailbox calls are to go to): 

Time Period Number: ______ (enter 1 to 9, for users to select time sensitive greetings)

Item Number: __________

Start Time: ___________ Mark active days for these hours:
MO TU WE TH FR SA SU

End Time: _____________  

Action (the menu or mailbox calls are to go to): 

Time Period Number: ______ (enter 1 to 9, for users to select time sensitive greetings)

Item Number: __________

Start Time: ___________ Mark active days for these hours:
MO TU WE TH FR SA SU

End Time: _____________  

Action (the menu or mailbox calls are to go to): 

Time Period Number: ______ (enter 1 to 9, for users to select time sensitive greetings)
Item Number: __________

Start Time: ___________ Mark active days for these hours:
MO TU WE TH FR SA SU

End Time: _____________  

Action (the menu or mailbox calls are to go to): 

Time Period Number: ______ (enter 1 to 9, for users to select time sensitive greetings)

* Up to 10 items can be assigned to a Time Control  -  use additional sheets for more items.



Installation Forms B-9
VOICE LINES SETTINGS

Action To Perform When Calls Ring In Additional Parameters

Line 1 _______________________________ __________________

Line  2 _______________________________ __________________

Line 3 _______________________________ __________________

Line 4 _______________________________ __________________

Line 5 _______________________________ __________________

Line 6 _______________________________ __________________

Line 7 _______________________________ __________________

Line 8 _______________________________ __________________



Installation Forms B-10



C Optional Modules

This chapter is an instructional tool for system administrators and
others who work with PathFinder. It describes how to install, set up,
design, monitor, and maintain various PathFinder applications. While
PathFinder is easy to use and administer, this manual will help you use
PathFinder to its fullest potential
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Introduction

PathFinder Hardware Components
All PathFinder hardware components should be listed in the Microsoft
Windows® Hardware Compatibility List (HCL), which can be found on the
Internet at http://www.microsoft.com/hwtest/hcl. The HCL is a
database of hardware, classified by function.

Optional Software Modules
The following features are available only as optional software modules
(sold separately) used to enhance the functionality of PathFinder’s
foundation software. Except for the Language Prompt Files, each of these
modules is discussed in more detail in a separate section in this
Appendix.

Chalk Talk

Fax Support

Internet Fax Delivery

Onelook

Onelook + Point to Point Server

Point to Point

TeleQueue

Language Prompt Files -- allow languages other than English to be
defined and used on PathFinder. When you purchase an alternate
language module, all PathFinder prompts have been recorded in that
language. One additional language is provided with each option.

To activate optional language prompts, simply activate your software
key. No additional installation or configuration is required.
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Chalk Talk

The PathFinder Chalk Talk module is an automated information system to
assist schools with managing communications in a school system
environment. This enhanced application also provides Advanced Voice
Mail features such as:

An auto attendant and unlimited menu options that eliminates the
need to talk to a operator.

An unlimited number of mailboxes that allows everyone on the
system to have their own voice mail box with features such as: call
screening, multiple greetings, message forwarding, and personal
distribution lists.

Features & Specifications
Three major applications have been specifically designed for school
systems: Outbound Calling, Homework Assignment Information, and
Questions & Answer Sessions.

Benefits for Schools

Outbound Calling

Contact parents of
absentee students …

Eliminates repeat phone calls. Automated outbound calling
notifies parents of their child’s absence and can inquire about the
reason for the absence. Parents can leave a voice message
responding to the inquire, which the school staff can later review.
Chalk Talk automatically redials non-answered and busy
numbers until the call is received.

Notify students and
parents of important
school information …

Chalk Talk can send a pre-recorded message to everyone that
needs to know important information (i.e., conferences,
meetings, report cards). A unique confirmation code can be
requested to ensure that the message was received. Chalk Talk
then matches the response against the database information.
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Outbound Calling

Notify employees and
students of school closings
or emergencies …

Chalk Talk automatically calls each student and faculty member
with an official message announcing the closing and/or the state
of emergency.

Locate and schedule
substitute teachers …

Automates the daily task of finding substitute teachers. Just
select the group list for the substitute teachers you need and let
chalk Talk call the possible candidates. Once an interested
teacher is found, Chalk Talk asks for a confirmation of acceptance,
such as a teacher ID or a voice mail message. Chalk Talk will
continue calling until all the positions are full. So, if you need
three Math teachers, Chalk Talk will continue calling until three
Math teachers accept the assignment.

Chalk Talk also has the ability to run multiple lists simultaneously.
If you need a History teacher and an English teacher on the same
day, you can run both groups at the same time.

Homework Assignment Information

Homework Hotline … Students and parents can access the home work hotline for the
latest assignments by entering the unique class ID number
supplied to each class. Updating the assignments is as easy as
recording a message and can be done by the teacher from any
telephone.

Student Activity Hotline … A 24-hour hotline for student sporting events, clubs and after-
school activities. Automated messaging can be kept accurate
and complete by allowing the activity leader to personally
update their own group using any telephone.

Question and Answer Sessions

Question and Answer
session via voice mail …

These pre-recorded voice mail sessions allow parents and
teachers to provide input and supply feedback at their
convenience. Up to 99 questions can be asked, recorded, and
reviewed at a later time.
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Minimum Specifications

PC Requirements

Intel Pentium-based PC with 32 MB RAM

Minimum 4 GB hard drive

3.5” 1.44 MB disk drive

Windows NT 4.0 or higher - with Service Pack 5

CD ROM drive

System Requirements

PathFinder release 8.2.4 or higher

Chalk Talk activation on the software key

Outbound Calling (using Call Lists)
The outbound calling portion of the Chalk Talk application was designed
to perform three major tasks:

1 -- Contacting parents of absentee students
2 -- Locating substitute teachers
3 -- Notifying employees of school closing, etc.

The basic underlying function of all three operations is: outbound dialing
to a list of numbers. A Windows-based program allows you to set up or
edit call lists, activate call lists by a specific group, and print call detail
reports.

DATABASES -- A Master List of call out numbers is created for storing
name, phone number, and ID information. Each entry is then assigned to
a specific group(s): Students, Teachers, Staff, Substitute1, Substitue2, etc.

CALL LISTS -- When a call out task is needed, an existing list may be edited
or a new list created. Members of the call list are selected from the Master
List. Once the property values for a call list have been set up, then the list
can be activated. Some functions (recording prompts), may be entered
via the telephone. Multiple call lists can be activated at the same time.

REPORTS -- Reports are generated based on call list parameters set up for
users and groups. Reports can also be printed and saved for future use.
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Getting Started
In order to access the Call List feature by computer or telephone,
configure the PathFinder system as described.

Call List Application Setup

1. From the MAINT application, select Configuration > System Settings.

2. Click the AUXILIARY TASKS button, then click ADD.

3. Type avOutDialManager.Main for the name.

4. Set the Event Group to 8, ignore the description field.

5. When finished, click ACCEPT, then click DONE.

After clicking on the LINE icon in the toolbar, complete the following
steps for each line to be used for outbound dialing:

6. Highlight the Line to be used for outdialing and click EDIT, then click
NEXT.

7. Enter 9 for the Event Handling group, then click FINISH.

8. Click OK when all lines are configured.

Call List Setup for Telephone Access

From the MAINT application:

1. Click the MENU icon on the toolbar.

2. Create or select a menu. Double-click or press select to edit the menu.

3. Select a Key Action to be used to activate/deactivate a call list
through the telephone.

4. Select “RunActiveVex.”

5. Enter CallListPrompter.Main

6. Click OK.

7. Click OK.

8. Click DONE.

9. Close the MAINT application when finished.
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First-Time Programming Setup
Once the PathFinder system has been completely installed, a Call List
Startup Wizard will automatically open to allow you to: Set up a Group.
One or more Groups MUST be present before you can add call list
members to the Master List, or activate a Call List for the First Time.

When the Startup Wizard welcome screen displays:

1. Click Next to continue. The second Wizard screen will display a brief
overview of the Call List process.

2. Click Next to continue. The third Wizard screen will show “Students”
in the First New Group field. (The group name may be changed here,
if desired.)

3. To add the Students group, click Next to continue. The final Wizard
screen will display:

4. Click Next to add another group (the third Wizard screen will return
for additional entries),

-or-

5. Click Finish to accept the group(s) shown. The Call List Admin screen
will display.
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Starting Call List Admin
To manually start the Chalk Talk Desktop Admin application, select:

Start > Programs > PathFinder Voice Processing > Call List Admin

… the Call List Admin screen will display:

Figure C-1: Call List Admin Screen

D A T A - E N T R Y T I P …
This “pushpin” icon appears on certain data-entry screens. Its function is
to keep the current screen “open” until multiple entries are completed
and accepted (OK, DONE, etc.).

side-view … for single entries

top-view … for multiple entries
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Call List Process Flow
The following diagram shows the sequential order for setting up and
activating a Call List:

Figure C-2: Call List - Process Flow

2 … choose Master List
then enter call list members
(teachers, students, etc.).

After a Group has been set up,

1 … select Database

open Call-List Admin …

then add Call List.
4 … choose Modify

then double-click on
5 … choose On/Off

name to active Call-List.

6 … click Exit when finished

3 … select Call-Lists
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Call List Options
Once the Call List Admin application has been programmed, the software
will open to the most commonly used area, Call-Lists. From this screen
you can start or terminate a call list, or modify the parameters.

To Activate/Deactivate a Call List:

1. Select CALL-LISTS, then click ON/OFF.

Figure C-3: Call List - Activation

2. To activate a call list, click the box next to the “call list name.” A check
mark will display to indicate the active status.

3. To deactivate a call list, click the box next to the “call list name.” The
check mark will disappear to indicate the inactive status.

An active Call List can not be modified. If you attempt to edit a list
that is still active, a system message will display and remind you to
“uncheck the item before editing or removing.”
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To Set Up or Modify a Call List:

1. Select CALL-LISTS, then select MODIFY.

a. To modify an existing Call List, highlight the desired list and click
the PROPERTIES button (or double-click on the entry).

b. To add a new Call List, click the ADD button.

The Edit Call-List Entry screen will display:

Figure C-4: Edit Call-List Entries

3. Add or change the parameters for the Call List as described in the
following field/definition table.
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Description » Name given to a Call List that identifies
its purpose or function.

Priority » Setting is used to select which list will be
processed first. A High priority list
processes before a Normal or Low
priority (1-10).

Supervised Call

Blind Call Delay (secs)

» System determines condition of call
(answered, ringing, busy). For optimum
results, use with Confirmation or Accept.

» This call type strictly follows its program
settings. For best results, set up calls to
repeat, or use with Confirmation.

Introduction Prompt Times to play » Number of times the prompt plays
before continuing with the call flow.
(Use a setting that will allow the system
to detect calls being answered.)

Play Member ID Times to play » Number of times the system will repeat
an ID (ex: to report ID of absentee
students).

Confirmation Use ID

Wait (secs)

Max Attempts

» System queries for a DTMF response to
confirm the caller is present (not an
answering machine or wrong number).

» Length of time the system allows the
person called to enter the ID.

» Maximum number of call backs allowed.

Accept Stop after (x) accepts

Wait (secs)

Accept keys

Max Attempts

» System calls out until this number of
acceptances are received (ex: school
needs 2 substitute teachers - calls will
stop after receiving 2 acceptances).

» Length of time the system allows the
called person to accept.

» Keys assigned for called party to use to
acknowledge/accept message.

» Maximum number of attempts called
party has to enter specified Accept Key.
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Message Optional

Mailbox

Max Length

Go to Q&A

» Person called is given a choice to leave a
message.

» Mailbox number to receive the voice
mail messages.

» Amount of time that a person called has
to record a message.

» System will play the designated
question and answer survey.

Disconnect Prompt » A recorded prompt to be played when
message has been delivered, and call is
ready to disconnect.

Start Date » When to start calling: mmm/dd/yy

Run Time » Time to start and stop calling: hh:mm
(military format)

Delay (mins) Before Call Backs » Period of time between attempts to
recall a previously dialed number.
Separate delays for each condition.

No Answer Max Attempts

Busy Max Attempts » Maximum number of call backs allowed.

No Confirm Max Attempts

Protect Password

Re-enter

» Numeric password (1- 9 digits) to
control access to a specified Call List.

» Verification of the password entered.

Activate on completion » Call List is automatically activated when
the Call-List Entry screen is completed.

Select members to call - To select members from a group
Master List. The number of members is unlimited.

Load Template Call-List - To use template settings
selected to create another call list.

Change - To accept new settings associated with a Call List
(reflects on Master List).

Cancel - To ignore current information entered.
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4. Click the SELECT MEMBERS TO CALL button to access the Master List
from the Select Members screen.

Figure C-5: Select Members to Call Screen

5. Click on the drop-down window to select the group. All names stored
on the Master List display in the left pane.

6. Use the ARROW buttons to add or remove names in the Call List, then
click OK.

3 - Move names to Call List1 - Select Group 2 - Select Members
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7. To load (copy) the parameters assigned to an existing call list, click
the LOAD TEMPLATE CALL-LIST button. The Load Template screen
displays.

Figure C-6: Load Template

8. Select the Call List with the desired parameters, then click APPLY.

The following system messages will display to confirm your selection:
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9. From the Edit Call Entry screen, click CHANGE when finished.

Follow the steps described earlier to activate the Call List.

To Record Prompts:

Place a call into PathFinder CallListPrompter.

Voice Prompts

All voice prompts should be stored in the ...\VOX directory, and must be
4-digits in length. The following system prompts may be used or the
numbers can be changed by the system administrator. Valid numbers
are: (0)000 to (0)999 and (1)000 to (1)999.

The first digit indicates the language, 0 = English, 1=Spanish.

Table C-1: System Prompts

Prompt Dialog

0010 This is the voice processing system calling to notify you.

0011 This is the absentee student system calling to notify you that your child was
absent from school today.

0012 This is the emergency notification system calling to notify you that school
will be closed today.

0013 This is the substitute teacher system calling to check your availability for
being a substitute teacher.

0019 Thank you. Good-bye.

0020 To confirm that you have received this message, press 1.

0021 To confirm that you have received this message, enter your ID number.

0022 To confirm that you have received this message, enter your child’s student ID.

0023 To accept this assignment, press 1; otherwise press 2.

0024 To leave a message in response to this notification, press 1.

0025 After the tone, start recording your message. When finished, you may press
any key or hang-up.



C-16 Chalk Talk
Report Options
To create a detailed report showing the details and parameters required:

1. Select REPORTS.

2. Then select the type of call list needed for the report: Master List,
Group List, or Call List. The selected screen displays.

Figure C-7: Reports - Master List
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3. Select the appropriate “view master list” for the time period needed:

all records

records created in the last week

records created in the last month

records created in the last year

4. To further define the report, choose one of the following:

Select only records created by AutoLogin

Select records in Group (groups display in drop-down box).

5. Click the VIEW REPORT button to display the details for the report
parameters selected.

EXAMPLE -- View all master list records … created by the person using
the AutoLogin … for a group called Teachers will produce this report:

Figure C-8: Master List Detail Report

6. Use the envelope icon to export the file to another application.

7. Use the printer icon to print the selected report.
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Database Options
The Database contains user and group parameters that are used to create
and modify the Master List for Call Lists and Reports.

MASTER LIST -- To delete, add, or change Master List settings:

1. Click DATABASE.

2. Then click MASTER LIST, previously stored entries display.

3. Click the ADD button to create a new Master List entry, or the
PROPERTIES button to edit an existing entry.

Figure C-9: Database - Master List/Entry Screen

A GROUP must be added prior to adding a member to the
Master List.
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4. Complete the desired fields, then click the ADD button to create a
new entry in the database,

-or-

Change the existing data entry and click UPDATE when finished.

(Each person can be a member of up to three groups.)

GROUPS -- To delete, add, or change Group settings:

1. Click the DATABASE button.

2. Then click GROUPS to bring up the list of groups. The Group List Entry
dialog window displays.

Figure C-10: Database - Group List Entry Screen

3. Add or change the name of the group, then click OK.
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USERS -- A user must first be set up with admin privileges before they can
select report parameters and generate call reports.

To add, change, or delete User settings:

1. Click the DATABASE button.

2. Then click USERS to bring up a list of valid users.

3. Click ADD or PROPERTIES, the Add User dialog window displays.

Figure C-11: Add User Screen

4. For a new user, type in the name and password. To allow the user to
modify User List reports, click ADMIN RIGHTS.

-or-

For an existing user, make the necessary changes.

5. Click OK when finished.
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Flow of Outbound Call

The following table describes common outbound call conditions and
their responses:

Table C-2: Outbound Call Responses

Call Condition System Response

Unable to connect to called
number

Reschedule the call based on timer settings.
Delay in minutes before call back atempts.
Number of attempts PathFinder will call.

Introduction Prompt is defined Play prompt the designated number of times to play.

Play ID is selected Play prompt (if present), then play ID (0011 or 1011).
Repeat as defined.

A Confirmation is required Play prompt and wait for digits designated number
of seconds (0022 or 1022).
If digits are defined as “ID”, then require caller to
enter the ID matching this record.

Acceptance is indicated Play prompt and wait for acceptance (0013 or 1013).
If maximum number of accepts are met, then stop
call out list.

Leave Message or caller selects
to leave message

Play prompt to leave message, then start recording.
End recording on disconnect or digit pressed
(0025 or1025).
Message should then be delivered to the mailbox
indicated.
If a QA ID is defined, the system should branch the
QA instead.

Leave Message can be optional
or required

Play prompt and record response (0025-1025).

Disconnect Prompt Play disconnect prompt (0019 or 1019).

When PathFinder is shut-down and restarted, the system continues outbound
calling where it left off.
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Homework Assignment Information
The Homework Hotline is a PathFinder application that allows each
teacher to have a specific area for storing homework assignments. A
teacher is assigned a unique ID (valid system mailbox) which allows a
teacher to have a personal mailbox, as well as one for assignments.
Students accessing the Homework mailbox WILL NOT be able to leave a
message, this is an announcement only area.

Installation / Configuration

Getting Started

» » » Start > Programs > PathFinder Voice Processing > Maint

To use an “opening menu” when the Homework Hotline is activated,
configure the system as follows:

1. Start the MAINT application.

2. Select Edit > Menus or click Menu icon in toolbar.

3. Select a MENU to use for Homework Hotline.

4. Then select the Key Action to start the Homework Hotline.

5. Select 1-9, #, or *.

For example:

a. To run the Homework Hotline, choose “6”

b. Select “Run ActiveVex”

c. Enter AVHomework.Run
d. Click OK

e. Click OK

f. Click DONE

7. Exit the MAINT application.

8. Record the greeting(s) for the Menu selected, such as: ”…to listen to
homework assignments, press 4”.

When the application requests a “teacher ID,” the system is referring
to the mailbox number assigned to that teacher for the callers to use
when they call in for their assignments.
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When a teacher wishes to record a new assignment, they access the
system as a student, enter their teacher ID, then press [✳]. The system
asks for the password. The teacher enters their mailbox password
followed by [#]. They can then listen to and re-record a new assignment.
After recording a new assignment, they must press [4] to accept the
assignment and make it available for the next caller.

Registry Variables are used to define specific parameters and how they
will be applied by the Homework Hotline application.

To add and change these variables, use the MAINT application and select
Configuration > Registry.

This variable defines what the application will run if a caller elects to
“go back” or exit.

HomeworkRunCodeOnExit = Mn100

- To run “Mn 100”

- To go to mailbox 123, use “Vm123”

- To disconnect, use “Hg”

This variable defines what the application will run if it detects an
error. Similiar to values used in “HomeworkRunCodeOnExit.”

HomeworkRunCodeOnError = Hg

When the homework assignment is played, you can select whether to
play back the date and time the assignment was recorded. The
default setting is set to NO (do not play the date).

HomeworkPlayDate= Y, A, B, N,

Play Date settings are:

- Y or A = Plays date AFTER the assignment

- B = Plays date BEFORE the assignment

- N = NO, does not play a date

All variables and values are case sensitive.
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Figure C-12: Edit Registry Item (MAINT App.)
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Prompts used within the Homework Hotline are non-indexed prompt
files, and are stored in the ...\Homework\Prompts directory. After shutting
down PathFinder, you can use BoomBox to re-record any of the
application prompts.

Table C-3: Homework Hotline (Default) Prompts

Prompt Prompt Dialog

100 Thank you for calling the homework hotline.
Please enter the teacher ID number.

101 Teacher ID...

102 …does not exist.

103 No assignment has been recorded for teacher ID...

104 To hear assignment again, press 1.
To enter a new teacher ID, press #.
To disconnect, press 9.

105 Please enter your teacher ID password followed by pressing #.

106 You have entered an invalid teacher password.

107 You are editing the homework assignment for ID...

108 To hear current assignment, press 1.

109 To record a new assignment, press 2.

110 To accept newly recorded assignment, press 4.

111 To go back and enter a new teacher ID, press #.

112 To disconnect, press 9.

113 After the tone, start recording the new assignment.

113 Press # to stop recording.

114 This assignment was recorded on...

115 The following is the current assignment.

116 The following is the newly recorded assignment.

117 New assignment has been accepted.
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Question & Answer Sessions
The Question and Answer Sessions is a PathFinder application that allows
the system to be configured for either voice or DTMF response questions.
The responses are stored as a voice message for a specified mailbox. The
QA module allows up to 99 questions.

Installation / Configuration

Activating the QA Application

Select: Start > Programs > PathFinder Voice Processing > Q&A Admin

The following Questionnaires screen will display:

Figure C-13: Questionnaires Screen

Since a questionnaire MUST be present to start the QA Admin application

… a sample questionnaire was set up using the following criteria:

“Ask for a voice name and a DTMF telephone number and then send
results to mailbox 100.”
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To edit, add, or delete a questionnaire:

1. Toedit --highlightthedesiredquestionnaire,thenclicktheEDITbutton,

-or-

Double-click on desired questionnaire (“100: Sample questionnaire...”).
The Edit Q&A ID screen displays the details for that question:

Figure C-14: Q&A Application - Edit Q&A ID Screen

Field Description

Description This text is used by administration to identify the Q&A Session.

Password The question prompts may be recorded via the telephone by
pressing [✳] during the first question. After pressing [✳], the
password must be entered to gain access.

Mailbox to Store Answer This is the mailbox where the results should be stored.

Send Incomplete Check this box if the system should deliver the responses to the
mailbox, even if they are not complete.

Menu to Run on Exit When the questionnaire is finished - this is the menu name that
should be called.

Questions A list of questions to ask. Double-click on a question to edit.
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2. Double-click on question to edit parameters (Question 2 “Ask for
telephone...”). The Edit Question screen displays detail for that question:

Figure C-15: Edit Question Screen

Field Description

ID Fixed field

Question Number Fixed field

Description Text/Action that describes the question.

Prompt What prompt should be played. Prompts should be stored in the
\PathFinder\QA\Prompts directory. Usually the prompt name is made up
of the Q&A ID followed by a hyphen, followed by the question number.
You can specify any prompt located in the \QA\Prompts directory.

If you want the recorded response to contain a header or leader that
indicates what is to follow, you can record a small prompt in the file
name “L” + Prompt Name.

FOR EXAMPLE: If prompt “100-1.vox” contains the prompt “Please say
your name after the tone.”, the prompt “L100-1.vox” would contain the
prompt “Name” or “Answer 1”. If the “L” prompt isn’t present - it is not
added to the resulting message.
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3. Click OK when finished.

4. To delete -- highlight the desired questionnaire, then click the
DELETE button. The item is removed from the list and can not be
retrieved.

5. To add -- click the ADD button. The Create New Question screen
displays.

Complete all necessary fields.

To add a question, click OK. The Create New Question screen
displays.

Complete the question attributes, then click OK when finished.

After creating a questionnaire, the next step is to link it to a menu. Then
place a call into the system and record the prompts.

Linking a Questionnaire to a Menu

For the Homework Hotline to be called from an “opening” menu, complete
the following steps:

1. Start the MAINT application.

2. Select Edit > Menus.

3. Select the menu you want to be connected to the application.

Type of Response The system can either record voice or wait for DTMF digits.

Length of Response When recording voice, this field shows the number of seconds recorded.
For DTMF input, field shows the maximum number of digits.

Terminating Digit For DTMF digits, you can specify the terminating digit if used.

Field Description
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4. Select the key on the menu (0-9, ✳, or #) that will start the Homework
Hotline (or the digit to be dialed).

Figure C-16: Start Homework Hotline Screen (MAINT App.)

5. For Key Action, select “Run ActiveVex”

6. For the ProgId parameter, type AVQA.Run.100

(where 100 is the questionnaire number).

7. Exit the MAINT application.
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RECORDING PROMPTS

Once the questionnaire has been linked to a menu,

1. Restart the PathFinder program.

2. Call into the desired menu, then press the DTMF tone previously
selected.

If a “question prompt” HAS NOT been recorded, then the system
will prompt with “ #115. “Press ✳ during this prompt to gain
access to record prompts."
If an “opening prompt” is present, you may still press [✳] to
access the Record Prompts option. The system will prompt you
for the password followed by the [#] sign.

3. After gaining access, select from these prompts:

4. Once you record a new prompt, press [4] “to accept the prompt”.
(Otherwise, the prompt will not be installed or heard by callers.)

The first telephone call takes a few extra seconds while the system
connects to the database.

[1] … to listen to current prompt

[2] … to record a new prompt

[4] … to accept new prompt

[7] … to go to previous question

[8] … to go to next question

[#] … to go to another questionnaire

[9] … to disconnect
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QUESTIONNAIRE PROMPTS

All prompts used within this application are non-indexed prompt files.
They are all stored in the ...\QA\Prompts directory. After shutting down
the PathFinder program, you can use BoomBox to re-record any of the
application prompts.

Table C-4: Questionnaire Prompt Files

Number Prompt Dialog

100.vox Installation of this questionnaire is incomplete.
To record prompts press ✳.

101.vox Enter the password for questionnaire followed by pressing #.

102.vox You are currently editing question number...

103.vox To hear currently recorded question, press 1

104.vox To record question, press 2

105.vox To re-record question, press 2

106.vox To accept newly recorded question, press 4

107.vox To go back to previous question, press 7

108.vox To go to next question, press 8

109.vox To disconnect, press 9.

110.vox To edit a new questionnaire, press #.

111.vox Enter the questionnaire ID you wish to edit followed by #.

112.vox That is an invalid password.

113.vox That is an invalid questionnaire ID.

114.vox You have selected an option currently not available.
Please make another selection.

115.vox Unable to access system file.
Please contact your system administrator.

116.vox Questionnaire was incomplete

117.vox After the tone, record the new question.
Press # to stop recording.

118.vox Thank you for calling.
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Conditions
The QA module is not controlled via the key.

The administrative module allows creating, deleting, and editing of
the QA lists. The administration can either be done over the phone or
via a GUI interface. A GUI interface is the preferred method.

If the QA is accessed and the opening prompt has not been recorded,
the system prompts for the password to record prompts.

During the 1st prompt, if the [✳] key is pressed, the system prompts
for the password and then allows prompts to be edited.

Logging is generated to allow for determining the QAs accessed.
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Fax Support

PathFinder supports facsimile receipt and facsimile store-and-forward via
the common facsimile cards. Parameters for the facsimile options are
accessed via the MAINT application’s Configuration menu.

Fax support is being used in many innovative ways in business. Fax
Options expand the capability of PathFinder to handle both voice and
facsimile messaging. Facsimile messaging also allows customers to
request commonly-needed documents.

PathFinder supports facsimile receipt and facsimile store-and-forward via
the common VFX/40ESC-plus cards. This allows for facsimile mailbox and
Fax On Demand capabilities.

Fax Mail
Fax Mail allows callers to leave facsimile messages in a subscriber's
mailbox. The subscriber can then retrieve the message at a later date and
time, just like they can with a voice message. When a facsimile message
needs to be printed, it can be directed to a local or remote facsimile
machine. PathFinder will ask the subscriber to enter the facsimile number
for printing.

Fax On Demand
Fax On Demand will send facsimile documents and information to any
caller with access to a facsimile machine.

Basically, the Fax On Demand database functions as follows:

1. The system administrator sends facsimile documents into PathFinder.

2. The system administrator gives each document a document number
and records a voice prompt describing the document.

3. Callers then can request each document by number or after hearing
the description, and PathFinder sends each requested facsimile
document.
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Configuration
When Fax Options are enabled on PathFinder, you receive both Fax Mail
and Fax On Demand applications. To configure PathFinder for facsimile
options, you must do the following:

1. Purchase the facsimile option.

2. Install the facsimile hardware according to the Dialogic®

documentation.

Facsimile Hardware
The first step in setting up any facsimile application is to install the
necessary facsimile hardware. Please refer to the Hardware Installation &
Configuration chapter in the System Administrator Manual for details on
configuring facsimile hardware.

Fax On Demand
There are a number of things you must do in order to set up a facsimile
application. The following steps illustrate what is required to set up a Fax
On Demand application, but these steps also can be used when creating
other facsimile applications or when enabling mailboxes to receive and
store facsimile messages. These steps are outlined in the typical order
that you should follow when setting up an application.

Fax Mail Application
Configuration of the Fax Mail application consists of the following
elements:

1. Setting up facsimile support in MAINT

2. Create a key to run Fax On Demand

3. Build a facsimile database
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Setting Up Facsimile Support in MAINT
After the facsimile card(s) and accompanying application software have
been installed, you can configure the facsimile settings. From the MAINT
application’s Configuration menu, select Fax Settings. The following
window displays:

Figure C-17: FAX Settings

Complete fields in this window as follows, then click OK when finished.
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Table C-5: Fax Fields and Descriptions

Field Description

Administration
Password

Specify the password to be used for administrative access to the
facsimile options (used when adding facsimile documents to the
facsimile database).

Event Group to use
when sending

Select the event group that processes outbound facsimiles. Event
group 6 is commonly used for facsimile purposes. Make sure to
assign a line to service this event group. Refer to the Line Settings
chapter of the System Administrator Manual for more details.

FAX ID for this
system

Enter an identifier for your company’s facsimile system. This
identifier is sent in the header of the facsimile document. Typically,
this is the telephone number of the Fax On Demand system.

Allow voice
attachments

If this option is selected, PathFinder will allow a caller to append a
voice attachment to a facsimile message. If this option is
deselected, PathFinder will simply accept the facsimile message
without the option to append a voice message.

Maximum
documents a caller
can select

Enter the limit for the number of documents a caller can access
during one phone call. Typically, this value is set to 3.

Callers must call
from FAX machine

Select this option if you want to disable PathFinder’s outbound
facsimile capabilities for Fax On Demand. Callers must call from a
facsimile machine and will be prompted to turn control over to the
facsimile machine to receive the facsimile, making the caller
responsible for any long-distance charges.

File to send as cover
sheet

Type the name of the file to be sent as a cover page with each
facsimile document. The cover page file must be in TIF format and
must exist on the PathFinder computer for this option to function
properly.

Retry attempts for
failed sends

Enter the number of times PathFinder should try to re-send a
facsimile if the call results in a busy signal or no answer or
disconnects in the middle of a send. A typical value is 3.

Retry interval for
failed sends

Enter the number of minutes PathFinder should wait between
retry attempts.
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Create a Key to Run Fax On Demand
The next step is to create or modify a menu to include a Fax On Demand
key. Usually, a front-end menu is used to provide facsimile support
services so callers do not have to hunt through multiple menus looking
for facsimile options.

At least one key must be assigned to the Fax On Demand option.

To create a facsimile menu:

1. Click on the Menu button on the toolbar.

2. In the Select Menu to Edit window, click on the Create button and
enter a name for the menu.

3. If you are using another menu as a template, select it from the
drop-down list.

4. Click on Create Menu. This returns you to the Select Menu to Edit
window.

When setting the Fax On Demand key, indicate if the caller either can
select any facsimile document or is restricted to defining a specific
facsimile document.
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5. Highlight the menu you just created, then click on Select. The
following window displays:

Figure C-18: Edit Menu: FAX Window

6. Enter a Password.

7. Select a Time Control if one is to be used.

8. Set the Time Out and (maximum) Retries options.

9. Select or record Introduction, Body, and Instructions prompts.

10. Set the Key Actions. At least one key must be assigned to Fax On
Demand.

Refer to the Menus Settings chapter in the System Administrator
Manual for details on the creation of menus.
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11. The Fax On Demand key action will accept one of three parameters:

ADMIN: Tells PathFinder that this key allows access to Fax On
Demand administrator features. When this key is selected,
PathFinder will ask for a password. When the correct password is
entered, PathFinder will allow the administrator to add or remove
documents to or from the Fax On Demand database.

Fax Document Number: If you enter a specific Fax On Demand
document number in the field, PathFinder will transmit that
facsimile document to the caller.

If you enter no value in the field, PathFinder allows the caller to
select the facsimile documents to be sent.

12. Click on OK when finished.

Build a Facsimile Database
Once PathFinder has been configured for facsimile support and a menu
has been created for Fax On Demand, you are ready to start building a
facsimile document database. A facsimile database is simply a group of
documents in facsimile format. Two methods can be used to enter
documents in the facsimile database:

Traditional facsimile machine

Computer-based facsimile software

Refer to Facsimile Database for more information.

Facsimile Database

Using a Traditional Facsimile Machine
To build a facsimile database using a traditional facsimile machine:

1. Make sure that PathFinder is online.

2. Call into PathFinder and access the facsimile menu you created
earlier.

3. Press the key designated as the facsimile ADMIN option.

One key action in the menu must be defined as ADMIN.
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4. Press ❊ and enter the ADMIN password. PathFinder plays the
following menu: "Press one to create a new document; press two to
delete a document; press three to change a document’s description;
press nine when finished."

5. Press 1 to add a new document to the facsimile database.

6. Enter a document number followed by the # key.

7. Record a description of the document, if desired.

8. Send the facsimile using manual send.

Repeat the process until all documents have been added to the database.

Using Facsimile Software
The use of a facsimile application to transmit facsimile documents
directly from a PC to PathFinder is highly recommended, as the quality of
such facsimile transmissions is much higher than when sending from a
traditional facsimile machine.

To build a facsimile database using a software-based facsimile program:

1. Create the facsimile document using a word processor, page layout,
or desktop publishing application.

2. Send the facsimile to PathFinder via the facsimile software. Most
facsimile software programs support extended dialing strings. You
can use this feature to set up a dialing string that sends the document
and automatically assigns a document number, eliminating the need
to enter this information manually. A typical dialing string is
presented below:

9,XXX-XXXX,,W,YYYY#,1,ZZZZZZZZ#,#,1

Where:

9 is any prefix digit or sequence of digits needed to gain access to
the telephone system.

Commas ( , ) are used in the dial string to pause dialing for two
seconds each, giving the telephone system and PathFinder time
to connect, and so on.
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XXX-XXXX is the phone number for the Fax On Demand system.
If you are calling from a telephone extension and the Fax On
Demand system also has an extension number, you can use the
shorter extension number.

W is the number assigned as the facsimile ADMIN key in the
facsimile menu.

YYYY is the ADMIN password.

1 is the menu option to create a new document.

ZZZZZZZZ is the document number being assigned to this
facsimile.

The final 1 tells PathFinder to start accepting the facsimile
transmission.

As an example, suppose PathFinder is at extension 400, your facsimile
ADMIN access key is 8, and your facsimile ADMIN password is 9999. You
need to add to the facsimile database a new facsimile document and
assign to it document number 1200. A typical dialing string might look
like this:

400,,8,9999#,1,1200#,#,1

A dialing prefix could be added to the front of the string if needed. You
might find it handy to save this string as a number in your facsimile
program’s phone book. When you are ready to create a new facsimile
document, simply edit the document number portion of the string to
give each facsimile document a unique number.

Adding a Voice Description to a Facsimile Document

Once you have entered the document in the facsimile database, you can
go back and add a brief description of the document.

To add a description to a document in the facsimile database:

1. Make sure that PathFinder is online.

2. Call into PathFinder and access the facsimile menu.

3. Press the key designated as the facsimile ADMIN option.
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4. Press ❊ and enter the ADMIN password. PathFinder plays the
following menu: "Press one to create a new document; press two to
delete a document; press three to change a document’s description;
press nine when finished."

5. Press 3 to change (add) a description.

6. Enter a document number followed by the # key. The current
description is played, or PathFinder tells you if no description has
been recorded.

7. Press # to record the description, then press # when finished.

8. Repeat the process, selecting a new facsimile document number,
until all documents have been given a description.

Sample Fax On Demand Application
PathFinder can be configured to meet your specific Fax On Demand
needs, whether as a sales tool, technical support aid, or as a source of
general information. The following sample shows how Fax On Demand
can be used to provide product information and technical support
services. The figure below illustrates a typical PathFinder Fax On Demand
menu setup for the Balagunda Corp.

Figure C-19: Edit Menu: Facsimile Menu Window
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Balagunda Corp. has a dedicated telephone number assigned for their
Fax On Demand service. Because the facsimile menu is the first one
accessed when a caller reaches the facsimile service, PathFinder plays a
greeting prompt (Balagunda), then a body prompt (faxlist) followed by
instructions for using the Fax On Demand system (faxinfo). If the
facsimile menu had been accessed from another menu, PathFinder would
play only the body and instruction prompts, without a greeting prompt.

The 1 Key ( 1 ) sends facsimile directions on how to get to
Balagunda’s office (document #100).

The 2 Key ( 2 ) provides a list of tech support facsimile documents for
the company’s widget product (document #200).

The 3 Key ( 3 ) sends sales information on the widget product
(document #300).

The 4 Key ( 4 ) is pressed if the caller knows the specific number of the
desired facsimile document. After pressing 4, the caller is prompted
to enter the appropriate facsimile document number, which is then
transmitted back to the caller.

The 7 Key ( 7 ) is used to access the Fax On Demand administration
options, and requires a password (718293).

Facsimile Mailboxes
Once PathFinder has been configured for facsimile support, facsimiles can
be left in and retrieved from a PathFinder user’s mailbox.

Leaving a Facsimile in a Mailbox
In order for a subscriber to receive facsimile messages in their mailbox,
their Class of Service (COS) must be configured to allow facsimile
messages. Refer to the Class of Service chapter in the System Administrator
Manual for more information.

The option to prompt callers to leave a facsimile can be set as a COS
feature (as set in the Class of Service Message Type Menu window). Again,
refer to the Class of Service chapter in the System Administrator Manual for
details.
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An alternative method is to have the mailbox owner prompt the caller to
leave a facsimile in the mailbox greeting. The key callers press to leave a
facsimile is 3. A typical greeting might sound like this: “You’ve reached
John. I’m away from my desk right now. To leave a voice message press
one. To leave a facsimile, press three.” After pressing 3, the caller is
instructed on how to leave a facsimile message as described below.

To leave a facsimile message:

1. Access the desired party’s voice mail.

2. Press 3 to leave a facsimile message.

3. Press # to leave a voice attachment to the facsimile (if the attachment
option is available) or press ❊ to skip the attachment.

4. Manually start the facsimile transmission.

Retrieving Facsimiles
Retrieving facsimiles from a mailbox is a PathFinder user function. Please
refer to the PathFinder User’s Manual for details on retrieving facsimiles.

Internet Fax Delivery

Internet Fax Delivery is an optional software component of PathFinder.
With Internet Fax Delivery (IFD), two or more PathFinder voice processing
systems can use the Internet to exchange facsimile documents for
delivery. By using the Internet as a transport, the cost and quality of the
transmission are improved. This is especially true for international
facsimile deliveries.

Internet Fax Delivery uses standard facsimile machines to send facsimile
documents into the PathFinder system. Upon receipt, the IFD module
determines where the closest server is located. It transports the facsimile
over the Internet to the destination server. The destination server then
dials the local facsimile machine. A return receipt can then be sent back
to the originating machine.
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Internet Fax Delivery delivers standard facsimile messages using the
Internet. It does not require any equipment attached to the facsimile
machine and runs with other PathFinder applications, including voice
mail and automated attendant.

Requirements
IFD requires the following before operation:

PathFinder Release 6 or higher

Dedicated Internet access (used for transport) to other PathFinders

Facsimile support on each of the PathFinder systems (VFX/40s)

Internet Fax Delivery activation code for the software controller key

Facsimile Support activation code for the software controller key

Installation
Internet Fax Delivery should be installed from the PathFinder CD-ROM by
selecting the Internet Fax Delivery component. If necessary, run the
PathFinder installation program and select Internet Fax Delivery.

Once installed, Internet Fax Delivery is made up of the following files:

\HELLONT\IFD\IFD_ADMN.EXE: This is the administration and
reporting program. IFD_ADMN allows a user to configure and
administer the subscribers, classes of service, routing tables, etc.

\HELLONT\IFD\IFD_SRV.EXE: This is the facsimile delivery server.
This program handles the inbound and outbound traffic. It should be
placed in your startup group so that it always runs.

\HELLONT\VOX\❊.VOX: Contains voice prompts.

All system components--both required equipment and optional
equipment--should be listed in the Microsoft Windows® Hardware
Compatibility List (HCL), which can be found on the Internet at http:/
/www.microsoft.com/hwtest/hcl. The HCL is a database of
hardware, classified by function.
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\HELLONT\MODULES\A!IFD.SUB: This is the facsimile delivery
module. This module communicates with inbound callers, and
receives and delivers facsimiles.

Setup & Configuration
Once the software is installed, select from the Start menu Programs >
Hello! Voice Processing > Internet Fax Admin.

Do not run the Internet Fax Server yet. If the Fax Server is running, select
from the menu bar File > Shutdown Server to exit the server.

Running IFD_ADMN.EXE will cause in the following window to display:

Figure C-20: Internet Fax Delivery - Administration & Reporting Window
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Settings Guidelines

Both the Fax Delivery Server settings and the Voice System Server
settings should use the same local machine name.

Fax Delivery should use IP Port 24, while Voice System will use IP Port
23.

Logging settings control how much information is logged and if it is
logged to a file.

Transport settings control frequency and retry interval.

The defaults are usually the correct setting.

Reports
The first item is Reports. Double-clicking on “Reports” results in the tree
expanding to show two more items. IFD is shipped with two reports:
“Usage” and “Settings”. These reports provide basic information about
IFD.

Subscribers
The second main item is Subscribers. Before users can call in and leave
facsimile messages, you must add the subscribers, as follows:

1. Double-click on Subscribers to expand the tree.

2. Click on Add Subscribers to add a new subscriber. The following
window will display:

Figure C-21: Subscriber Add Window
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3. Enter the information about the new user.

Number -- This field indicates the subscriber number that will be
entered by the originating caller.

Name -- This field indicates the subscriber’s name.

COS -- This field is used for billing. If you have not yet added the
desired COS, type the name of the COS that you will create after you
add this subscriber.

Send Receipt to -- Type the phone number where a return receipt
should be delivered. If a receipt should not be sent, then leave this
field blank.

4. Continue to add subscribers to build up the list. You may go back and
edit or delete a subscriber by double-clicking on subscriber entries.

Class of Service
After entering the subscribers, click on Classes of Service to add a new
COS. Note that classes of service only control pricing.

Servers in Network
After administering Classes of Service, click on Servers in Network to list
the other PathFinder machines where you can send facsimiles. For Servers
in Network, you should add entries for each of the machines with which
this one will be communicating. Also, add a server named Default that
points to your current machine. This setting will be used if IFD cannot
find a remote server.

All servers should use IP Port 24 unless that port is unavailable.

Figure C-22: Server Add Window
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Phone Number Translations
This item list the translations that should be done on facsimiles being
delivered by this server. For example, if this server is located in Holland
and it will be handling facsimiles originating from the US, then the phone
numbers will be prefixed by 01131. But when people in Holland dial the
number locally, they do not need the 01131.

Therefore, the 01131 should be stripped off for local dialers only. You
can do that by adding a translation, as shown in the following window:

Figure C-23: Add Translation Window

You can include a new prefix if necessary. Only include numbers in the
translations.

The Servers in Network list does not specify when you send the
facsimiles. Those settings are controlled in the Fax Routing window.

When performing local dialing, the system uses the dialing prefixes
specified in MAINT.
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Facsimile Routing
This item lets you edit a table that indicates where facsimile messages
should be routed. The destination phone number is used to determine
which server should be used.

Figure C-24: Routing Table Window

Special characters ❊ and ? are used to indicate wildcards.

The ❊ key matches no digits as well as one or more digits.

The ? key matches a single digit.

The digits 0 through 9 are matched explicitly.
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General Settings

Figure C-25: General Settings Window

Facsimile Delivery Module Access
The next step is to give callers access to the facsimile delivery module.
This is usually done using a menu key off of a main or secondary menu.

To administer facsimile delivery module access, please follow these steps:

1. Run MAINT.

2. Select Edit > Menus from the menu bar.

3. Select a menu from the list that will be used to give callers access to
IFD.
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4. Double-click on Key 4. The following window displays:

Figure C-26: Key 4 Action Window

5. Select Run Module
6. Select the module name A!IFD.SUB, then choose one of the

following situations:

If you want the system to prompt for a subscriber number, leave
the Parameter field blank.

If you wish to predefine the subscriber number, type it in the
Parameter field.
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Usage
The server is started by running the IFD_SRV.EXE program. The following
window displays:

Figure C-27: Internet Fax Delivery - Server Window

As requests are processed by the server, the log information will appear.
The only operation available is to shut down the server.

Start a Facsimile Transmission
To start a facsimile transmission, perform the following steps:

1. Call into the PathFinder system from a facsimile machine.

2. Access the menu defined above.

3. Press the key associated with the A!IFD.SUB module.

4. Enter a subscriber number (if prompted).

5. Enter a destination number.

6. When prompted press Start on your facsimile machine.

After the system has delivered the facsimile, it will send a return receipt
back to the number indicated in the subscriber record.
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Troubleshooting
Depending on the problem, use the log files associated with PathFinder
and IFD to determine the problem. Bad IP addresses are the most typical
problems you will encounter.

Use Telnet and Ping to connect to remote systems and verify addresses.
Refer to “Is the server name correct?” on page C-72 for more information.

Onelook (Unified Messaging)

Onelook is PathFinder’s unified messaging solution. With Onelook, all of
your messages (voice, facsimile, and e-mail) can be retrieved from your
desktop.

Onelook gives you the ability to send and receive voice mail messages
through Microsoft Exchange or Microsoft Outlook. Instead of having to
dial into a phone system to retrieve messages, the messages will appear
in your desktop Inbox. You can archive messages and keep them
indefinitely without having to keep them in your voice mailbox.

With Onelook, you can also read facsimile messages that were received in
your voice mailbox through Onelook. Onelook has full synchronization,
which means that when you mark messages as read in your desktop
Inbox they will be marked as read in your voice mailbox as well.

In addition, if you delete a message in your Inbox, it deletes it from your
voice mailbox automatically.

In order to received facsimile messages via Onelook, you must have the
facsimile option enabled within Onelook.
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System Requirements

Server
These are the minimum requirements for the server PC to run Onelook:

PathFinder Release 6 or higher

Onelook capability in the software key

Onelook + Point to Point Server active on your Windows NT-based
voice processing computer

Valid IP addresses

Ability to run Ping between the clients and the server

Network:

Network Interface Card

LAN with TCP/IP protocol running

Client

These are the minimum requirements for the client PC to run Onelook:

Windows 95, 98, or later

Microsoft Outlook or Microsoft Exchange Version 5.0 or later

16 megabytes of RAM or greater

10 megabytes of free hard drive space

Sound-card

Speakers

Microphone

Network:

Network Interface Card (compatible with operating system)

TCP/IP connectivity to Onelook server

TCP/IP Networking Installed

All system components--both required equipment and optional
equipment--should be listed in the Microsoft Windows® Hardware
Compatibility List (HCL), which can be found on the Internet at http://
www.microsoft.com/hwtest/hcl. The HCL is a database of hardware,
classified by function.



Onelook (Unified Messaging) C-57
Synchronization in Onelook
Onelook includes a synchronization feature that ensures that your Inbox
and voice mailbox are always synchronized. Whenever you delete a
message from your voice mailbox it will also be deleted from your Inbox.
Likewise, if you delete a message from your Inbox, the message will also
be deleted from your voice mailbox.

However, it should be noted that while messages deleted from your
Inbox are immediately synchronized, any messages that you delete from
your voice mailbox are only deleted from your Inbox once you restart
Outlook or Exchange.

Onelook messages are deleted from your voice mail if they are moved to
the Deleted Items folder. You will not be able to recover the deleted
message in your voice mailbox, but if the message was deleted by
accident, you will be able to move it from the Deleted Items folder back
to another folder.

Marking a message as either “read” or “unread” in Exchange or Outlook
will cause the message to be marked as, respectively, “saved” or “new” in
your mailbox.

Installation & Configuration
There are two parts to the Onelook installation process: the server
installation and the client installation. The system administrator will
install the server portion of Onelook, while the end user will need to
install only the client portion.

Server PC
Onelook software is installed along with your PathFinder software. You
also must configure the Onelook + Point to Point server before using
Onelook.

Read messages in Inbox are never synchronized. This means that if you
listen to a message in Inbox and then delete it through voice mail, that
message will not be deleted from Inbox. To completely remove the
message (from both your voice mail and Inbox), you must manually
delete it from Inbox and the voice mailbox.
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Installation
To install Onelook, run SETUP.EXE as described in the System
Administrator Manual. If Onelook + Point to Point Server is already installed,
then installation is not required.

Configuring the Onelook + Point to Point Server
1. Use notepad.exe to edit the \HELLONT\NTMAIL.INI file.

2. Make sure the following settings are correct:

[HELLONT]

LocalMessagesDirectory=C:\HELLONT\messages

TelnetPort=23

login=HELLONT

password=hnttelnet

3. Place a shortcut to \HELLONT\NTMAIL.EXE in your Start-Up group.

Client PC
As part of Onelook client installation, the following components will be
installed:

Voice Form server

Facsimile Form server

Installation
To install Onelook on a client PC:

1. Make sure all programs are closed.

2. Run the program in the ONELOOK CLIENT INSTALL directory. The name
of this program could vary depending on what version of Onelook
Client you have on your CD.

If you have Point to Point messaging installed, you do not need to
perform the server installation described in this section. Do not try to
install the server portion of Onelook on a system that already has Point
to Point messaging installed.
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3. After the installation program has finished copying the program files
to your hard drive, the following window displays.

Figure C-28: Onelook Service Provider Window (blank)

4. Fill in the Server Name field. You can get this information from your
Network Administrator. This is either a name served network system
name (e.g., xyz.com), or a numeric H-port IP address (e.g.,
192.6.1.50).

5. In the User Information section, enter your mailbox number. This is
the same as your voice mail number. For example, extension 1256 has
the mailbox number 1256.

6. Next, enter your password. This is the same as your voice mail
password (for example, 1234).

7. Enter an interval time. The interval time is the delay between
successive checks by Onelook for new messages.
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It is recommended that you choose a value of 300 seconds or higher.
If you set the interval too small, your system will check for mail all the
time and will slow down significantly.

8. When you have entered the required information, the Onelook Service
Provider window displays. It should look something like this:

Figure C-29: Onelook Service Provider Window (complete)

9. Click on OK to close the Onelook Service Provider window.

Configuration

1. After the setup program is complete, open Outlook (the Inbox icon
on your desktop). If you are only running Exchange and not Outlook,
you can skip this step.

2. From the Tools menu, select Options.
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3. In the Options window, click on the E-mail button. Be sure that the
Onelook Service Provider option is selected.

Figure C-30: Outlook Options Window

Using Onelook
In Onelook, you can choose to not dial into the voice mail system
whenever you have a new message waiting (most PBXs have a flashing
“New Message” light on the phone). Instead, wait for Onelook to
automatically download all new messages or press F5 in Outlook or
Ctrl+M in Exchange to have them downloaded immediately.
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In both situations you will get a New Mail icon in the taskbar (shown
below) letting you know that there are unread or unheard messages
waiting.

Figure C-31: New Mail Icon

Voice Messages

Once you launch a voice message by double-clicking on it in Outlook or
Exchange, the following Message Management window will display:

Figure C-32: Message Management Window
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The buttons in the top left portion of the window allow you to do the
following:

Delete the current voice message

Reply with a voice message

Forward the current voice message

Go to the next message

Go to the previous message

Show a version information window in Exchange or Outlook

The four fields tell you:

From -- From whom the message has been sent

Sent -- When the message was sent

To -- To whom the message was sent

Subject -- The subject of the message

The message slider bar shows the current position within the voice
message.

The time range at the bottom of the window shows the current
position within the voice message in seconds. The bottom text line
indicates how many seconds of the message are equal to one tick
mark.

Replying to a Voice Message
The following are the steps for replying to a voice message with another
voice message:

1. Open the message you want to reply to by double-clicking on it in
Outlook or Exchange.

The Subject and From fields can be changed to reflect what the
message is about and who the message was from. These fields are
saved in Exchange or Outlook when you close the form. This
process helps make it easier to locate an important facsimile
quickly.
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2. Once it is open press the Reply button at the top of the window. This
will change the form into a reply window

.

Figure C-33: Message Management Window

3. Press the record button to record a voice message with a
microphone.

4. After recording your message you can listen to it by pressing the play
button.

5. If you want to re-record your voice message just repeat step 3 again.

6. Before you send the message, fill in the To: field. The address format
for this is <mailbox>@<server> (for example,
1234@esimail.com).

7. Fill in the subject line and your name in the From: field.

8. Send the message by pressing the Send Message button, and your
message will be sent.
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Forwarding a Voice Message
The following are the steps for forwarding a voice message to another
mailbox:

1. Open the message you want to forward by double-clicking on it in
Outlook or Exchange.

2. Once it is open, press the Forward button at the top of the window.
This will change the form to a Forward window.

Figure C-34: Onelook Voice Message Viewer Window

3. Press the Record button to record a voice preamble with a
microphone.
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4. After recording your message you can listen to it by pressing the Play
button.

5. Before you send the message, fill in the To: field. The address format
for this is <mailbox>@<server> (for example,
1234@esimail.com).

6. Fill in the subject line and your name in the From: field.

7. Send the message by pressing the Send Message button, and your
message will be sent.

Creating a New Voice Message
The following are the steps for creating a new voice message:

1. Open Outlook or Exchange.

2. Next, select New Form from the Compose menu in Exchange or
Choose Form from the Compose menu in Outlook.

You cannot re-record a preamble. If you want to do this, you must
close the current message and return to Step 1.
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3. The following window displays. Select the type of form you wish to
create, then click on OK.

Figure C-35: New Form Selection Window
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A blank message window displays.

Figure C-36: Onelook Voice Message Viewer Window

4. Fill in the From and Subject fields.

5. Address the message <mailbox>@<server>
(1234@esimail.com, for example).

6. Press the Record button to record a message with a
microphone.

7. Press the Send Message button, and the message will be sent.



Onelook (Unified Messaging) C-69
Facsimile Messages

Once you launch a facsimile message by double-clicking on it in Outlook
or Exchange, the following window displays:

Figure C-37: Onelook Fax Message Viewer

In order to receive facsimile messages via Onelook, you must have the
facsimile option enabled within Onelook.



C-70 Onelook (Unified Messaging)
The buttons in the top left-hand portion of the window allow you to
do the following:

Print a current facsimile message

Delete a facsimile message

Go to the next message

Go to the previous message

Show a version information window in Exchange or Outlook

The four fields tell you:

From -- From whom the message has been sent

Sent -- When the message was sent

To -- To whom the message was sent

Subject -- The subject of the message

You can move the image within the window by dragging the mouse
on it. This is especially useful when zoomed in on a facsimile.

The Fit to Window button can be used to resize the image to the
window after zooming or moving.

The Full Screen button allows you to look at a facsimile in full screen
mode. This mode is best for reading facsimile messages on screen.

On multi-page facsimiles, the Next Page and Prev Page buttons let
you navigate through pages.

The Subject and From fields can be changed to reflect what the
message is about and who the message was from. These fields are
saved in Exchange or Outlook when you close the form. This
process helps make it quicker and easier to locate an important
message.
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Archiving Messages using Onelook
A good way to archive voice mail messages and facsimiles is to create an
Archive folder under the Inbox folder, as shown in the following window:

Figure C-38: Archive Folder Setup (in Outlook)

When you are finished with a new message, archive it by dragging it from
the Inbox folder to the Archive folder. If you want to copy the message
instead of moving it, you can hold down the Ctrl key before dropping it
into the Archive folder.

Files in the Archive folder are never synchronized. However, if you delete
a Onelook message from the Archive folder, Onelook will delete it from the
voice mailbox (if it still exists there). This technique can be used to keep
your important messages in Outlook or Exchange indefinitely. It is also
recommended that you change the Subject and From fields in the
messages you want to archive so you can find a message quickly.

Create an archive folder by clicking on Inbox in the left pane and then
selecting the New Folder option from the File menu in Exchange, or by
selecting Folder > Create Subfolder from the File menu in Outlook.
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Troubleshooting

Service Provider window keeps displaying
The server name, mailbox number, or password is not correct and could
not be validated. This may also be caused by the network being down or
the server not running PFMAIL.

Is the server name correct?
There are two utilities on your system that can help you find this
information: Ping and Telnet.

Ping
Go to a DOS prompt and type ping <servername> (for example,
ping esivmail).

If Ping returns the message Bad IP address, then the server is
not known. You can get the correct Onelook server name from your
network administrator.

If the response from Ping is Request timed out, then the
network or server may be down.

Telnet
The second utility will help you if the first one was completed
successfully. At the DOS prompt, type telnet.exe <servername> 
10710. Watch for the following line within a few seconds:

+OK UMP POP3 VPOP Server ready.Version 24, UMP/
0.10)

If this line does not display, then you may have a problem with the
Onelook + Point to Point Server. The most likely reason for this is that the
Onelook + Point to Point Server is down. Talk to your system administrator
for further assistance.

Why don’t I receive any Onelook messages in Outlook?
The server is down. See the “How can I find out if the server name is
correct” question above.
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My messages are not synchronized
The server is down. See the “How can I find out if the server name is
correct” question above.

Outlook or Exchange Locks Up
In other words, when you open Outlook or Exchange and then click on the
Tools menu item, Outlook or Exchange locks up for a few seconds.

This is normal. Outlook or Exchange launches all message services when
you click on the Tools menu. If you do not click on the menu right away,
the services are launched in the background and the mail client will not
lock up.

Recorded voice message playback is not easily audible
Make sure that the volume control for the microphone is at its highest
volume. You can check this by doing the following:

1. Double-click on the speaker icon in the notification area of the task
bar.

2. Select Options > Properties from the menu bar.

3. In the Adjust volume for pane, make sure Recording is selected, and
make sure that the Microphone option is selected in the list box.

4. Click on OK.

5. Make sure the volume level for the microphone is as loud as possible.

Now, when you record, you should have better results. If this does not
help, you may want to try using a different microphone.

Onelook + Point to Point Server

Onelook + Point to Point Server is an optional software component of
PathFinder. Onelook + Point to Point Server is required to support either
Point to Point messaging between PathFinder systems or Onelook unified
messaging for Microsoft Outlook/Exchange/Inbox desktop clients.
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Onelook + Point to Point Server supports Point to Point messaging
between PathFinder systems in one of the following ways:

By sending local PathFinder messages outbound over a TCP/IP
connection to a remote PathFinder system based on remote mailbox
address as configured by MAINT.

By receiving remote PathFinder messages inbound over a TCP/IP
connection from a remote PathFinder system and depositing them in
the appropriate local mailbox.

Refer to “Point To Point Messaging” on page C-84 for more details on these
processes.

Onelook + Point to Point Server supports Onelook Unified messaging
clients by supporting a POP/SMTP interface to the local PathFinder
message store. It feeds outbound messages and accepts inbound
messages from Onelook client systems. Refer to “Onelook (Unified
Messaging)” on page C-55 for more details on these processes.

Requirements
Onelook + Point to Point Server requires the following:

PathFinder release 6 or higher

Dedicated TCP/IP access (used for transport) for Point To Point
messaging

TCP/IP access for Onelook unified messaging clients.

Onelook + Point to Point Server activation code for the software
controller key

All system components--both required equipment and optional equipment-
-should be listed in the Microsoft Windows® Hardware Compatibility List
(HCL), which can be found on the Internet at http://www.microsoft.com/
hwtest/hcl. The HCL is a database of hardware, classified by function.
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Installation
Onelook + Point to Point Server should be installed from the PathFinder
CD-ROM by selecting either Point To Point messaging or Onelook Unified
messaging. If necessary, run the PathFinder installation program and
select the Onelook + Point to Point Server option.

Once installed, Onelook + Point to Point Server is made up of the following
files:

\HELLONT\HNTMAIL\HNTMAIL.EXE: This is the Onelook + Point to
Point Server program. This program sends and receives point to point
messages for the local PathFinder server, and sends and receives
messages for Onelook Unified messaging clients.

\HELLONT\HNTMAIL\HNTMAIL.INI: This is the Onelook + Point to
Point Server settings file. It contains all the configuration settings that
control how HNTMAIL.EXE operates.

\HELLONT\HNTMAIL\LOGS\❊.LOG: Onelook + Point to Point Server
creates a log file of operations for each day, beginning at midnight.

Setup & Configuration
Once the software is installed, configuration changes may be made to
Onelook + Point to Point Server by editing the \HELLONT\HNTMAIL.INI file
(no configuration program currently exists).

The following are the Onelook + Point to Point Server sections and settings
(along with their defaults) that can be configured in the HNTMAIL.INI file.

POP

Port=10710TCP/IP port that Onelook + Point to Point Server listens for
inbound Onelook connections.

Enabled=TrueWhether POP service is enabled.

MaxConnections=5Maximum simultaneous POP connections
allowed.

Be sure to create a backup of your HNTMAIL.INI file before making any
modifications, as an incorrect modification can cause PathFinder to
behave erratically.
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LogEnabled=TrueWhether POP logging is enabled in general
(master log switch).

LogCommands=FalseWhether POP commands are logged.

LogSocket=FalseWhether POP socket operations are logged.

LogUserLogin=TrueWhether POP user logins are logged.

LogUpdt=TrueWhether POP updt commands are logged.

LogDele=TrueWhether POP dele commands are logged.

LogRetr=TrueWhether POP retr commands are logged.

LogUIDL=FalseWhether POP uidl commands are logged.

LogTop=FalseWhether POP top commands are logged.

Logs

MaxLogAgeDays=45Max age (days) before old log files are purged
at midnight.

SMTPIn
Port=10725TCP/IP port that Onelook + Point to Point Server listens for
SMTPIn connections.

Enabled=TrueWhether SMTPIn service is enabled.

MaxConnections=5Maximum simultaneous SMTPIn connections
allowed.

ResponseTimeout=30Maximum time for SMTPIn command/
response before disconnect.

LogEnabled=TrueWhether SMTPIn logging is enabled in general
(master log switch).

LogSocket=FalseWhether SMTPIn socket operations are logged.

LogMessage=TrueWhether SMTPIn message file operations are
logged.

LogQueue=TrueWhether SMTPIn queue operations are logged.
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SMTPOut
DefaultRemotePort=10725 Default TCP/IP port used for send to
remote system.

Enabled=True Whether SMTPOut service is enabled.

QueueDirectory=c:\HELLONT\hntmail (Directory for local SMTPOut
queue database files).

LogEnabled=True Whether SMTPOut logging is enabled (master log
switch).

LogSocket=False Whether SMTPOut socket operations are
logged.

LogRequeue=True Whether SMTPOut message requeue
operations are logged.

LogMessage=TrueWhether SMTPOut message operations are
logged.

RetryMaxTries=100Maximum number of retries to send a message
to remote system.

RetryInterval=00:05HH:MM retry interval after failed attempt to
send SMTPOut message.

SleepSeconds=300Seconds to sleep after end of outbound message
send cycle.

ResponseTimeout=30Maximum time for remote SMTP system to
respond before disconnect.

HELLONT
LocalMessagesDirectory=c:\HELLONT\messagesDirectory for local
PathFinder message store.

LocalDbaseDirectory=c:\HELLONT\dbaseDirectory for local
PathFinder database store.

EngineIPAddress=Name address of PathFinder if PathFinder and
Onelook + Point to Point Server are not running on the same system.

TelnetPort=23TCP/IP port to connect to local PathFinder.
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Login=PathFinder telnet login name to use.

Password=HNTELNET telnet login password to use.

Usage
Once started, Onelook + Point to Point Server has a main status display
window that indicates which services are started (SMTP-In, SMTP-Out,
POP).

Figure C-39: Main Mailer Window

These services should normally all be started.



Onelook + Point to Point Server C-79
Guidelines
Click on the Enable/Disable check boxes to enable or disable
service(s).

The Red/Green indicators for Messages or Logs indicate whether disk
space is available.

Other informational fields indicate the current status of each service.

To watch the operation of an individual service (SMTP-In, SMTP-Out,
POP), select File > Status from the menu bar to bring up the
Connection Status window. Refer to “Connection Status” on page C-79
for more information.

Connection Status

The Connection Status window has tabs in which you can select the
service you want to look at: SMTP-In, SMTP-Out, POP, or all service
operations interleaved together chronologically (Master). These log
windows (combined or separate) can be used to monitor or troubleshoot
the operation of Onelook + Point to Point Server.
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SMTP-In
Click on the SMTP-In tab to see the following window:

Figure C-40: Connection Status SMTP-In Window

The SMTP-In tab of the Connection Status window allows you to view all
incoming SMTP activity including incoming mail messages.
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SMTP-Out
Click on the SMTP-Out tab to see the following window:

Figure C-41: Connection Status SMTP-Out Window

The SMTP-Out tab of the Connection Status window allows you to view all
outgoing SMTP activity including outgoing mail messages and login
attempts.

The SMTP-Out service is used to deliver messages that Onelook + Point to
Point Server has received to mail to another system. The SMTP-Out queue
is where message delivery requests are queued up until successfully
delivered. The purpose of this display is to allow an operator to observe if
messages are arriving and being delivered effectively, or if they are
backing up because of delivery problems.

To access the SMTPOut Queue window, go back to the main menu and
select SMTP-Out > Queue from the menu bar.
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POP
Click on the POP tab to see the following window:

Figure C-42: Connection Status Pop Window

The POP tab of the Connection Status window allows you to monitor
activity on incoming and outgoing messages from the Onelook client
systems.

Onelook + Point to Point Server supports PathFinder’s Onelook unified
messaging optional module. The POP service handles Onelook client
requests for current message status inside PathFinder and delivers the
body of messages to the Onelook client programs for use on the client
systems. Onelook + Point to Point Server controls the number of users that
are authorized to use Onelook by keeping track of the current users who
have “leases” to use Onelook.

The POP/Onelook Lease status window can be retrieved by going back to
the main menu and selecting POP > Leases from the menu bar.
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Master
Click on the Master tab to see the following window:

Figure C-43: Connection Status Master Tab

The Connection Status window’s Master tab allows you to view all activity
on the system interleaved chronologically.

Troubleshooting
Examine log files in \HELLONT\HNTMAIL\LOGS\❊.log

Make sure TCP/IP is installed.

Make sure [HELLONT] section settings in
\HELLONT\HNTMAIL\HNTMAIL.INI are correct.

Make sure all services (SMTPIn,SMTPOut,POP) are enabled in
\HELLONT\HNTMAIL\HNTMAIL.INI.

Make sure PathFinder Engine (HELLONT.EXE) is running.
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Make sure remote PathFinder systems are running correctly (for Point
To Point).

Make sure Onelook clients are installed and configured correctly (for
Onelook unified messaging).

Make sure Onelook clients have the correct TCP/IP name or address
for the HELLONT/HNTMAIL system.

Make sure enough Onelook leases are enabled on software controller
key for active Onelook clients.

Point To Point Messaging

This section of the manual contains material related to the optional Point
to Point messaging capabilities of PathFinder. With Point to Point
messaging, two or more PathFinder systems can transport messages
using any TCP/IP network. This capability allows low cost messaging
between multiple sites. Since PathFinder does not use voice lines for
delivery, there is relatively little cost involved with sending the messages
– regardless of the destination.

While PathFinder serves very well as a stand-alone voice processing unit,
it also can be networked with other PathFinder implementations over any
TCP/IP link, including the Internet. With the optional Point to Point
messaging module, PathFinder is able to use store-and-forward to deliver
messages intended for remote mailboxes, effectively extending its
operations anywhere in the world.
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Features
Features of Point to Point messaging include:

Voice messages -- anonymous originate, subscriber originate,
forward and reply.

Facsimile messages -- anonymous originate, subscriber forward.

Multiple remote sites -- Limited only by length of area code chosen.

Easy to remember “area code” metaphor used for addressing remote
sites.

Multiple COS settings for each remote location.

Requirements

The following are the requirements for Point to Point messaging:

PathFinder Release 6 or higher

Point to Point capability in the software key

PathFinder Mailer software included in both Point to Point and
Onelook messaging

Information on the remote systems: IP addresses; mailbox lengths

Network: Network Interface Card (must be on the Windows NT 4.0
HCL)

TCP/IP:

Connectivity between Windows NT-based processing sites

Network connection (WAN, LAN, etc.) with TCP/IP protocol
running

Dedicated, full-time TCP/IP connectivity to the other sites. This is
required so that the PathFinder sites can transport the messages
on demand.

All system components--both required equipment and optional
equipment--should be listed in the Microsoft Windows® Hardware
Compatibility List (HCL), which can be found on the Internet at http://
www.microsoft.com/hwtest/hcl. The HCL is a database of hardware,
classified by function.
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Valid IP addresses

Ability to run Ping between the servers that make up the Point to
Point network

Installation
Point to Point Messaging is installed from the PathFinder installation CD
by selecting the Point to Point component. If you did not install Point to
Point along with PathFinder, it may be necessary to run the PathFinder
installation program and select Point to Point.

Configuration
To configure the Point to Point voice mail system, follow these steps:

1. From the Start menu, select Programs > Hello! Voice Processing >
MAINT.

2. From the menu bar, select Configuration > Point to Point Settings.

Figure C-44: Point to Point Settings Window

Do not install the server portion of Point to Point messaging on a
system that already has Onelook/Unified messaging installed. You
need only to change the configuration as described in the “Configuring
Voice Mail” section of this appendix.
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3. Configure this window as follows:

Enable Point to Point Messaging -- Check to enable outbound Point to
Point messaging. Even when not enabled, the system can still receive
inbound messages. The Onelook + Point to Point Server needs to be
running in order for any messaging to occur.

Area Code Length -- Enter the length, in digits, that area codes will be
on this system. A typical value is three. If you only have nine sites, you
can use a one-digit area code. Maximum area code length is seven.

Remote Locations -- This list box contains the remote locations to
which this system can send messages. Use the Add, Edit, and Delete
buttons to maintain this list.

Mailer Address and Port -- Enter the IP address and port where the
Onelook + Point to Point Server application is running. This is usually
the same system. The port number for the Onelook + Point to Point
Server’s SMTP services is usually 10725. If you wish to change this (for
firewall reasons), make sure that you change the settings in the
PFMAIL.INI file and the remote locations that are going to send
messages to this machine. Enter the machine name, plus a colon,
followed by the port: <machine>:<port>.

Event Group -- This is the event group that the voice mail system will
use to send messages to the Onelook + Point to Point Server. The
typical group is 6. Make sure that at least one channel is set to handle
these messages.

Retry Delay -- When the voice mail module can not connect to the
Onelook + Point to Point Server, this field indicates how long before it
retries.
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4. Select Add to add locations. The following window displays:

Figure C-45: Point to Point Location Settings Window

5. Configure this window as follows:

Description -- For each location, enter a descriptive title.

Area Code -- For outbound messages, this is the prefix area code that
callers will enter. For example, if the remote system has a mailbox
number 1234, and the area code for that system is 770, then the caller
would enter 7701234.

Mailbox Length -- Enter the length of the mailbox on the remote
system. The voice mail module uses this number to validate the
remote mailbox.
Examples:
If the area code length is 3 and the mailbox is length 4, and the caller
enters 7701234, then PathFinder looks up system 770 from this list
and will deliver to mailbox 1234 on that system.
If the area code length is 3 and the mailbox length is 3, but the caller
enters 7701234, then PathFinder looks up system 770 from the list
but will return an error because a mailbox number of 1234 has a
length of 4 digits rather than the three digits required by the system.

IP Address and Port -- These two fields contain the IP name and port
of the remote system’s Onelook + Point to Point Server. Almost all
Onelook + Point to Point Servers use port 10725.
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1. From the menu bar in the main MAINT window, select Edit > Class Of
Service.

2. Click on Create.

3. In the COS Name field, type PTP_xxx (where xxx is the area code
for your first remote site).

4. Edit the COS to match the settings for the first remote system.

5. Repeat this for the other sites.

Using Point to Point Messaging
Once the installation and setup/configuration steps have been
completed, subscribers can use Point to Point messaging.

Test
The quickest way to demonstrate Point to Point’s capabilities is to
complete the following test procedure:

1. Call in to PathFinder.

2. Access a mailbox’s owner functions.

3. Press 2 to send.

4. Record the message, then press 1 to accept.

5. Enter the remote mailbox location number.

6. Enter the area code.

7. Enter the mailbox number, then press #.

8. Press # to confirm.

9. Press # to stop send.

10. Wait approximately one minute while the message is sent.

11. Call into the remote system.

12. Access the mailbox number to which the message was sent.

13. Press 1 to hear message.

14. After listening to the message, press 5 to reply.

15. Listen to the address.

16. Press # to confirm.
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Troubleshooting
If messages are not being delivered, use the following methods to
diagnose and solve the problem:

Make sure that the two systems are both running PathFinder and
PathFinder Mailer.

Diagram the IP names and ports for all the connections.

Use telnet.exe to connect to the PathFinder Mail and PathFinder
Monitor applications.

Check the passwords for consistency.

Use Ping to see if one system can “see” another.

Refer to “Check Logs” on page C-90.

Check Logs

You can check logs as follows:

Message is sent from a subscriber’s mailbox to another system:

C 17:18:59.803 01 H!DBASE  Info: Remote location, code=771 mail-
box=1221 address=esihello port=10725.

C 17:18:59.803 01 H!DBASE  Info: Remote Address <1221@771 Ia1221@es-
ihello:10725>.

C 17:19:06.853 01 Log: VMail 100 Voice Send to Rm1221@771 with 
OrVI100.JG6 Sr100@skelly_nt_a:10725 To1221@771 Ia1221@esihello:10725
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Local Onelook + Point to Point Server receives the message from
PathFinder:

17:25:03 02/12 17:25:03 SMTPIn:  c:Waiting on connection.

17:25:05 02/12 17:25:05 SMTPIn:  [1]  <-- HELO skelly_nt_a:10725

17:25:05 02/12 17:25:05 SMTPIn:  [1]  --> 250 Nice to meet you 
SKELLY_NT_A:10725

17:25:06 02/12 17:25:06 SMTPIn:  [1]  <-- MAIL FROM:100@esisys.com

17:25:06 02/12 17:25:06 SMTPIn:  [1]  --> 250 OK Mail From:100@ESI-
SYS.COM

17:25:07 02/12 17:25:07 SMTPIn:  [1]  <-- RCPT TO:100@esisys.com

17:25:07 02/12 17:25:07 SMTPIn:  [1]  --> 250 OK Rcpt To:100@ESISYS.COM

17:25:08 02/12 17:25:08 SMTPIn:  [1]  <-- DATA H!NTOut VT100.U66

17:25:08 02/12 17:25:08 SMTPIn:  [1]  --> 250 OK H!NTOut Data VT100.U66

17:25:09 02/12 17:25:09 SMTPIn:  [1]  <-- QUIT

17:25:09 02/12 17:25:09 SMTPIn:  [1]  --> 221 Bye.

17:25:09 02/12 17:25:09 SMTPIn:  [1]  --> xxx Connection closed.
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Local PathFinder Onelook + Point to Point Server connects to a remote
site and delivers a message:

17:25:15 02/12 17:25:15 SMTPOut: Connect To ESIHELLO:10725

17:25:15 02/12 17:25:15 SMTPOut: Recv <220-H!NT/UMP Gateway SMTPIn>

17:25:15 02/12 17:25:15 SMTPOut: Recv <220-ESMTP spoken here>

17:25:15 02/12 17:25:15 SMTPOut: Recv <220 UMP/1.0 spoken here>

17:25:15 02/12 17:25:15 SMTPOut: UMP Spoken on other end.

17:25:15 02/12 17:25:15 SMTPOut: --> EHLO

17:25:15 02/12 17:25:15 SMTPOut: Recv <250-XUMP>

17:25:16 02/12 17:25:16 SMTPOut: Recv <250 Hello >

17:25:16 02/12 17:25:16 SMTPOut: --> MAIL FROM:100@SKELLY_NT_A

17:25:16 02/12 17:25:16 SMTPOut: Recv <250 OK Mail From:100@SKELLY_NT_A>

17:25:16 02/12 17:25:16 SMTPOut: --> RCPT TO:1221@ESIHELLO

17:25:16 02/12 17:25:16 SMTPOut: Recv <250 OK Rcpt To:1221@ESIHELLO>

17:25:16 02/12 17:25:16 SMTPOut: --> DATA 15642

17:25:16 02/12 17:25:16 SMTPOut: Recv <354 UMP accepting 15642; end with 
<CRLF>.<CRLF>>

17:25:16 02/12 17:25:16 SMTPOut: --> X-UMP-ID: xxxxxx.xxx

17:25:16 02/12 17:25:16 SMTPOut: --> X-UMP-Category: Voice

17:25:16 02/12 17:25:16 SMTPOut: --> X-UMP-Status: 

17:25:16 02/12 17:25:16 SMTPOut: --> X-UMP-Flags: 

17:25:16 02/12 17:25:16 SMTPOut: --> X-UMP-Size: 0:00:05

17:25:16 02/12 17:25:16 SMTPOut: --> X-UMP-Priority: 3

17:25:16 02/12 17:25:16 SMTPOut: --> To: 

17:25:16 02/12 17:25:16 SMTPOut: --> From: 

17:25:16 02/12 17:25:16 SMTPOut: --> Date: 

17:25:16 02/12 17:25:16 SMTPOut: --> MIME-version 1.0

17:25:16 02/12 17:25:16 SMTPOut: --> Content-type: audio/adpcm
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17:25:16 02/12 17:25:16 SMTPOut: --> Content-length: 15408

17:25:16 02/12 17:25:16 SMTPOut: --> Content-encoding: Binary

17:25:16 02/12 17:25:16 SMTPOut: --> 

17:25:16 02/12 17:25:16 SMTPOut: --> 

17:25:16 02/12 17:25:16 SMTPOut: --> .

17:25:16 02/12 17:25:16 SMTPOut: Recv <250 VT1221PGC Message accepted 
for delivery.>

17:25:16 02/12 17:25:16 SMTPOut: --> QUIT

17:25:16 02/12 17:25:16 SMTPOut: Rename VT100.U66 to VD100.U66

17:25:16 02/12 17:25:16 SMTPOut: SENT:    02/12/97 17:25  100@ESI-
SYS.COM:0 VT100.U66
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Remote Onelook + Point to Point Server receives a message and sends
to remote PathFinder:

17:20:55 02/12 17:20:55 SMTPIn:  [1]  <-- EHLO

17:20:55 02/12 17:20:55 SMTPIn:  [1]  --> 250-XUMP

17:20:55 02/12 17:20:55 SMTPIn:  [1]  --> 250 Hello 

17:20:56 02/12 17:20:56 SMTPIn:  [1]  <-- MAIL FROM:1221@ESIHELLO

17:20:56 02/12 17:20:56 SMTPIn:  [1]  --> 250 OK Mail From:1221@ESIHELLO

17:20:56 02/12 17:20:56 SMTPIn:  [1]  <-- RCPT TO:100@SKELLY_NT_A

17:20:56 02/12 17:20:56 SMTPIn:  [1]  --> 250 OK Rcpt To:100@SKELLY_NT_A

17:20:56 02/12 17:20:56 SMTPIn:  [1]  <-- DATA 12582

17:20:56 02/12 17:20:56 SMTPIn:  [1]  --> 354 UMP accepting 12582; end 
with <CRLF>.<CRLF>

17:20:56 02/12 17:20:56 SMTPIn:  c:Waiting on connection.

17:20:56 02/12 17:20:56 SMTPIn:  [1]  <-- 

17:20:56 02/12 17:20:56 SMTPIn:  [1]  <-- .

17:20:56 02/12 17:20:56 SMTPIn:  [1]  --> 250 VT100KKP Message accepted 
for delivery.

17:21:04 02/12 17:21:04 SMTPOut: AddHNTEvent :23 <Addevent " " " " 
"MmNmVT100.KKP" "1">

17:21:05 02/12 17:21:05 SMTPOut: QUIT Response <-- 250 Command Accepted

17:21:05 02/12 17:21:05 SMTPOut: SENT:    02/12/97 17:20  100:0 VT100.KKP

17:21:26 02/12 17:21:26 SMTPIn:  [1]  <-- xxx connection closed (by Re-
mote?).

17:21:26 02/12 17:21:26 SMTPIn:  [1]  --> xxx Connection closed.

17:21:26 02/12 17:21:26 SMTPIn:  [1]  <-- xxx connection closed (by Re-
mote?).
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Remote PathFinder delivers the message:

TeleQueue

TeleQueue gives PathFinder Automatic Call Distributing (ACD) features.
With TeleQueue you can create 1,000 call queues that callers can access.
Each queue has its own unlimited list of possible extensions and
associated prompt and help files. With TeleQueue, you can select for
callers waiting to do one of the following:

Be connected to hear pre-recorded prompt files

Be placed on hold and hear music from your phone system

Hear pre-recorded music provided by PathFinder

Wait

At any time before transferring begins, a caller may elect to exit the
queue and be placed in a menu. From there the system administrator can
do many things, including taking a voice message through voice mail or
transferring to an operator. Each queue also has the ability to send the
caller to a predefined Auto Attendant extension if all extensions in the
queue list are ring no-answer. This is especially useful for after hours.

Requirements
To set up TeleQueue you need to do the following things:

Make sure PathFinder is installed properly and is functioning
correctly.

Make sure the TeleQueue support is activated in the key.

Add the necessary parameters for each queue in the registry.

A 18:24:54.569 -- tcpin: login U=[HELLO] P=[HNTELNET]
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Allow a caller to get to the queue by using a menu, or by answering
the telephone with TeleQueue.

There are no additional system requirements to run TeleQueue.

Getting Started
The TeleQueue files are installed as part of the Release 6 install. No other
files are required.

To set up TeleQueue, you must create the necessary registry entries for
the queue or queues that you intend to use. To modify the registry, go
into MAINT, and select Configuration > Registry > Registry
Maintenance > Create Registry Item. Each registry item has a name and a
value associated with it. When you create a registry item, just fill in the
Name and Value fields and press the Enter key for all the other fields.

TeleQueue Registry
All TeleQueue items in the registry start with “Tq” to make them easier to
find. The following is a list of TeleQueue items and what they do. When
you create the item, give it a name and a value. Examples are listed in
each item entry.

Registry Items
The following registry items assume “0000” as the queue name.

All system components--both required equipment and optional
equipment--should be listed in the Microsoft Windows® Hardware
Compatibility List (HCL), which can be found on the Internet at http://
www.microsoft.com/hwtest/hcl. The HCL is a database of hardware,
classified by function.

You may want to enter a description to make things clearer when you
view the registry list.



TeleQueue C-97
Tq0000Desc
A description line. Not used by the system, but provided for clarity. This is
a mandatory item, and it must be included for each queue.

Tq0000LstExt
The last extension PathFinder transferred to. This allows the callers to be
sent to the extensions in a linear order, so that all extensions will have an
equal chance of receiving the same number of calls. When setting up a
queue, just leave this line blank. This is a mandatory item.

Tq0000HldTyp
Hold type. While a person is waiting to be moved to the front of the line
you can do three things with the call. First, you can do nothing and just
tell TeleQueue how long to do it. This is called “sleeping” and is
designated by an S followed by the number of seconds to sleep before
checking the position in the queue. S10 would check the queue and
confirm that the caller wants to stay every 10 seconds. A number like 30 is
probably more reasonable.

Another type of holding is to do a hold using the phone system's hold
features. If TeleQueue is told to hold, then PathFinder would dial a
“transfer start,” then sleep for the designated number of seconds and
then dial the “ring no-answer abort” sequence. The letter H is used,
followed by the number of seconds to hold. For example, H30 would tell
TeleQueue that the caller should be put on a phone system hold for 30
seconds.

The final method of holding is for TeleQueue to play hold files. If a P is
specified and there are not any files recorded, TeleQueue plays the
canned message TQ_MUSIC.VOX. You can record any number of
consecutive prompt files. The file names for our test queue 234 would be
TQ234.1, TQ234.2, TQ234.3, and so on. When TeleQueue gets to the end
it replays the first message.

Tq0000HlpFls
Are help files allowed? Help files allow the caller to enter a four-digit
prompt number while listening to other prompt files. For example, if a
caller was listening to TQ234.2, he could then press “4567#” and
TeleQueue would play TQ4567.VOX.
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If these help files are recorded with the correct information, you could
help the caller without ever sending them to an extension. Set the fourth
line to a 0 to turn this ability off or to a 1 to allow it. If it is turned off then
TeleQueue ignores the keys.

Tq0000Menu
Name of the menu to run when the caller presses 0. Make sure the menu
exists. If it does not, PathFinder will disconnect the caller. In PathFinder
Release 5.0, the menus can Branch to other menus, time controls, etc.

Tq0000LstRsrt
Last resort extension. This is an extension number that must exist in the
Auto Attendant database. After TeleQueue goes through all extensions
and finds them all “ring no answer”, it will transfer control to this
extension. If you do not have an extension on this line or it is invalid then
TeleQueue will continue through the list.

Tq0000Loops
Number of loops through the EXT file before asking the caller to verify
that they wish to stay in the queue. If you only have one extension in the
EXT file (possibly a hunt group on your phone system) then you will want
this number to have a value of at least three. This is to prevent TeleQueue
from continually coming back and asking the caller if he wishes to hold.

Tq0000PlayTm
Minimum time to play hold files. Used only if hold files (Line 3) are turned
on. Just before TeleQueue starts playing a hold file, it remembers the
time. After playing a file it then waits to see if the minimum time has
elapsed. If not, it waits (the caller hears silence) until the time has elapsed.
If during this wait time the caller gets to the head of the queue or if they
press a key, they will be brought out of the waiting cycle. This parameter
is usually 30 seconds and is used to keep the caller on hold a specified
number of seconds, regardless of the length of the individual hold files.
The value in the file should be expressed in seconds. A value of “0”
indicates to TeleQueue that after playing the hold file it should re-check
the position and move to the next hold file.
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Tq0000NTmToAsk
Loops while waiting before getting response. This is similar to
Tq000Loops, except that this is used for callers who are not at the head
of the queue. After holding the caller, use whatever method is specified
in Tq0000HldTyp.

Tq0000ExtLog
Extended Logging Flag. This field should be either a 1 (extended logging
turned On) or a 0 (Extended logging turned off). Extended logging
generates simple SMDR type log lines in the PathFinder system log. It also
allows tracking of the CSR status (see TqCsrCtl below). A typical log line
for extended logging would look like the following:

TqCsrCntl
CSR Status Tracking Flag. Note: This is a system wide parameter and thus
does not need to have the queue specified. This field controls whether
TeleQueue should support the CSR status files. A value of 1 turns on CSR
Status tracking and a 0 turns it off. The CSR Status files allow the
extension owners to mark themselves as busy for 1 of 9 reasons and then
to mark themselves as not busy. While a CSR is marked as busy, no other
calls will be sent to that extension.

:

13:30:02 04 H!TELEQ: CSR 7404 
Answered.

13:30:02 04 H!TELEQ: CSR Caller Out

13:31:12 05 H!TELEQ: CSR Caller In 
Position 0

13:31:12 05 H!TELEQ: CSR 7401 is 3.

13:31:13 05 H!TELEQ: CSR 7402 Busy.

13:31:14:05 H!TELEQ: CSR 7403 
Answered.

13:31:14:05 H!TELEQ: CSR Caller Out
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A CSR can call into the system and set the status to 0 (Available), or 1-9
(Not Available). Assuming you are answering the phone with a menu,
when the caller presses 1 you send them to the custom module
H!TELEQ.SUB and for the parameter you enter 1234. This sends any calls
into queue 1234.

If you would like the CSRs to change their status by pressing 8 from the
main menu, then set key 8 up to go to custom module H!TELEQ.SUB and
for the parameter enter “CSRMAINT”. When the caller presses 8, we play
the prompt VOX\TQGETCSR.VOX. You should record something like
“Enter your CSR extension number followed by pressing pound.” Once
the CSR enters an extension, we then play the prompt
VOX\TQGETSTA.VOX. You should record something like “Enter your
status, 0 for available, 2 for out to lunch, 3 for personal time...”. After
PathFinder receives a single digit it changes the CSR's status and hangs
up.

If, at the TQGETCSR.VOX prompt, the caller enters a queue number
followed by❊, then we generate a report of all CSRs status in that queue.
The queue number entered before the❊must be valid. After generating
the report, PathFinder will hang up. The following is an example of the
report:

12:20:01 03 H!TELEQ Report Start 
.............................

12:20:01 03 H!TELEQ Report Queue [1234]

12:20:01 03 H!TELEQ Report CSR 7401 marked as 0.

12:20:02 03 H!TELEQ Report CSR 7402 marked as 0.

12:20:03 03 H!TELEQ Report CSR 7403 marked as 1.

12:20:04 03 H!TELEQ Report CSR 7404 marked as 0.

12:20:05 03 H!TELEQ Report CSR 7405 marked as 3.

12:20:05 03 H!TELEQ Report CSR 7406 marked as 4.

12:20:06 03 H!TELEQ Report Stop  
.............................



TeleQueue C-101
Tq0000AlwCllr
Default Action Stays in Queue. This field controls what happens when we
ask a caller (in any position) to press 1 to continue to hold or 0 for the
operator. Normally if the caller does nothing, TeleQueue assumes the
caller has hung up or does not want to stay in the queue. This is what
TeleQueue does when there is a 0 on line 12. If a 1 is placed on line 12,
then TeleQueue will allow the caller to stay in the queue, even if no DTMF
key is received. The down side is that if your phone system sends silence
(H2) when a caller has hung up, then TeleQueue may think the caller
wants to stay in the queue, when actually they have hung up. If your
phone system sends a drop in loop current (H1), you are safe to set this
parameter to a 1.

Tq0000ShwCntrs
Show Queue Event Counters. If this value is a 1, then TeleQueue will
update the event counters on PathFinder's run-time screen when this
queue is accessed.

Tq0000StrtAtTp
Start Over in EXT List. If this value is a 1, then TeleQueue will start at the
beginning of the EXT list for each caller. TeleQueue will not remember
the last extension it transferred to - but will always start at the top of the
list.

Tq0000NoRBBfrHu
Number of No Ring Backs before Disconnect. This field indicates how
many no-ring backs TeleQueue should process before it disconnects the
caller. A value of 1 to 3 is common.

Tq0000MstrQ
Queue Priority or Master Queue Number. (See TQTEST.DOC)

Tq0000PsudoSup
Use Pseudo-Transfers. Most systems should have this value set to 0. On
systems where you want the system to do a blind-transfer to the CSRs
extension (followed by waiting for any DTMF), put the number of
seconds to wait for a DTMF on line 17. When the CSR picks up the phone,
the system will be silently waiting for a DTMF. Alternatively, you may
record a prompt in the VOX\TQ_TRANS.VOX file.
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Instead of representing the number of seconds to wait, the Line 17
parameter would reflect how many times the TQ_TRANS.VOX prompt is
played before assuming ring-no-answer.

Tq0000ExitExt
Exit to Extension. If this is set to 0, then while a person is on hold waiting
for a CSR to free up, they can only press “0” to get to an operator or menu.
If this is set to “1”, then the person has the additional option of pressing
“❊” to enter an extension to transfer to, or to get to the company
directory.

EXT List
The EXT list in the registry contains the extensions that TeleQueue should
call. This list does not have to be in any order. TeleQueue does follow this
ordering but because it always starts calling from where it left off on the
previous call, you cannot be sure where TeleQueue will start. There can
be any number of extensions in this list. Each entry in the list should
contain one extension. The extension numbers in the EXT file are
independent of the list of extensions in Auto Attendant.

Keep in mind that TeleQueue works faster if you can take all of your
destination extensions (those that would normally be listed in the EXT
list) and put them in a “hunt group” on your PBX. If the access extension
for that “hunt group” is 290 then that would be the only extension that
would appear in the EXT list. The reason this is usually better is because
when there is a list of extensions TeleQueue has to step through each
and find if it is busy, but if your PBX does the work it will respond much
faster.

The format in the registry for extension entries is as follows:

Name Value

Tq0000#01 1111

Tq0000#02 1112

So that in the above example, Queue 0000 has two extensions associated
with it.
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If you are using CSR Control features, then you must add a line for each of
the extensions to hold the status of the CSR. The format of the CSR entries
for the above example follow:

Name Value

TqCSR#1111 0

TqCSR#1112 0

The value of the CSR entry will change when the CSR checks in or out.

Setup Items
The following items are involved in the setup of TeleQueue.

Attaching TeleQueue
You can link TeleQueue to the rest of PathFinder through a menu or by
directly associating a queue to a line. To link TeleQueue to a menu, go
into MAINT and select Modules > Menu > Edit Menu and pick the menu
that you answer the phone with. Then select the key that you will want to
take the caller to TeleQueue, select for its action “Run Module” and enter
“H!TELEQ.0000”, where “0000” is the queue number. For CSR MAINT, the
entry would be “H!TELEQ.CSRMAINT”.

To send all calls coming in on a particular line to a queue, select “Setup
Lines” from the MAINT main screen, select the line you want to send to
the queue, select “Run Modules” as the action for that line and follow the
preceding instructions to run the TeleQueue module with your queue.

Because of PathFinder’s very powerful Time Control feature, you can have
certain lines go to a queue during one time period, then to another
queue at another time period.

Use of Hunt Group

When you are using a hunt group, you must be able to set up the hunt
group in a UCD (Uniform Call Distribution) format. This allows ringing of
the next extension in the hunt group that has not been called recently.

TeleQueue is a versatile package. However, it is important to understand
your application and the limitations of some phone systems to be able to
fully exploit its capabilities.
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Without UCD, calls transferred to the hunt group by PathFinder are not
evenly distributed and possibly could create a situation where PathFinder
repeatedly calls an extension that does not answer.

If you do not have UCD, it is highly recommended that you use an
extension list.

Position in Queue

If a caller chooses the option to exit the queue by pressing 0, their
position in the queue is lost. If the caller chooses to go back into the
queue, they will be placed at the end of the queue (depending upon the
configuration). This may give the caller the impression that their queue
position is deteriorating. TQ_INSTR.VOX can be modified to warn a caller
that they will lose their position in the queue if they exit.

Last Resort Extension
It is important to provide some way out of the queue for the caller unless
you absolutely do not want to provide this option and understand the
consequences.

Opening Prompts
Some people attempt to run TeleQueue without using an opening
prompt. This is not recommended due to the confusion it can create.

Pressing a Key to Stay in Queue
It is not necessary for the caller to press a key to stay on hold. To
accomplish this, increase the number of tries in Configuration Line 9.

Hang-Up Detection

The best type of hang-up detection for TeleQueue is Drop in Loop
Current. It is highly recommended that when using TeleQueue, you use
telephone lines that provide this feature.
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Prompt Names and Descriptions

All the prompts in TeleQueue are “checked” and if they do not exist then
TeleQueue does not try to play them. Therefore you may simply erase (or
change) any prompts you wish.

All prompts for TeleQueue are stored in the \PathFinder\VOX directory.

The TQExxxx.VOX prompts are played when a CSR changes the status
code of an extension.

Table C-6: Telequeque Prompts and Descriptions

TQ_INTRO.VOX “Your call will be answered in the order that it was received.”

TQ_INSTR.VOX “Press 0 at any time to be transferred to the operator. While you are
waiting you will be prompted to press 1 to remain on hold.”

TQ_CONT.VOX “Please press 1 to continue to hold or press 0 to reach an operator.”

TQ_CONT2.VOX (Used for the number 1 caller when you want to say something
different than what is in TQ_CONT.VOX.)

TQ_NEXT.VOX “I will now transfer you, please do not hang up”

TQ_POS1.VOX “There is only 1 person in front of you, please continue to hold.”

TQ_POSX.VOX “There are...”

TQ_FRONT.VOX “...callers in front of you.”

TQ_CALL.VOX “You have a call from TeleQueue.”

TQ_MUSIC.VOX (Music - prerecorded; played if no prompt files exist for this queue)

TQGETCSR.VOX “Enter your CSR number followed by pressing #.”

TQGETSTA.VOX “Enter your CSR status code” -or-“Press 0 if available or 2 if out to lunch.”

TQEBAD1.VOX “CSR extension”

TQEBAD2.VOX “is invalid.”

TQEOK1.VOX “CSR extension”

TQEOK2.VOX “is now set for status code”

TQEOK3.VOX “Thank you”

TQ_TRANS.VOX “Press 1 to accept TeleQueue call.”
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If the extension number entered does not exist in the extension list in
MAINT, then the TQEBAD1 and TQBAD2 prompts are played. If the status
code is successfully changed, then TQEOK1, TQEOK2, and TQEOK3 are
played. The extension number is played between 1 and 2 and the status
code number is played between 2 and 3.

Queue Introductions
Each queue can have its own introduction and TQ_CALL.VOX file. The
name for the introduction (or greeting) file is TQ<queue>.GRT. The
greeting file for queue 234 would be TQ234.GRT. Also, the first caller into
the queue can have a different greeting file. The file for the first caller
ends in GR0 instead of GRT. For example, queue 234 would use the file
TQ234.GR0 for the first caller. The other file, TQ_CALL.VOX is played when
TeleQueue finds an extension available and it is answered. It is similar to
the message “You have a call” heard in Auto Attendant. If you wish for a
queue to have its own “answer” message then record a prompt named
TQ<queue>.ANS. The complete file name for queue 234 would be
TQ234.ANS. If this file does not exist, then TeleQueue falls back and plays
TQ_CALL.VOX.

Wait For Transfer
As mentioned earlier, you can tell TeleQueue to play prompt files for a
caller while he is waiting to be transferred. Each queue has its own
prompt files and they can be recorded with MAINT’s Recording Studio.
The file names for these prompts are TQ<queue>.<prompt 
number>. The first five prompt files for queue 234 would be:TQ234.1, 
TQ234.2, TQ234.3, TQ234.4, and TQ234.5. You can have one
or more prompt files. When TeleQueue gets to the last prompt it will
reset back to the first one. As mentioned earlier, if you do not have a “1”
file then the file TQ_MUSIC.VOX is played.

Help Prompts

You can also have help files. These are not specific to a particular queue
like the files mentioned above. Help files all have a unique 4,5 or 6 digit
number. The caller can, while listening to the files TQ234.1 through
TQ234.999, enter the help prompt number followed by pressing pound.
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This feature can be used to help callers solve their problems while they
are waiting to be transferred.

Typically you would set the queue up to allow prompt files and record a
file TQ234.1 that would have the following instructions:

“While you are waiting for a representative you may 
enter the following numbers to get more information. For 
information on PathFinder press 1111#. For information on 
TeleQueue press 2222#. Otherwise stay on the line and 
someone will be with you shortly. Remember to press 1 
when prompted if you wish to continue to hold.”

Then you would record TQ1111.VOX and put something like:

“You selected more information on PathFinder. For 
information on new products press 1112#. For information 
on common problems for first time installations press 
1113#. For information on common problems on installed 
systems press 1114#.”

You will need to plan the files and what is in them along with the correct
names to be used. If this is set up correctly, it can help your customers
solve their problems before they ever reach a support person.

Non-Queue-Specific Prompts
The last set of custom prompt files are not queue specific. They are used
to customize what messages the caller hears, depending on how many
other callers are in front. For the first caller, the file name would be
TQ_POS1.VOX. For the second caller, the file name would be
TQ_POS2.VOX. These are most commonly used to give the caller an
estimate on how long (on average) it will take to be connected.

Troubleshooting / Testing
Now test your setup. To see the real power of TeleQueue you will need to
have many people call into the system at the same time. The first caller
will be transferred to the first available extension. Each caller after that
will be queued according to which call was answered first.
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Sample Logs
QuickCommand=<command sequence> 

08:02:46 03 08:02:31 B CSS_4521 1aTQUE script <H!TELEQ> param <111> ...

08:02:46 03 H!TELEQ CSR TQ111 Caller Start Position 1.

08:02:47 02 08:02:43 B CSS_4521 8aTQUE script <H!TELEQ> param <csrmaint>
...

08:02:57 01 H!TELEQ CallTime 1642 CallResult 8  <&,4585>.

08:02:58 01 H!TELEQ CSR TQ111 4585 No Answer.

08:02:59 01 H!TELEQ CSR TQ111 4586 is 2.

08:03:01 02 H!TELEQ CSR 4585 set to 2 by CSR.

08:03:01 02 08:02:43 ...,H!TELEQ csrmaint,H!TELEQ CsrMaint Csr Status 
4585 , ...

08:03:01 02 011 Sys: Blockage Cleared Group# 1

08:03:01 02 08:02:43 ... 

08:03:02 04 011 Sys: Blockage Detected Group# 2

08:03:03 01 H!TELEQ CallTime  407  CallResult  10  <&,4587>.

08:03:04 01 H!TELEQ CSR TQ111 4587 Answered.

08:03:04 01 08:02:19 ...,H!TELEQ 111,H!TELEQ TQ111 startpos=0 ca4585=8 
ca4587=10 ...

08:03:04 01 H!TELEQ CSR TQ111 CSR Caller Out.

08:03:04 01 08:02:19 ... connect 4587,

08:03:19 04 08:03:02 B CSS_4521 1aTQUE script <H!TELEQ> param <111> ...

08:03:19 04 H!TELEQ CSR TQ111 Caller Start Position 1.

08:03:29 01 08:03:24 B CSS_4521 8aTQUE script <H!TELEQ> param <csrmaint>
...

08:03:37 01 H!TELEQ CSR 4585 set to 2 by CSR.

08:03:37 01 08:03:24 ...,H!TELEQ csrmaint,H!TELEQ CsrMaint Csr Status 
4585 , ...

08:03:37 01 08:03:24 ... 

08:03:38 03 H!TELEQ CSR TQ111 4585 is 2.

08:03:38 03 H!TELEQ CSR TQ111 4586 is 2.

08:03:45 03 H!TELEQ CallTime  714  CallResult  10  <&,4587>.

08:03:46 03 H!TELEQ CSR TQ111 4587 Answered.

08:03:46 03 H!TELEQ CSR TQ111 CSR Caller Out.

08:03:46 03 08:02:31 ...,H!TELEQ 111,H!TELEQ TQ111 startpos=1 ca4587=10 
connect 4587,



Glossary

Automated
Attendant

The Auto-Attendant processes all call transfer activity
not carried out by a human operator or user. The
Auto-Attendant settings provide access to caller-
related Call Queue Interval and Directory
configurations. The Auto-Attendant Operator setting
determines what happens when a caller presses 0
while in the Auto-Attendant module.

COS Class of Service. To understand Class of Service (COS),
think of an airplane. Some passengers fly first class,
others fly business class, and some fly economy class,
each with different amenities and services. PathFinder
can do the same for subscribers, defining a virtually
unlimited number of different classes of service. Each
subscriber is associated with a COS that defines its
attributes. Grouping mailboxes and extensions into
classes of service lets you change options for all the
mailboxes and extensions in the same class
simultaneously, simply by editing the COS record.
Refer to Chapter 5, Class of Service Settings.

DTMF Dual Tone Multi-Frequency. Sounds made by a push-
button telephone’s keys when they are pressed.

Hardware The various interface devices (voice cards) that
PathFinder uses to connect the computer and the
phone system.
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These devices provide the support for voice
messaging, fax services, text-to-speech, and voice
recognition support. The PathFinder system uses
Dialogic®products.

HCL Hardware Compatibility List. All system components--
both required equipment and optional equipment--
should be listed in the Windows NT® Hardware
Compatibility List (HCL), which can be found on the
Internet at http://www.microsoft.com/hwtest/hcl. The
HCL is a database of hardware, classified by function.

IRQ Interrupt Request.

MWI Message Waiting Indicator.

Operator There are several different types of operators in
PathFinder. The operators are called when a caller dials
0 at different times during PathFinder operation. All
operator settings are defined in the Registry. There are
four operators used in the system, as follows:

General Operator

Voice Mail Operator

Auto-Attendant Operator

Personal Mailbox Operator

Refer to “Operators” on page 5-9 for more information.

PBX Private Branch Exchange.

PEB Pulse Code Modulation Expansion Bus. A Dialogic bus
type. Also refer to “SC”.
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POTS Plain Old Telephone Set. Refer to “SLT”.

RJ11 and RJ14 Telephone connectors/jacks.

SC Dialogic bus type. Also refer to “PEB”.

SLT Single Line Telephone.

SMDI Simplified Message Desk Interface.

Subscriber The terms “user” and “subscriber” are used
interchangeably throughout this manual. A subscriber
can be either a mailbox user, an extension user, or a
user who has both a mailbox and an extension.

UDDU Universal Dialogic Diagnostic Utility. Allows you to run
tests on your voice board to determine the integrity of
the board. The best way to determine if your Dialogic
boards are configured correctly is to use the UDDU.
Refer to “How Can I Be Certain I Configured My Dialogic

Boards Correctly?” on page 2-54.

User The terms “user” and “subscriber” are used
interchangeably throughout this manual. A subscriber
can be either a mailbox user, an extension user, or a
user who has both a mailbox and an extension.

Voice Messaging The terms “voice messaging” and “voice mail” are
used interchangeably.
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